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Resumen

Resumen

El objetivo del Proyecto de Final de Carrera (PFC) es el de sistematizar la experiencia del
Grupo de Telecomunicaciones Rurales de la Ponti�cia Universidad Católica del Perú (GTR-
PUCP) en el diseño y despliegue de redes inalámbricas en zonas rurales dentro de proyectos de
países en vías de desarrollo.

Para ello fue necesario trabajar durante seis meses dentro del GTR y de esa forma se registró
y se sintetizó su forma de operar, así como se participó en el diseño y despliegue de nuevas redes
de telecomunicaciones. Se trabajó en Cusco (Perú) en los proyectos �Acomayo I� y �Acomayo
II�. Estos proyectos se incluyen dentro del Programa Willay del que son socios: GTR-PUCP,
Ingeniería Sin Fronteras (ISF-Apd) y Soluciones Prácticas ITDG.

El resultado ha sido una guía para el diseño y despliegue de redes inalámbricas basadas
en tecnología WiFi en entornos rurales. El objeto de este documento es que una persona con
conocimientos previos en redes de telecomunicaciones y con la guía, pueda diseñar y desplegar
una red.

Los diferentes capítulos de la guía, se referirán a las distintas etapas que constituyen los
proyectos de diseño y despliegue de redes inalámbricas. Comenzará con las etapas de formulación
del proyecto y plani�cación. Se de�nirá el diseño de las redes, las compras del equipamiento y
la simulación en el laboratorio. Posteriormente, aparecerán las fases de instalación de la red y
pruebas de campo. Las fases �nales serán las de capacitación, acompañamiento, mantenimiento
y entrega de la red ya desplegada.

Palabras Clave

Redes inalámbricas, Formulación, Plani�cación, Diseño, Compras, Simulación, Instalación,
Pruebas, Capacitación, Acompañamiento, Mantenimiento, Entrega.
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Abstract

The purpose of the Final Year Project is to systematize the experience of the Grupo de Tele-
comunicaciones Rurales of Ponti�cia Universidad Catolica del Peru (GTR-PUCP) in the design
and deployment of wireless networks in rural areas inside projects of developing countries.

This involved working for six months in GTR to record and synthesize the way they operate,
as well as participating in the design and deployment of new telecommunications networks. We
worked in Cusco (Peru) in the projects �Acomayo I� and � Acomayo II.' . These projects are in-
cluded in the Willay Program. GTR-PUCP, Ingeniería Sin Fronteras (ISF-Apd) and Soluciones
Prácticas ITDG are Willay members.

The result has been a guide for the design and deployment of wireless networks based on
WiFi technology in rural environments. The object of this document is that a person with pre-
vious knowledge in telecommunication networks and with the guide, could design and deploy a
network.

The di�erent chapters of the guide will cover the various stages of the design and deployment
of wireless network projects. It will begin with the stages of project formulation and planning.
The design of the network will be de�ned, as well as procurement of equipment and laboratory
simulation. Subsequently, there will apear phases of network installation and �eld testing . The
�nal stages will be training, support, maintenance and delivery of the already deployed network.

Key words

Wireless networks, Formulation, Planning, Design, Procurement of equipment, Simulation,
Installation, Testing, Training, Support, Maintenance, Delivery.

iv



Agradecimientos

Gracias a mi tutor D. Valentín Villaroel y a Da. Cecilia Fernández, gracias en general a la
ONG Ingeniería Sin Fronteras - ApD, por darme la oportunidad de desarrollar este proyecto.

Gracias a D. Juan Paco Fernández, a D. César Córdoba y a todos los chicos del Grupo de
Telecomunicaciones Rurales de la PUCP, incluida �Sandrita�, por los meses de trabajo junto a
ellos.

Gracias a D. José María Martínez y a mi ponente D. Jorge Ruiz por facilitarme las cosas.

Gracias a Lurdes por ser mi compañera y amiga durante estos años.

Gracias a mi madre por tener tanta paciencia y, en general, gracias a toda mi familia y
amigos por apoyarme.

María Martín Espín
Diciembre 2010

v



Guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú

vi



Índice general

Índice de �guras xii

Índice de cuadros xiv

Introducción 1

Motivación y objetivos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Metodología y plan de trabajo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Organizacion de la memoria . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

1. FORMULACIÓN 5

1.1. Introducción de la fase de formulación . . . . . . . . . . . . . . . . . . . . . . . . 6

1.2. Tipo de Proyecto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

1.2.1. Proyecto determinado por la subvención de una entidad . . . . . . . . . . 7

1.2.2. Proyecto independiente. Fines comerciales . . . . . . . . . . . . . . . . . . 8

2. PLANIFICACIÓN 9

2.1. Introducción de la fase de plani�cación . . . . . . . . . . . . . . . . . . . . . . . . 10

2.2. Metodología de intervención . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2.3. Plani�cación temporal . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10

2.4. Recursos humanos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

3. DISEÑO DE LA RED 13

3.1. Estudio de necesidades . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.1.1. Variables de estudio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

3.1.2. Herramientas para el estudio de necesidades . . . . . . . . . . . . . . . . . 15

3.2. Prediseño . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15

3.2.1. Puntos cliente . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

3.2.2. Selección de posibles puntos repetidores de la red troncal . . . . . . . . . . 16

3.2.3. Selección de posibles puntos repetidores de la red local . . . . . . . . . . . 16

3.3. Estudio de campo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3.3.1. Elementos indispensables . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3.3.2. Información a recoger . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

3.3.3. Visita de campo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

vii



Guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú

3.4. Diseño de gabinete . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

3.4.1. Servicios sobre la infraestructura . . . . . . . . . . . . . . . . . . . . . . . 19

3.4.2. Descripción general de la red de telecomunicaciones . . . . . . . . . . . . . 20

3.4.3. Diseño del subsistema de telecomunicación . . . . . . . . . . . . . . . . . . 21

3.4.4. Diseño del subsistema de infraestructura . . . . . . . . . . . . . . . . . . . 22

3.4.5. Diseño del subsistema de alimentación eléctrica . . . . . . . . . . . . . . . 22

3.4.6. Diseño del subsistema de protección eléctrica . . . . . . . . . . . . . . . . 23

3.4.7. Diseño del subsistema de seguridad y vigilancia . . . . . . . . . . . . . . . 23

3.4.8. Diseño del subsistema informático . . . . . . . . . . . . . . . . . . . . . . 24

3.5. Validación del diseño de red . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3.5.1. Metodología del diseño participativo . . . . . . . . . . . . . . . . . . . . . 24

3.5.2. Actividades de los talleres . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3.6. Listado de equipamiento aproximado . . . . . . . . . . . . . . . . . . . . . . . . . 26

4. COMPRAS 27

4.1. Listado �nal del equipamiento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

4.1.1. Listado aproximado de elementos del subsistema de telecomunicación . . . 29

4.2. Clasi�cación y procedimiento de las compras . . . . . . . . . . . . . . . . . . . . . 29

4.2.1. Productos locales . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.2.2. Importaciones . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.2.3. Razones de la elección . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.3. Ejecución de las compras . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

4.3.1. Cotización y evaluación de propuestas . . . . . . . . . . . . . . . . . . . . 30

4.3.2. Elaboración de órdenes de compra . . . . . . . . . . . . . . . . . . . . . . 31

4.3.3. Permisos y homologaciones . . . . . . . . . . . . . . . . . . . . . . . . . . 31

4.3.4. Ejecución de las compras . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

4.3.5. Recepción de las compras . . . . . . . . . . . . . . . . . . . . . . . . . . . 31

4.3.6. Inventario . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32

5. SIMULACIÓN DE LA RED 33

5.1. Validación del funcionamiento de equipo . . . . . . . . . . . . . . . . . . . . . . . 34

5.2. Entrega de la con�guración . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 34

5.3. Simulación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5.4. Ajustes del diseño . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35

5.5. Adaptación a la ingeniería de detalle . . . . . . . . . . . . . . . . . . . . . . . . . 35

6. INSTALACIÓN DE LA RED 37

6.1. Envío del equipamiento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

6.1.1. Selección del medio de transporte . . . . . . . . . . . . . . . . . . . . . . . 38

viii ÍNDICE GENERAL



Guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú

6.1.2. Selección del operador de transporte . . . . . . . . . . . . . . . . . . . . . 38

6.2. Instalación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 38

6.2.1. Obra civil . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 39

6.2.2. Instalación de la infraestructura . . . . . . . . . . . . . . . . . . . . . . . . 39

6.2.3. Instalación de equipamiento . . . . . . . . . . . . . . . . . . . . . . . . . . 40

7. PRUEBAS DE CAMPO 41

7.1. Ejecución del protocolo de pruebas . . . . . . . . . . . . . . . . . . . . . . . . . . 42

7.1.1. Pruebas de nivel de señal de los radioenlaces . . . . . . . . . . . . . . . . 43

7.1.2. Pruebas de ancho de banda . . . . . . . . . . . . . . . . . . . . . . . . . . 43

7.2. Ajustes en instalaciones o con�guraciones . . . . . . . . . . . . . . . . . . . . . . 43

8. CAPACITACIÓN 45

8.1. Introducción de la fase de capacitación . . . . . . . . . . . . . . . . . . . . . . . . 46

8.2. Capacitación de los instaladores . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

8.3. Capacitación de los usuarios . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 47

8.4. Capacitación de los encargados del mantenimiento . . . . . . . . . . . . . . . . . 48

9. ACOMPAÑAMIENTO 49

9.1. Monitoreo de red y mantenimiento temporal . . . . . . . . . . . . . . . . . . . . . 50

9.2. Aseguramiento de la sostenibilidad de la red . . . . . . . . . . . . . . . . . . . . . 50

9.3. Búsqueda de nuevos proyectos . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 50

10.MANTENIMIENTO 51

10.1. De�nición de políticas y procedimientos de mantenimiento . . . . . . . . . . . . . 52

10.2. Mantenimiento necesario mediante coordinación con los bene�ciarios . . . . . . . 52

11.ENTREGA 53

11.1. Recopilación de información . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

11.2. Transferencia de bienes y responsabilidades . . . . . . . . . . . . . . . . . . . . . 54

11.3. Gestión del cambio en la institución bene�ciaria . . . . . . . . . . . . . . . . . . . 54

Conclusiones 55

Glosario de acrónimos 57

Bibliografía 61

A. Manual de Radio Mobile 63

A.1. Instalación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 63

A.2. Inicio . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

A.3. Mapas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 65

ÍNDICE GENERAL ix



Guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú

A.4. Imágenes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

A.5. Unidades . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 70

A.6. Redes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

A.6.1. Sistemas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

A.6.2. Parámetros de enlaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 73

A.6.3. Topología de red . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 74

A.6.4. Unidades miembro del enlace . . . . . . . . . . . . . . . . . . . . . . . . . 75

A.6.5. Estilo del enlace . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 75

A.7. Reportes de enlaces . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 79

A.8. Radio Link . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 80

A.9. Representación de la cobertura . . . . . . . . . . . . . . . . . . . . . . . . . . . . 81

A.10.Guardar el proyecto . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 85

A.11.Google Earth . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 86

B. Selección de equipamiento 89

B.1. Placas SCB . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 89

B.2. Tarjetas de red inalámbrica . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

B.3. Pigtails . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 90

B.4. Antenas . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 91

C. Pruebas de Campo para placas MIKROTIK 95

C.1. Ejecución del protocolo de pruebas. Placas MIKROTIK . . . . . . . . . . . . . . 95

C.1.1. Pruebas de nivel de señal de los radioenlaces. Placas MIKROTIK . . . . . 96

C.1.2. Pruebas de ancho de banda. Placas MIKROTIK . . . . . . . . . . . . . . 97

D. Pruebas de Campo para placas ALIX 99

D.1. Ejecución del protocolo de pruebas. Placas ALIX . . . . . . . . . . . . . . . . . . 99

D.1.1. Pruebas de nivel de señal de los radioenlaces. Placas ALIX . . . . . . . . 102

D.1.2. Pruebas de ancho de banda. Placas ALIX . . . . . . . . . . . . . . . . . . 102

E. Software 105

E.1. Sistema Operativo Linux Voyage . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

E.1.1. Voyage GTR . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 105

E.1.2. Instalación y con�guración de Voyage GTR . . . . . . . . . . . . . . . . . 106

E.1.3. Con�guración de Redes con Voyage GTR . . . . . . . . . . . . . . . . . . 110

E.2. Software PBX Asterisk . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 116

E.2.1. Con�guración de una red de Telefonía IP con Asterisk . . . . . . . . . . . 117

E.2.2. Registro de los clientes SIP . . . . . . . . . . . . . . . . . . . . . . . . . . 121

E.2.3. Veri�cación del estado de telefonía IP con Asterisk . . . . . . . . . . . . . 123

x ÍNDICE GENERAL



Guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú

F. Presupuesto 125

G. Pliego de condiciones 127

ÍNDICE GENERAL xi





Índice de �guras

1.1. Grá�co Fase Formulación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5

2.1. Grá�co Fase Plani�cación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

3.1. Grá�co Fase Diseño . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

4.1. Grá�co Fase Compras . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27

5.1. Grá�co Fase Simulación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

6.1. Grá�co Fase Instalación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 37

7.1. Grá�co Fase Pruebas de campo . . . . . . . . . . . . . . . . . . . . . . . . . . . . 41

8.1. Grá�co Fase Capacitación . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45

9.1. Grá�co Fase Acompañamiento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 49

10.1. Grá�co Fase Mantenimiento . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 51

11.1. Grá�co Fase Entrega . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53

A.1. File > New networks. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 64

A.2. Options > Intenet. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 67

A.3. Options > Elevation data. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

A.4. Options > Map properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 68

A.5. File > Unit properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 72

A.6. Systems. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 76

A.7. Parameters. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

A.8. Topology. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 77

A.9. Membership. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

A.10.Style. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 78

A.11.Tools > Radio link. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 82

xiii





Índice de cuadros

A.1. Conductividad y permeabilidad según el tipo de terreno. . . . . . . . . . . . . . . 74

A.2. Código S en función del márgen de fadding (M) . . . . . . . . . . . . . . . . . . . 81

B.1. Comparación de SBCs para aplicación de redes inalámbricas. . . . . . . . . . . . 92

B.2. Comparación de tarjetas inalámbricas para Wi-Fi de larga distancia. . . . . . . . 93

xv





Introducción

Motivación y objetivos

La guía es el fruto de un proyecto ofertado por la ONGD Ingeniería Sin Fronteras - ApD.
Esta oferta se destinó a sistematizar, de forma documentada, la experiencia del Grupo de Teleco-
municaciones Rurales de la Ponti�cia Universidad Católica del Perú (GTR-PUCP) en el diseño
y despliegue de redes inalámbricas en zonas rurales. Los proyectos a sistematizar se desarrollan
en el entorno de países en vías de desarrollo, en concreto en Perú.

Ingeniería Sin Fronteras (ISF) es una organización no gubernamental (ONG) dedicada a la
cooperación al desarrollo y que busca poner la tecnología al servicio del desarrollo, para cons-
truir una sociedad mundial justa y solidaria. ISF es pluridisciplinar, aconfesional y apartidista.
La forman personas que participan como socias y como voluntarias. ISF es una organización
consolidada, con un proyecto original y necesario en varios campos de actuación: proyectos de
cooperación, educación para el desarrollo, investigación e incidencia.

El Grupo de Telecomunicaciones Rurales (GTR-PUCP) es una entidad dedicada al desarro-
llo y promoción de las telecomunicaciones rurales en Latinoamérica, como medio facilitador del
desarrollo humano sostenible en el sector rural. Son un equipo multidisciplinario dedicado a la
investigación, desarrollo, aplicación, análisis, evaluación de impacto y difusión de las tecnologías
de información y comunicaciones (TIC) apropiadas para contribuir a la mejora de la calidad de
vida de las comunidades marginales que carecen o tienen acceso limitado a medios de comuni-
cación, con énfasis en aquellas ubicadas en entornos rurales. Buscan ser líderes en el desarrollo de
soluciones tecnológicas apropiadas e innovadoras en el área de las telecomunicaciones rurales y
ser reconocidos nacional e internacionalmente como un referente en el ámbito de las tecnologías
de información y comunicaciones (TIC) para el desarrollo humano. Como objetivos principales
tienen: Contribuir a la reducción de la brecha digital en las zonas de intervención; Actuar co-
mo facilitadores de diversos actores sociales que contribuyan a la mejora de la calidad de vida
de nuestro grupo objetivo; Contribuir al desarrollo humano a través de la implementación de
TIC apropiadas; Identi�car, formular, planear, ejecutar, difundir y promover oportunidades y
proyectos de TIC para el desarrollo.

Metodología y plan de trabajo

Para conseguir estos objetivos se realizaron las siguientes actividades:

- Estancia en la Ponti�cia Universidad Católica del Perú: en el plazo de siete meses se trabajó
junto con el GTR-PUCP en Lima, Perú.

- Recopilación y lectura de información: la bibliografía a estudiada fue la relacionada con
redes inalámbricas en entornos rurales y documentos de proyectos ya implementados del
programa Willay.
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- Entrevistas y asistencia reuniones: se entrevistó a los miembros activos del Programa
Willay y se acudió a reuniones de forma pasiva, para recopilar información práctica del
diseño redes inalámbricas ya implantadas o en proceso.

- Participación: fue necesario participar en algunas fases de los proyectos activos del Pro-
grama.

- Visita a zona: se conocieron las zonas en las que se está implementando el Programa Willay.
Se visitó distintos emplazamientos de Cusco (Perú).

- Elaboración de la guía: se redactó la guía para la sistematización del diseño y despliegue
de redes inalámbricas en zonas rurales.

- Elaboración de manual de Radio Mobile: se redactó un manual del software Radio Mobile
para el diseño de radio enlaces en base a los criterios que sigue el GTR-PUCP.

Organizacion de la memoria

Los diferentes capítulos de la guía de�nirán las fases de los proyectos a sistematizar:

CAPÍTULO 1. FORMULACIÓN: La primera fase consistirá en la formulación del proyecto
en la que deberán quedar de�nidos los requisitos técnicos, económicos y de alcance. Se diferen-
ciará entre dos tipos de proyectos, los proyectos determinados por la subvención de una entidad
y los proyectos con �nes comerciales.

CAPÍTULO 2. PLANIFICACIÓN: En la etapa de plani�cación se desarrollará la metodología
de intervención y se de�nirán los plazos y los hitos, además de los recursos humanos.

CAPÍTULO 3. DISEÑO: La fase de diseño comenzará con un estudio de necesidades en
función de la zona. Se desarrollará un prediseño en el que se de�nirán los puntos cliente y los
posibles puntos repetidores, tanto de la red troncal como de la red local. Gracias a este predi-
seño se visitará la zona, en lo que se llama estudio de campo, para con�rmar las características
y requerimientos especiales de la zona de trabajo. Empleando esta información se realizará el
diseño de gabinete, de�niendo los servicios a proporcionar, la red de telecomunicación, la in-
fraestructura y el listado aproximado de los equipos a emplear.

CAPÍTULO 4. COMPRAS: La etapa de compras comenzará con la de�nición del listado del
equipamiento �nal. Se continuará con la propia ejecución de las compras. Esta fase �nalizará
con la recepción de las compras, lo que se documentará mediante inventarios.

CAPÍTULO 5. SIMULACIÓN: La etapa de simulación se dirigirá a validar los productos
recibidos y a con�gurarlos.

CAPÍTULO 6. INSTALACIÓN: Esta fase se iniciará con el envío de los equipos a la zona
�nal. La instalación se referirá a la obra civil, a la instalación de la infraestructura y a la insta-
lación del equipamiento.

CAPÍTULO 7. PRUEBAS: Se deberá ejecutar un protocolo de pruebas de campo entre las
que se incluirán pruebas de nivel de señal y ancho de banda de los radioenlaces.
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CAPÍTULO 8. CAPACITACIÓN: La etapa de capacitación incluye la formación de instala-
dores, usuarios y encargados de mantenimiento.

CAPÍTULO 9. ACOMPAÑAMIENTO: Se deberá hacer un monitoreo de la red y se solu-
cionarán las posibles fallas. Se deberá de�nir un plan de actuación para asegurar la sostenibilidad
de la red.

CAPÍTULO 10. MANTENIMIENTO: Deberán quedar de�nidas las políticas y los proced-
imientos de mantenimiento a realizar por los bene�ciarios.

CAPÍTULO 11. ENTREGA: En esta fase se gestionará el cambio en la entidad bene�ciaria
y se realizará la transferencia de bienes y responsabilidades.

ÍNDICE DE CUADROS 3





1
FORMULACIÓN

Figura 1.1: Grá�co Fase Formulación
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1.1. Introducción de la fase de formulación

GTR trata de hacer proyectos no desarrollados, que sean una base para que después empre-
sas y operadores implementen lo que desde GTR se plantea. Por tratarse de una universidad,
se busca la característica de investigación. Se procura que, a la vez que estas implementaciones
persiguen un �n, sirvan como material de estudio para que otros puedan emplear lo desarrol-
lado. Como ejemplos, la primera red inalámbrica Wi-Fi en Cusco, con enlaces de distancias de
hasta 50 km, fue osada inicialmente en 2006. En el río Napo, en 2003, se implementó una red
inalámbrica con torres de 90 metros, enlaces de 50 km y una red troncal de 500 km.

GTR intenta difundir una metodología para que otros la puedan emplear, y a la vez, estar
continuamente innovando. Cuando GTR comenzó con las redes inalámbricas en 2003, implemen-
tando la primera red Wi-Fi, no existían redes similares en el mundo, ahora sí están desplegadas
y por ello, se está investigando en nuevas tecnologías (por ejemplo Wimax), en la forma de hacer
más competitivos los sistemas satelitales, en optimizar los sistemas en los que se comparte ancho
de banda, etc. También se investiga para mejorar el sistema Wi-Fi, mejorar la telefonía de VoIP,
mejorar la QoS y los sistemas gestión de red. La idea de GTR es estar a la vanguardia.

GTR también intenta difundir buenas prácticas. Las telecomunicaciones en zonas rurales no
están reguladas, a veces, no se emiten autorizaciones (por ejemplo para el montaje de una torre),
por lo que posteriormente no habrá una supervisión. Otro ejemplo puede ser que en muchos paí-
ses está normado que se utilice bajo voltaje en torres, no 220 V, ya que se podría energizar una
torre y causar graves accidentes. Existe poca información y por ello, otro de los objetivos de
GTR es trabajar con las empresas mostrando buenas prácticas.

La de�nición del presupuesto, del plazo y los cronogramas está directamente ligado a la tec-
nología que se escogerá. Un despliegue de red satelital es bastante más rápido que el despliegue
de red inalámbrica. A largo plazo, el presupuesto requerido para una red inalámbrica será infe-
rior, a corto plazo, es más económica una red satelital.

Desde el punto de vista de los plazos de los proyectos, se deben diferenciar distintas fases.
Deberá existir una etapa de estudio previa, una etapa de diseño de gabinete y una etapa de
compras, seguirá la etapa de instalación, que se divide en instalación de la infraestructura e ins-
talación de los sistemas de telecomunicaciones y equipos informáticos, y una etapa de pruebas.
Cuando �nalizan las pruebas se suele terminar con el proyecto, aunque en paralelo se podrá
trabajar en la fase de capacitación y mantenimiento.

Conseguir �nanciación para el mantenimiento suele ser difícil ya que los proyectos tienen
una vida acotada. El mantenimiento es una tarea frustrante, porque depende de terceros lo que
di�culta los procesos de mantenimiento. Para generar conciencia de mantenimiento no habrá
que centrarse en la técnica, sino en el bene�cio de la red.

El primer documento que se generará en la fase de formulación será el estudio de prefacti-
bilidad, se trata de un estudio sencillo donde se evalúan las distintas alternativas y se hace un
presupuesto aproximado. Con la prefactibilidad se elegirá una opción y se realizará un estudio
de factibilidad, donde se analizan los bene�cios sociales, económicos y, en función de los fondos,
se desarrollará un diseño técnico más o menos detallado.

En cualquier caso, se deberá crear un documento técnico y una propuesta económica con
más o menos detalle. Si se exigiera menos detalle, se debería crear un documento interno más
extenso que quede como respaldo.
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1.2. Tipo de Proyecto

En primer lugar, hay que diferenciar si el proyecto está originado por una subvención, nor-
malmente mediante convocatoria de una entidad que ofrece fondos para cooperación, o si el
proyecto se solicita a empresas o entidades comerciales, con los que se participa. Generalmente,
si GTR trabaja en estos últimos, lo hace como consultora técnica.

1.2.1. Proyecto determinado por la subvención de una entidad

Esta modalidad de proyectos se da en base a convocatorias. Se trata de los llamados proyectos
de cooperación. Se deberá partir de un Documento de Formulación en el que se determinará el
presupuesto disponible, el plazo temporal previsto y el alcance general que debe tener el proyecto.

Las características de los documentos de formulación estarán de�nidas en su totalidad por
el organismo �nanciador. Hay entidades más rigurosas y otras más �exibles. La información
mínima exigida a incluir será la justi�cación del proyecto, la descripción del proyecto, el marco
lógico, los plazos, el presupuesto general, los alcances, la justi�cación de la experiencia que tiene
cada socio o cada entidad que participa y los compromisos de cumplimiento de los requisitos
que establezcan los �nanciadores.

Para determinar el lugar donde se va a realizar un proyecto de telecomunicación, lo primero
que hay que valorar es la necesidad. El objetivo no es competir con los operadores comerciales, el
objetivo es llegar donde no existen operadores y por lo tanto, subvencionar telecomunicaciones
tiene sentido.

El segundo punto que se debe valorar es el nivel de desarrollo mínimo que debe haber en una
localidad para que una red de telecomunicaciones impacte, ya que no en todos los lugares im-
pactará de una manera adecuada. En un lugar donde no hay agua, la red de telecomunicaciones
no es una necesidad todavía. Pero existe un punto en el desarrollo de una comunidad o de un
pueblo donde las telecomunicaciones sí aceleran el proceso de desarrollo.

Se debe buscar la instalación de telecomunicaciones para interconectar personas que estén
previamente conectadas, tiene que haber un tejido social previo. Estas instalaciones irán dirigi-
das a mejorar las comunicaciones, no a crear comunicaciones nuevas.

Se debe procurar que los futuros usuarios sientan como necesidad la red de telecomunica-
ciones. Esta necesidad se podrá valorar en la medida en que ellos inviertan en esa red.

Se deberá realizar un estudio de factibilidad, este estudio debe plantear un abanico de posi-
bilidades, para escoger la más adecuada. De las posibles soluciones que plantea GTR, la satelital
resulta ser un poco cara y las inalámbricas un poco más baratas, pero hay que valorar otros
aspectos. Por ejemplo, cuando los sistemas son muy aislados se optará por una solución satelital.
Cuando se debe implementar una interconexión elevada, la solución adecuada será una red in-
alámbrica, porque la interconexión va a aumentar trá�co sobre el sistema satelital, por lo tanto,
va a ser inviable desde el punto de vista económico.

GTR no cree en las soluciones únicas para todos, por ello, se deberá realizar un estudio de
factibilidad, tanto desde el punto de vista técnico como desde el punto de vista de rentabilidad
social. La rentabilidad social se debe valorar, ya que estas redes no están implementadas con
�nes comerciales, si así fuera, se valoraría desde el punto de vista de rentabilidad económica.

CAPÍTULO 1. FORMULACIÓN 7
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Para analizar la rentabilidad social se eligen indicadores referidos a salvar vidas, educar personas,
mejorar la gobernabilidad, etc. Estos indicadores se escogen al comienzo de los proyectos.

El proceso cronológico aproximado será: primero se determinará la zona, luego se hará un
estudio de prefactibilidad, analizando los costos. Después se identi�carán los recursos de los que
se dispone, si se podrá �nanciar con recursos propios o se deberá ayudar a los futuros usuarios
a encontrar �nanciación.

En proyectos de cooperación, generalmente el estudio de factibilidad está comprometido
dentro del proyecto mismo, normalmente se destinan fondos para algún tipo de estudio de línea
de base. En este tipo de proyectos se suele establecer el cronograma propio, ya que se propone
la iniciativa para la que solicita subvención.

1.2.2. Proyecto independiente. Fines comerciales

En los proyectos con �nes comerciales se seguirá el mismo proceso. Se planteará un estudio
de prefactibilidad, en el que se analizarán las opciones tecnológicas, las necesidades de comu-
nicación, las instituciones receptoras y la capacidad técnica para soportar la red. Se deberá
presentar un presupuesto. Como suelen ser instituciones públicas las que solicitan este tipo de
trabajos, GTR no suele realizar la instalación, simplemente un diseño y en muchos casos, un
seguimiento o una asesoría.

Existe un interés, por parte de GTR, de potenciar a empresas, grupos o instituciones que se
dedican al despliegue de redes y de incitarles a que abran las perspectivas a distintas opciones
tecnológicas y que usen la que les convenga en cada caso. GTR ha realizado este tipo de trabajos
para operadores grandes, municipios, consultorías, etc.

El estudio de factibilidad no necesariamente lo tendrá que crear la entidad que está asumien-
do la ejecución del proyecto, se podrá haber redactado en etapas anteriores. En ámbito comercial,
las empresas establecerán las características del servicio, lo que ya estará de�niendo la viabilidad.
Al aplicar y ser escogido, se adquirirá un compriso con las características que se han de�nido,
por lo que necesariamente no se exige un estudio de factibilidad.

En los proyectos con �nes comerciales, los fondos dependen del monto que esté dispuesto el
cliente a invertir en el servicio. Las entidades van a de�nir exactamente qué es lo que quieren,
el cronograma y los requisitos y se tendrá que presentar un compromiso de cumplir con ello.
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PLANIFICACIÓN

Figura 2.1: Grá�co Fase Plani�cación
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2.1. Introducción de la fase de plani�cación

Esta etapa consistirá en diferentes actividades de gestión inicial. Se partirá del documento
de formulación. Se deberán considerar los demás proyectos en los que se está trabajando, si es
el caso.

La plani�cación consiste en profundizar en la de�nición de las fases, detallando el tiempo
y los recursos de los que se dispone. Se tendrá que estudiar la posible saturación del personal,
dejando previstas las actividades, los recursos e incluso cómo se ejecutarán los fondos para poder
cumplir con los tiempos comprometidos de las actividades.

Se generará en esta fase un cronograma, que podrá realizarse mediante un diagrama de
Gantt, indicando dónde y cuándo es el lugar y el momento en el que se tendrá que intervenir.
En el diagrama de Gantt se incluirán los tiempos y el personal.

También se tendrá que hacer un listado aproximado de costos, para veri�car que se ajusta
al presupuesto. Este listado se generará, por primera vez, en la fase de formulación. En la etapa
de plani�cación se revisará y se actualizarán costos, ya que pueden modi�carse los precios o el
cambio de divisas.

En esta fase se suele producir un acercamiento a los bene�ciarios, se interactuará mediante
convenios.

2.2. Metodología de intervención

Primero se deberán tomar como referencia los hitos de lo que se ha comprometido. En base
a esto, se plani�cará, de�niendo la temporización de cada etapa. Por las características de los
escenarios, la plani�cación dependerá en gran medida de la realidad de la zona. Por ejemplo, se
deberá tener en cuenta que no es conveniente plani�car la etapa de instalación en temporada de
lluvia, salvo retrasos, cruces con otros proyectos u otros imprevistos, por los que se tenga que
llevar a cabo alguna etapa bajo peores condiciones climáticas.

De acuerdo a la plani�cación temporal, de�nidos los plazos y los hitos, se determinará la
necesidad de recursos humanos para cumplir con las actividades. También se deberá plani�car
la disponibilidad de recursos materiales, como por ejemplo, los instrumentos de medición. No se
deberá olvidar plani�car el gasto de los fondos, en función del momento en el que se reciban.

2.3. Plani�cación temporal

Esta sección consiste en la a�nación del cronograma de�nido en la fase de formulación. De-
berán de�nirse las fases y los hitos. Para las fases se tendrá que determinar la duración prevista
y para los hitos, las fechas límite.

La duración de cada fase depende de la magnitud de cada proyecto, pero aquí se va a dar
una idea de la duración aproximada de cada etapa:

Normalmente, la etapa de estudio de campo puede durar alrededor de un mes. La etapa de
diseño puede llevar también un mes dependiendo de la topología y de la complejidad de la red
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que se va a desplegar.

La parte de compras puede dilatarse uno o dos meses en función del diseño y de los materiales
y equipos que haya que importar o comprar localmente.

En la etapa de simulación se tendrán que montar los equipos, con�gurarlos y hacer las prue-
bas de acuerdo a la topología que ya se haya de�nido, esto puede demorar alrededor de unos
quince o veinte días, dependiendo del tamaño y de la complejidad de la red. A la vez se generará
la documentación de esa red, el plan de direccionamiento IP y los protocolos de pruebas. La
etapa de acondicionamiento de los materiales puede durar unos veinte o treinta días.

La demora de la fase de envío depende de la zona de intervención, si el destino es una ciudad
principal puede ser de una o dos semanas, en caso de que el escenario sea sierra, una semana,
en el caso de zonas de selva suele tardar unos diez días. Para repartirlo a los puntos �nales, en
sierra será necesario dos o tres días y en el caso de la selva, hasta una semana o quince días
porque el medio de transporte es el río.

La etapa de instalación puede durar uno o dos meses, dependiendo del tamaño y las compli-
caciones que haya. La fase de pruebas puede llevar alrededor de veinte o treinta días.

Se deberá tener en cuenta que el trabajo en campo es muy duro, se trabaja en zonas muy
difíciles y eso obliga a tener a las personas por tiempo limitado. Realmente una persona no rinde
más de veinte días en campo.

2.4. Recursos humanos

También se deberá determinar los recursos humanos con los que se cuenta. El número de per-
sonas necesarias se calculará en función del número de puntos. El personal se suele estimar por
horas/hombre incluyendo el cargo, por ejemplo horas/hombre-técnico, horas/hombre-ingeniero,
etc. Se suele empezar a de�nir en la fase de formulación.

Se formarán grupos de trabajo para que puedan intervenir más rápido en las instalaciones,
en las pruebas, en la preparación de material, etc. Se requiere cierta especialización en cada
actividad del personal encargado. Se podrá incluso contrar a alguna empresa especializada, por
ejemplo, para la preparación de las cajas.

Como ejemplo, en un proyecto realizado por GTR de trece puntos en zonas de selva, se
formaron dos grupos de torreros para instalar las torres en paralelo. En el caso de sierra, el
número de torres suele ser menor, por lo que un grupo trabajaba en los repetidores y otro grupo
trabajaba haciendo las pruebas e instalando los equipos en cada sitio.

Los grupos de torreros pueden ser de cuatro o cinco personas. En el caso de las instalaciones
de los equipos en los puntos cliente, pueden ser grupos de dos o tres personas.

Una clave fundamental para reducir costos es disponer de abundante documentación ya que
intervienen muchas personas. GTR siempre trabaja sobre un diseño. Se deberá crear gran canti-
dad diagramas y esquemas. Éste es el modo mediante el cual se sincronizarán las distintas fases
de los proyectos. La cantidad de información necesaria depende de la magnitud del proyecto.
Al aumentar el numero de personas aumenta la cantidad de información necesaria de forma
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exponencial ya que hay más interacción del personal. Una clave para reducir el número de in-
teracciones es fraccionar los trabajos.

El número de personas necesarias y la cantidad de trabajo no siguen una relación lineal. Se
deberá buscar el punto óptimo de máxima e�ciencia entre el personal dedicado, lo que in�uye
en el coste, y la duración de los trabajos. Habrá que tener en cuenta los límites temporales del
�nanciador para la entrega �nal.
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DISEÑO DE LA RED

Figura 3.1: Grá�co Fase Diseño
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3.1. Estudio de necesidades

Esta tarea se realizará únicamente en los proyectos de cooperación. El estudio de necesidades
se destina a conocer las características especiales de los bene�ciarios como usuarios de la red. Se
deberán determinar las necesidades generales de comunicación y acceso a la información.

Algunos de los datos interesantes sobre los bene�ciarios, de los que se dispondrá una vez
�nalizada esta tarea, serán la disposición a participar en el proyecto, la necesidad de comuni-
cación con otras instituciones, la posible colaboración en seguridad y mantenimiento, etc.

Se creará un documento de diagnóstico de necesidades de comunicación y acceso a la in-
formación. Se va a dar un ejemplo de las posibles variables de estudio y de las herramientas a
emplear para este diagnóstico.

3.1.1. Variables de estudio

- Contexto general. En esta dimensión se analizará el contexto en el que se desarrolle la
intervención, teniendo en cuenta los ámbitos nacional, regional, provincial y distrital.

o Ubicación geográ�ca. Mapas.

o Población total de la zona (distribución territorial, por sexo y edad).

o Índice de desarrollo humano (IDH). Acceso a los servicios básicos.

o Directorio de autoridades.

o Programas del estado. Programas de la cooperación internacional.

o Planes de extensión de infraestructuras de telecomunicación públicas previstas por el
gobierno central, regional y local para la zona de estudio.

o Datos detallados a nivel distrital:

* Períodos estacionales: ciclos anuales en clima, actividades económicas, civiles (p.e.
de la municipalidad), culturales, religiosas.

* Infraestructuras públicas de acceso en la zona: transporte, energía, servicios bási-
cos y telecomunicación. Croquis, plano de ubicación con rutas de acceso.

* Mapeo de actores (instituciones públicas, privadas, empresas del sector TIC,
ONGs, etc. que trabajan en la zona de intervención): identi�cación, relaciones
entre ellas.

- Caractenización física de las instituciones.

o Análisis de la infraestructura física: edi�cios, descripción de ambientes, plano, mapa
de ubicación, etc.

o Infraestructura de acceso a energía eléctrica: si se trata de red o sistemas autónomos
(fotovoltaicos/motor Diesel).

o Dotación de medios de transporte.

o Equipamiento informático y de telecomunicación de los establecimientos y distribu-
ción de las infraestructuras de comunicación e información.

o Costo de operación y mantenimiento de los servicios TIC, a nivel institucional, de-
sagregado por servicio de telecomunicación (voz e Internet).

o Viajes: frecuencia, destinos más frecuentes, motivos más frecuentes, duración y coste.

o Instituciones con las que se relaciona la institución (mapeo de actores externos: tipo
de institución, grado de acercamiento, poder, tipo de relación).
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- Caracterización de la organización de las instituciones.

o Estructura organizativa (departamentos: funciones, recursos).

o Estructura territorial.

o Cultura organizativa: valores, identi�car los ritmos y ritos (diarios, semanales, men-
suales y anuales) de la organización.

- Caracterización de las personas de las instituciones.

o Caracterización de usuarios: nivel de formación, edad, género, frecuencia en uso de
TIC, predisposición para usar las TIC, TIC conocidas y utilizadas, grados o cursos
de capacitación.

o Necesidades de capacitación para desarrollar su trabajo, preferencia y facilidades que
posibilitarían su participación en capacitaciones futuras.

- Caracterización de los procesos de las instituciones.

o Mapeo de comunicación e información - Entidades de información. Datos y entregables
que recibe o genera cada institución en su relación con otras y al interno en relación
con sus áreas funcionales

o Mapeo de procesos. Identi�cación general de los macro-procesos institucionales: fun-
ción, clientes, resultados

3.1.2. Herramientas para el estudio de necesidades

En función del proyecto a realizar, las herramientas para el estudio de necesidades se podrían
encontrar entre éstas:

- Talleres internos. Se dedican a levantar información �na de una institución determinada.

- Entrevistas para las instituciones. Dan información sobre la institución.

- Encuestas. Se pueden realizar a los futuros usuarios.

- Transectos de la estructura física. Se recopilará información sobre la estructura de los
edi�cios.

- Reuniones con las instituciones bene�ciarias. Se destinan a obtener información directa de
los responsables de las instituciones.

- Reuniones con los socios de la zona (si los hay). Se realizarán los acuerdos necesarios con
los socios.

- Talleres externos. Destinados a levantar información intrasectorial y distrital de cada zona.

- Cursos. Se dedican a capacitar y crear espectativa.

3.2. Prediseño

Se deberá de�nir la zona de intervención. Durante el estudio de necesidades se habrán cono-
cido determinadas características de la zona. Con esta de�nición se procederá a la validación en
campo.

El prediseño dependerá de la tecnología de acceso y de topología de la red.
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3.2.1. Puntos cliente

Los puntos cliente se habrán de�nido en la fase de formulación. Se habrán veri�cado los
lugares y sus coordenadas. Dentro de cada comunidad a veces también se hace una distribución
de la red, se deberá haber comprobado las condiciones de cada punto y con qué recursos se cuenta.

En el caso de la selva se deberá conocer si se cuenta con movilidad, cuántas personas hay en
el establecimiento, qué funciones tienen, etc. En una ciudad de sierra se tendrán que comprobar
las facilidades para instalar la infraestructura, techos, soportes...

3.2.2. Selección de posibles puntos repetidores de la red troncal

Los principales criterios para seleccionar los puntos repetidores, en el tipo de redes que
implementa GTR, son:

- Se preferirá que estén en una zona de fácil acceso.

- Deberá existir línea de vista entre repetidores.

- Se deberá tratar de que los enlaces no superen los 50 km.

Se buscarán previamente las coordenadas mediante el nombre de las comunidades. En base
a estas coordenadas y otros documentos, se ubicarán los posibles puntos repetidores, gracias a
Radio Mobile (ver Apéndice A), que permite dibujar sombras de cobertura. Se hará una primera
simulación. Con esta simulación se podrá determinar la necesidad de ubicar puntos intermedios.

Posteriormente a la realización del prediseño, se veri�cará en campo cómo de accesible es
llegar a ese lugar.

Existirá diferencia de criterios para los diversos escenarios:

En el caso de zonas de selva, si son puntos muy distantes, se recogerán coordenadas de comu-
nidades intermedias. Aunque Radio Mobile indique menos, por experiencia en campo de GTR,
las alturas de las torres serán de más de 45 metros para enlaces de 10 a 30 km; para enlaces de
30 a 40 km, la altura mínima será de 60 metros, etc.

En el caso de la sierra, se determinarán los posibles cerros para ubicar los repetidores. En
sierra las torres no son tan altas ya que se suelen ubicar zonas elevadas. Se deberá veri�car la
línea de vista, que no existan obstáculos.

3.2.3. Selección de posibles puntos repetidores de la red local

Para el tipo de redes que diseña GTR, se elegirá como repetidor local uno de los puntos
cliente. Se seleccionará el más elevado, siempre que tenga línea de vista hacia los demás.

Esta selección también dependerá del tipo de antenas. Por ejemplo, si se va a instalar una
antena sectorial, el punto repetidor de la red local será el que tenga línea de vista hacia el repeti-
dor troncal y pueda abarcar a los demás clientes.

En este momento se tendrán los posibles puntos donde se ubicarán los nodos. Se deberá
disponer de las coordenadas y de la altura del terreno. Se habrá creado un prediseño.
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3.3. Estudio de campo

En la etapa de estudio de campo se deberán con�rmar las características y requerimientos
especiales de la zona de trabajo. Esta fase consiste en la visita a los posibles nodos de la red,
incluyendo la plani�cación de estas visitas, la coordinación para llevarlas a cabo y la de�nición
de recursos a emplear, como las herramientas y el equipamiento.

Si se realizara el estudio de campo de forma participativa, también se deberá incluir la pla-
ni�cación de las reuniones con los bene�ciarios y la posible �rma de convenios.

El estudio de campo consiste en validar el prediseño o, por el contrario, determinar la necesi-
dad de modi�carlo. En el terreno se comprobará cuál es la locación óptima de entre los posibles
puntos intermedios que se obtuvieron con Radio Mobile.

3.3.1. Elementos indispensables

Se propone un pequeño listado con los recursos que no deberán faltar durante el estudio de
campo:

- Equipo GPS.

- Cámara fotográ�ca y/o cámara de video.

- Brújula.

- Catalejos.

- Herramientas básicas.

- En algunos casos, equipos para pruebas.

3.3.2. Información a recoger

A continuación, se proponen los datos que se deberán registrar:

- Coordenadas geográ�cas puntos cliente:
Punto / Localidad / Coordenadas (Latitud / Longitud) / Altura (m)

- Coordenadas geográ�cas puntos repetidores troncales y locales:
Punto / Coordenadas (Latitud y Longitud) / Altitud (msnm.) / Lugares que se observa
(distancia (km))

- Lectura de resistividad del terreno:
Punto / Resistividad (Ohm)

- Movilidad:
Punto de partida / Punto de llegada / Tipo / Distancia (km) / Tiempo de desplazamiento
(min) / Consumo de combustible (litros)

- Autoridades:
Comunidad / Autoridad / Nombre y apellidos / Teléfono / E-mail

Se deberá completar esta información con fotografías, videos.
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3.3.3. Visita de campo

Para llevar acabo esta fase será preferible disponer de un formato de recogida de la informa-
ción. Éste, será diferente para los distintos escenarios (selva y sierra).

En primer lugar se deberá determinar el plazo de la actividad y la responsabilidad de que
éste se cumpla. Se de�nirán los lugares que se visitarán, de acuerdo con el prediseño. Resultará
conveniente conocer el tiempo que se empleará en cada desplazamiento a las ubicaciones bajo
estudio. Se relizará la plani�cación de las visitas y reuniones.

Las salidas de campo suelen ser costosas, en cada viaje se deberá recopilar la máxima infor-
mación posible para un correcto estudio de gabinete.

Durante el estudio de campo, para determinar la ubicación de un repetidor, se visitarán di-
ferentes lugares. La elección se basará en la existencia de visibilidad directa con los otros nodos.

Se realizarán las mediciones y se recopilará la información descrita en el apartado anterior. Se
deberá veri�car la altitud y las coordenadas geográ�cas con GPS, se comprobará la accesibilidad
al lugar, la existencia de energía, de posibles obstáculos o infraestructura de telecomunicaciones
ya desplegada, incluso se tomará información de la resistividad del suelo.

También será interesante conocer la propiedad del terreno para poder solicitar y obtener au-
torizaciones para instalar los equipos. Como información complementaria se podrá determinar
la visibilidad para posibles enlaces futuros.

En las visitas a los repetidores locales y a los puntos cliente, se realizará la inspección de
las instalaciones y se comprobará la línea de vista con otros puntos para determinar la mejor
ubicación de los equipos.

La parte complementaria a las visitas serán las reuniones con los socios de la zona, si los
hubiera, con los responsables de los puntos cliente y repetidores y con los gobiernos y otras
instituciones que intervengan.

En las reuniones con los socios de la zona se acordarán convenios de participación. Se deberá
determinar, en las reuniones con los responsables de los puntos cliente, el interés en colaborar
y participar en el programa y la disposición de personal para el apoyo durante los trabajos de
instalación de equipos o para ser capacitados en tareas de mantenimiento. En las reuniones con
los gobiernos, se explicarán los alcances del proyecto y las diversas necesidades, se determinará
su posible participación en el proyecto, así como se solicitarán las aprobaciones de los trámites
necesarios.

Podría ser apropiado componer un plano de los lugares visitados.

3.4. Diseño de gabinete

En esta fase se de�nirán los tipos de enlaces y las tecnologías, así como la altitud y coorde-
nadas de los nodos y las distancias de los enlaces.
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El diseño se deberá desarrollar en base al estudio de necesidades y al estudio de campo. Se
deberá disponer de los requisitos, es decir, de los servicios sobre la infraestructura a implementar,
lo que estará relacionado directamente con el ancho de banda requerido.

3.4.1. Servicios sobre la infraestructura

La elección de los servicios sobre la infraestructura de los que se dispondrá, será conjunta de
los bene�ciarios y los implementadores.

En las redes implementadas por GTR se está seleccionando Internet y VoIP, ya que se está
eligiendo una tecnología que ofrece alrededor de 10 Mbps. Si se implementara otra tecnología se
podría pensar en otros servicios.

- Servicio de acceso a Internet.

Se de�nirá la ubicación de los puntos de conexión a Internet. Se deberá instalar un servi-
dor que gestione las salidas a Internet y equipos de acceso a Internet (provistos por el
proveedor de acceso).

Se calculará el ancho de banda disponible por cada zona (ancho de banda disponible en la
troncal dividido entre el número de zonas), luego cada zona debe contratar un servicio de
acceso a Internet efectivo de ese ancho de banda.

- Servicio de telefonía (VoIP).

Se empleará telefonía de voz sobre IP (VoIP), la cual permite a los usuarios hacer y recibir
llamadas usando el protocolo de Internet, también permite integrar voz con aplicaciones
de datos.

Se de�nirá la ubicación del servidor de telefonía. Los servidores de telefonía se instalarán
en cada repetidor local. Se calculará el número de llamadas en simultáneo que puede con-
trolar cada servidor y se determinará el número de anexos locales y si se podría expandir
a más usuarios. Las llamadas dentro de la red serán gratuitas.

Se determinarán los lugares de instalación de sistemas de comunicaciones de voz. se
de�nirán los números telefónicos de cada punto de red.

- Aplicaciones adicionales.

En función de las necesidades de los usuarios, a través de la red diseñada se podría acceder
a aplicaciones tales como:

o Tele educación (cursos en línea, educación a distancia, tutoriales...)

o Tele medicina (tele consultas y transmisión de información)

o Aplicaciones cliente servidor (bases de datos, programas corporativos...)

o Acceso a servidores web, correo electrónico, ftp...

o Comercio electrónico

o Acceso a información del estado, económica...

o Tele vigilancia, tele trabajo...
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3.4.2. Descripción general de la red de telecomunicaciones

En este punto se de�nirá el alcance general del proyecto, distinguiendo si se instalarán sis-
temas de voz, datos o ambos para tener acceso a telefonía y/o Internet. Se descibirán las zonas
involucradas �nalmente y las posibles ampliaciones futuras.

Se describirá el tipo de enlaces (inalámbrico/cableado), la tecnología de red que se empleará
y su topología.

En esta guía hablaremos de enlaces inalámbricos con tecnología Wi-Fi, ya que GTR está
desarrollando esté tipo de redes.

Se crearán tablas con los datos georreferenciales (latitud, longitud y altura) de los puntos
que comprenden la red troncal, repetidores locales y puntos �nales.

Para visualizar la topología general se incluirá un esquema general de la red troncal, los
enlaces de distribución, los repetidores locales y las estaciones cliente.

- Repetidores troncales:

En la red troncal, se de�nirá el tipo de enlace (ptp/ptmp), la distancia de los enlaces,
calculada en base a las coordenadas, y el número n de repetidores (por tanto n-1 enlaces).
Resulará útil nombrar los repetidores. Si los enlaces representan grandes distancias (km),
será conveniente usar antenas directivas e interfaces inalámbricas de alta potencia.

Empleando el software Radio Mobile (ver Apéndice A), se diseñará cada uno de los enlaces
troncales. Se utilizarán equipos inalámbricos 802.11b/g o 802.11a, en función de la banda
de frecuencia seleccionada (5,8GHz o 2,4GHz, respectivamente).

En cada enlace se cuidará que, para cada estación repetidora, se con�guren enlaces con-
tiguos en polarizaciones diferentes (vertical/horizontal).

El software de Radio Mobile permite mostrar las �guras con los enlaces y sus per�les.

- Repetidores locales:

Se de�nirá la ubicación de cada repetidor local, así como el punto de conexión con la red
troncal.

Se determinará el tipo de enlaces (ptp/ptmp), el número y nombre de los repetidores lo-
cales, el número de clientes por cada estación repetidora y la distancia de los enlaces locales
y de los enlaces a la red troncal.

También habrá que establecer la frecuencia y el estándar inalámbrico de los enlaces de
distribución.

- Estaciones �nales:

Se re�eren a los puntos �nales de conexión, en los que se dotará de conexión a Internet
y acceso a la red telefónica del proyecto. Se determinará los puntos donde se dará algún
tipo de acceso y cuál.
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Se de�nirá el voltaje de la alimentación eléctrica a la que trabajan los equipos. Se de-
tallarán las características de los equipos de cómputo instalados en los establecimientos:
Computador personal de bajo consumo (placa, memoria, fuente de alimentación) y equipos
de impresión (impresora).

En los enlaces de distribución, entre el repetidor local y los puntos cliente las distancias
son pequeñas (m) y sólo se necesitará de interfaces de baja potencia y antenas de baja
ganancia en los repetidores y establecimientos.

- Presupuesto por enlace:

Mediante el software de Radio Mobile (ver Apéndice A) se realizará el cálculo de cada uno
de los enlaces, haciendo una predicción de los márgenes de operación del sistema, deter-
minando los ángulos acimutales, ángulos de inclinación y los despejes de la zona de Fresnel.

Los parámetros por enlace que se pueden ajustar son la frecuencia mínima (MHz), la
frecuencia máxima (MHz), el modo estadístico (difusión:% tiempo /% ubicaciones /%
situaciones), el clima, el sistema empleado, el tipo de antena y las pérdidas de línea.

La banda de frecuencias (2,4 o 5,8 GHz) se de�ne considerando las posibles interferencias
con equipos ya instalados. El usar la banda de frecuencias menos saturada nos permitirá
un mayor tiempo sin interferencias para los enlaces y un buen ratio Señal/ruido.

- Ejemplo de distribución de antenas:

En un repetidor intermedio habrá tres antenas, dos de ganancia alta para el enlace troncal y
otra de baja ganancia para el enlace de distribución. En los repetidores �nales únicamente
dos antenas (sólo hay un enlace troncal) y en los establecimientos �nales una antena.
Cada antena debe estar relacionada a una determinada interfaz inalámbrica, por tanto
habrá tantas interfaces inalámbricas como antenas.

3.4.3. Diseño del subsistema de telecomunicación

Generalmente se buscarán equipos que tengan aplicaciones lo más estándar posible, evitando
soluciones netamente propietarias.

Para los enrutadores GTR está empleando placas MIKROTIK y ALIX. Las nuevas placas
se deberán probar primero en laboratorio para luego enviarlas a campo.

- Sistema de telecomunicaciones de la red troncal:

Se determinará qué equipos (routers, antenas...) y el número de éstos que conforman el
subsistema de telecomunicaciones de cada repetidor. Se confeccionará una tabla con las
características de los equipos: Equipo / Fabricante / Modelo / Características.

Se diferenciarán los equipos empleados en los enlaces troncales y en los enlaces de distribu-
ción, de�niendo la interfaz inalámbrica 802.11 y la antena, el enrutador - computador, los
cables coaxiales y los cables pigtail empleados.

- Sistema de telecomunicaciones de los repetidores locales:

Se enumerarán los equipos que conforman el sistema de telecomunicación (interfaz inalám-
brica, enrutadores, antenas...). De cada elemento se determinará el fabricante, el modelo
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y sus características.

Los equipos a instalar son:

o Servidor de telefonía de VoIP y acceso a Internet.

o Router de acceso a Internet.

o Switch para la interconexión de equipos de comunicación a través de una red LAN
local.

o Punto de acceso para telefonía.

- Sistema de telecomunicaciones de las estaciones �nales:

Se elegirán los elementos de telecomunicaciones (router de acceso a la red, antena, ATA...)
necesarios.

3.4.4. Diseño del subsistema de infraestructura

Se deberá de�nir la fabricación de los elementos de las torres y su montaje, también la disposi-
ción de las cajas metálicas de alojamiento para estaciones cliente, repetidores locales y troncales.

Habiendo hecho un estudio exhaustivo con Radio Mobile (ver Apéndice A), GTR obtiene las
alturas de las torres mediante el método siguiente:

1. Comenzar encontrando las alturas que nos garantizan 0.6F o 0.7F de despeje en el peor
punto de la trayectoria de enlace.

2. Añadir a estas alturas 10 metros en los centros poblados rurales y 5 metros en las ciudades
grandes.

- Sistema de infraestructura de la red troncal:

Se dará la ubicación de cada punto repetidor. Se explicará por qué elementos está confor-
mada (torres, casetas, soportes para antenas, plataformas de montaje de antenas...).

- Sistema de infraestructura de los repetidores locales:

Se explicará de qué elementos está compuesta (soporte para las antenas, torre...).

- Sistema de infraestructura de las estaciones �nales:

Se enumerarán sus elementos, como postes (indicando su longitud) o soportes en �L�.

3.4.5. Diseño del subsistema de alimentación eléctrica

- Consumo de energía de la red:

Se deberá dimensionar el sistema para que alimente a los elementos necesarios (router,
sistema de vigilancia...).

- Fuente de energía:

Se determinará el tipo de energía (fotovoltaica/eléctrica de la red pública).
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Cuando la electricidad esté garantizada las 24 horas del día se utilizará la electricidad de
la red pública. En los demás puntos se deberán emplear sistemas fotovoltaicos. Se podría
emplear un sistema dual, que, cuando no se disponga de la electricidad de la red, se emplee
la de los paneles.

- Sistema de almacenamiento:

También habrá que de�nir el sistema de almacenamiendo, en función de la autonomía que
interese que disponga.

- Elementos:

Habrá que enumerar y de�nir los elementos que compondrán el sistema (controladores,
paneles solares, baterías...).

Se podrá estudiar la posibilidad de añadir baterías de libre mantenimiendo. Se tendrá que
tener en cuenta que poseen menor amperaje/hora por lo que se requerirá mayor número
de baterías para poder cubrir la carga.

3.4.6. Diseño del subsistema de protección eléctrica

- Sistema de protección eléctrica de la troncal:

Se deberán de�nir los elementos de los que consta el sistema: pararrayos, pozos a tierra,
barra master, protectores de línea y accesorios adicionales. Se determiná el tipo de pozos a
tierra a construir en las estaciones (horizontales/verticales), longitud lineal, forma, ancho
de la sección y profundidad. Se decidirá si se instalan UPSs para proteger los equipos ante
�uctuaciones y cortes de energía eléctrica.

- Sistema de protección eléctrica de los repetidores locales:

Los elementos que se de�nirán son el pozo a tierra, la barra master, los protectores de
línea y accesorios adicionales. Para proteger a los equipos de cambios buscos en el sistema
de energía se podrán emplear UPSs que además servirían como sistemas de respaldo de
energía en caso de corte.

- Sistema de protección eléctrica de las estaciones �nales:

Se determinará el pozo a tierra, la barra master y accesorios adicionales que se vayan a
emplear. Si las antenas están ubicadas fuera del alcance de los rayos no será necesario
emplear protectores de línea. Se podrán usar UPSs.

3.4.7. Diseño del subsistema de seguridad y vigilancia

En los repetidores, se podrá instalar un servicio de vigilancia remota que cumpla las siguientes
funciones: di�cultar el acceso a intrusos (cerco o enmallado), detectar la presencia de intrusos
(sensores de presencia y cámaras de vigilancia), interacción con el sistema de telecomunicación
para reportar la presencia de intrusos por correo electrónico y/o telefonía, activación de alarmas
que permitan poner en alerta a los bene�ciarios, etc.
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3.4.8. Diseño del subsistema informático

Generalmente se instalarán sistemas operativos abiertos basados en Linux, debido sus apli-
caciones y a las limitaciones de presupuesto para la compra de liciencias.

GTR emplea VoyageGTR, se incluye su de�nición en el Apéndice E.

3.5. Validación del diseño de red

Esta tarea se puede realizar mediante un diseño participativo. Consiste en validar con los
bene�ciarios y con el resto de los actores que están involucrados. Implica coordinación y acuer-
dos, por ejemplo con propietarios de terrenos.

También se podría validar el diseño en función del presupuesto o de forma técnica si el proyec-
to no es de cooperación. En esta guía se va a de�nir la validación mediante diseño participativo.

3.5.1. Metodología del diseño participativo

Se ejecutará la presente actividad con el �n de realizar la devolución de los principales hallaz-
gos del diagnóstico participativo de necesidades de información y comunicación, y por otro lado,
de�nir el diseño de la red con la participación de los representantes de los sectores involucrados.

Previamente se de�nirán los datos para la plani�cación, como la fecha, el lugar, la duración
y los participantes.

Los objetivos especí�cos del diseño participativo serán:

- Socializar los resultados del diagnóstico y obtener comentarios de los actores.

- Brindar información sobre la red y los servicios a instalar.

- Veri�car disposición a aportar para ampliación de red.

- Con�rmar, en primera instancia, el compromiso de los bene�ciarios en el mantenimiento
futuro de la red a instalar.

- Levantar información complementaria que, a partir del primer estudio de necesidades se
haya identi�cado como necesaria.

3.5.2. Actividades de los talleres

Este diseño participativo se podrá llevar a cabo mediante un taller. Este taller se diseñará
tratando de que los participantes formen parte activa. Se utilizarán técnicas participativas que
facilitarán la intervención de los actores locales. Las actividades podrían organizarse secuencial-
mente como sigue:

1. Presentación del taller:

- Presentación del programa y a sus socios.

- Presentación del objetivo de la Red de Telecomunicaciones e Informática.

- Presentación del objetivo del taller.
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2. Presentación de los participantes:

- Dinámica de la red: Para motivar a los participantes a tejer una red de personas e
instituciones.

- Dinámica del teléfono malogrado (Importancia de la Comunicación): El facilitador
ordena a los participantes en un círculo del cual él forma parte. Seguidamente indica
que el dará una información al participante que está a su derecha y este deberá dar
la misma información al participantes de su derecha y así sucesivamente hasta que
la información llegue a la persona que inicio dicha cadena de información. Luego el
facilitador, que es quien inicio la información, dará a conocer lo que recibió y dará a
conocer también el texto completo de la información inicial para que los participantes
puedan apreciar si llegó completa o no.

3. Devolución del diagnóstico de necesidades de información y comunicación:

- El facilitador hace una breve presentación del estudio de necesidades realizado en la
zona de intervención.

- Se entrega a los participantes grá�cos de población, equipamiento por sector, viajes
y organigramas para motivar a la discusión y análisis.

- Los participantes hacen observaciones a la información recibida.

- Se hace un listado de conclusiones.

4. Trabajo en grupos:

- Los asistentes mediante una dinámica son divididos en grupos de trabajo para res-
ponder los interrogantes planteados:

o En qué parte de las conclusiones están de acuerdo y en cuáles no.

o Qué nueva información importante para el programa hay en la zona.

- En cada grupo, los participantes, mediante una lluvia de ideas e intercambio de opi-
niones generan propuestas que complementen y ayuden a una mejor intervención del
proyecto en sus zonas de trabajo. Esto enriquece los preliminares de la intervención.

- Se realiza un listado de las instituciones a las cuales debería llegar la red.

- Un representante de cada grupo socializa sus conclusiones.

- La información que se pretende obtener son propuestas generales para la intervención
que mejoren el estudio de necesidades en los temas siguientes: instituciones educativas,
políticas locales sobre el tema, datos sociales y económicos nuevos, vías de acceso a
la localidad, medios de transporte, costos de desplazamiento (medir los viajes para
salir de la zona y comparar cuando se tenga el proyecto, centros poblados y caseríos
con los que se relacionan, infraestructura de comunicación y acceso a información.

- Un miembro de nuestro equipo irá recogiendo los datos para generar una retroali-
mentación inmediata.

5. Las TIC en nuestra institución:

- Se explica con un grá�co como las TIC apoyan a las personas y procesos para conseguir
los objetivos estratégicos institucionales.

6. Descripción de otra red:

- Se usa otra red para explicar:

o Principales elementos y servicios brindados por una red inalámbrica.

o Descripción de la red troncal y sus servicios.

- A partir de la red descrita se presenta la red troncal.
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7. Diseño participativo de la red local (ubicación de locales):

- Se indica que se describirá la red local y se empieza ubicando los locales.

- Se ubican también otros locales que aunque no están previstos podrían ser bene�cia-
rios potenciales y se priorizan por votación de los presentes.

8. Diseño participativo de la red local (ubicación de servicios):

- Con los locales ya ubicados se pide a los participantes que ubiquen los servicios que
se brindarán: telefonía, Internet y computadora.

9. Acuerdos y Compromisos:

- Se listan las tareas y compromisos que asumen las instituciones y el Programa.

10. Cierre del taller.

3.6. Listado de equipamiento aproximado

En función de la red que se va a montar y gracias a la experiencia de GTR con algunos
equipos, se tienen de�nidas unas marcas y modelos con los que se trabaja.

Normalmente GTR emplea las placas ALIX o SOEKRIS.

En función de los enlaces y de las distancias, el tipo de antena que se emplea también es
conocida, se usan antenas de panel, de grilla, parabólicas, etc. Tanto el tipo de antena como el
tamaño de la torre se de�ne de acuerdo al estudio de campo y al diseño de gabinete.

Otros equipos básicos son las fuentes de alimentación. Si hay energía, se utilizan UPS, es-
tabilizadores. Si no hay energía se utilizan paneles solares y todo lo que conlleva un sistema de
energía solar. GTR está trabando con sistemas de cuatro días de autonomía.

En cuanto al sistema de protección eléctrica, ya se tienen de�nidos los pozos a tierra. Nor-
malmente son horizontales, ya que se logran mejores resistividades, pero depende de la zona en
la que se va a trabajar. Por ejemplo, en zonas rocosas, debe ser horizontal. Si el suelo es bueno
y es fácil cavar, se puede hacer uno vertical.

Se debe buscar que los equipos sean de bajo consumo de energía, de bajo costo, robustos y
de fácil con�guración.

Normalmente, se trabaja con Linux, se trata en lo posible de emplear soluciones abiertas.

Por experiencia GTR trabaja con proveedores conocidos, que dan buenos precios y que
proveen en el tiempo que se necesita. Pero hay que ir comparando con otros proveedores del
mercado.

Se pueden requerir ajustes del diseño por razones económicas y debido a posibles ampliaciones
de nodos en la red.
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Figura 4.1: Grá�co Fase Compras

4.1. Listado �nal del equipamiento
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La primera actividad de este campo deberá ser la de�nición del listado de equipamiento �nal
de acuerdo al diseño. Si la selección de los equipos no se ajusta al presupuesto, se deberá retocar
el diseño.

Los requisitos necesarios de los dispositivos router para su uso en zonas rurales son:

- Bajo consumo. El dimensionado de los paneles solares será proporcional al consumo en-
ergético de los diferentes componentes que conforman el router. En este sentido es impor-
tante que el hardware usado tenga un consumo reducido.

- Bajo coste. No se pueden implementar soluciones de un alto costo que no sean sostenibles
a medio o largo plazo por las comunidades objetivo de estas redes.

- Reducido tamaño. De esta forma se asegura que el diseño �nal del router sea lo más
compacto posible.

- Robusto ante condiciones meteorológicas adversas. Ya que el router se suele instalar en
zonas de selva y alta montaña es necesario que tenga cierta robustez en cuanto a condiciones
extremas de temperatura y humedad.

- Tipo de procesador. El router debe contar con un procesador lo su�cientemente potente
para poder realizar las diferentes tareas que se le exijan.

- Número mínimo y tipos de interfaces inalámbricas. Debido a que el router actúa como
repetidor en diversos escenarios es recomendable que al menos cuente con 3 interfaces in-
alámbricas. Además, es necesario que estas interfaces sean de un tipo determinado (PCM-
CIA, CardBus, mini-PCI).

- Resto de interfaces. Además de las interfaces inalámbricas es necesario considerar otro tipo
de interfaces. Entre otras las dos más importantes son: una interfaz serie a través de la
cual poder acceder al router para labores de con�guración y mantenimiento, y al menos
una interfaz Ethernet para conectar otros dispositivos de red (por ejemplo un teléfono IP).
También es recomendable la existencia de una interfaz USB que permita extensiones o
conexiones futuras.

- Rangos y tipos de alimentación. Por razones de �exibilidad es recomendable que el router
cuente con un rango variable de alimentación. Valores alrededor de 12V resultan ser muy
útiles, ya que de esta forma se pueden alimentar de forma directa con el sistema de energía
solar. También será más que recomendable que la placa seleccionada tenga la opción de
poder ser alimentada a través de PoE (Power over Ethernet).

- Disponibilidad de watchdog. Se recomienda la existencia de un watchdog hardware que
permita reiniciar la placa cuando ésta se bloquee.

- Disponibilidad de compra en el medio/largo plazo. Este requisito resulta especialmente
importante, ya que es necesario asegurar de alguna manera que el hardware seleccionado
va a seguir siendo distribuido en el medio y largo plazo. Es más que recomendable tener
posibles alternativas localizadas en caso de que sea necesario llegar a usarlas.

En el Apéndice B se puede encontrar una selección del siguiente equipamiento que GTR ha
empleado en alguno de los diseños:

- Single board computers (SBCs).
Son computadoras completas construidas en una sola tarjeta de circuito impreso (PCB,
printed circuit board). Ellas incluyen microprocesador, memoria RAM, puertos de entrada
y salida. No suelen incluir puertos para teclado y monitor, pues su �n no es trabajar co-
mo computadora de escritorio, sino servir para un propósito especí�co como puede ser un
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dispositivo de telemetría o un router. Por este motivo también son llamadas �computado-
ras empotradas� ó �embedded systems�. Algunas incorporan un sistema operativo y otras
poseen ranuras para insertar discos duros de estado sólido en formato SD (Secure Digital)
o CF (Compact Flash).

- Tarjetas de red inalámbrica.
La elección de tarjetas Wi-Fi se basa en parámetros tales como la potencia de trans-
misión, sensibilidad de recepción, temperatura y humedad soportadas en operación, así
como chipset incorporado. Esta última condición es importante, ya que es necesario dispon-
er de soporte para un S.O. GNU/Linux para todos los modos (Master, Managed, Ad-hoc,
Monitor) para poder construir puntos de acceso, puentes, repetidores y encaminadores.

- Pigtails.
Los pigtails son cables coaxiales con conectores adecuados para las tarjetas de red inalám-
bricas.

- Antenas.
Las antenas son dispositivos pasivos que convierten la señal de radio frecuencia enviada por
los cables coaxiales en ondas electromagnéticas que se propagan en el espacio y viceversa.

4.1.1. Listado aproximado de elementos del subsistema de telecomunicación

- Router empleado en los repetidores troncales, en los repetidores locales y en los clientes
�nales.

- Computadora embebida para repetidores locales empleada como servidor de telefonía.

- Memoria empleada como disco duro en las computadoras embebidas.

- Tarjeta inalámbrica empleada en cada tipo de router.

- Antena empleada en los enlaces troncales.

- Antena empleada en los enlaces locales para enlazar a su troncal correspondiente.

- Antena empleada en los repetidores locales para enlazar con otros repetidores locales.

- Antena empleada en los repetidores locales para repartir la señal a las estaciones �nales.

- Antena empleada en las estaciones �nales.

- Filtros de señales en la banda de 5.8 o 2.4 GHz (para reducir interferencia).

- Pigtails.

- Cable coaxial (para conexiones a las antenas).

- Adaptador telefónico que se empleará en el punto de acceso a la RTC para conectar las
líneas telefónicas proporcionadas por la empresa telefónica.

- Adaptador telefónico para todos los puntos de instalación.

- Teléfono para todos los puntos de instalación.

4.2. Clasi�cación y procedimiento de las compras

Para la clasi�cación y procedimiento de las compras se distinguirá entre productos locales e
importaciones, en función de la �nanciación.
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4.2.1. Productos locales

Se evaluarán precios en la zona, aunque a veces el precio es muy elevado. También dependerá
de los tiempos. Se deberá jugar con las variables tiempo y precios.

Por ejemplo, GTR suele comprar los materiales para la obra civil en una ciudad principal
cercana a la zona de intervención. GTR suele comprar en Lima el material eléctrico y los equipos
del sistema de protección eléctrica.

4.2.2. Importaciones

El equipamiento como las placas, los routers o las antenas, dependiendo del tipo, se podrán
comprar localmente o se importarán. También depende de los montos porque si el despliegue es
muy grande y los costos son más elevados se pre�ere importar.

4.2.3. Razones de la elección

La elección dependerá en gran parte de los precios, pero también interesará incentivar a los
proveedores locales, para que sigan trayendo materiales y sea más fácil conseguir repuestos.

También in�uye en la elección el tiempo que demoran las importaciones, ya que se pueden
requerir permisos y estas empresas ya disponen de ellos.

4.3. Ejecución de las compras

De�nido el diseño de la red y de�nido el equipamiento (características técnicas y comerciales
para elegir un producto) se buscará generar la lista �nal de requerimiento indicando el equipo y
las unidades necesarias.

En el proceso de compras, para de�nir la estrategia a seguir, se deberá buscar la línea crítica
en función del costo de los equipos y el tiempo que reservar a la compra de cada equipo. Se
deberá destinar más tiempo a los productos que representen un costo mayor en el presupuesto.

4.3.1. Cotización y evaluación de propuestas

GTR solicita tres cotizaciones para evaluar los precios y disponibilidad de los productos en
el mercado local.

Se podrá trabajar con proveedores conocidos o se buscarán nuevos en Internet o en las pági-
nas amarillas. Se podrá contactar mediante correo electrónico o por teléfono. Se preguntará por
la disposición de un determinado producto, si lo tienen, se solicitará que envíen las cotizaciones
y en base a esto se hará el requerimiento.

Para la elección de una determinada propuesta primero tendrá que cumplir con las especi-
�caciones técnicas que se han pedido, después se valorarán los costos y los tiempos de entrega.
También se valorará que el proveedor sea con�able y que la empresa sea sólida y de prestigio.
También se deberá requerir garantía del producto.

Algunas veces, como por ejemplo para los materiales de ferretería, GTR elige empresas
pequeñas, que dan mejores precios ya que sólo se dedican a esos rubros y ya son conocidos.
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4.3.2. Elaboración de órdenes de compra

Para los proyectos en los que se realiza la compra a través de ISF, GTR envia un correo a
ISF indicando la compra a realizar, para ello se adjuntan tres cotizaciones y la explicación de la
cotización ganadora.

Para los proyectos en los que se realiza la compra a través de Operaciones de la PUCP, se
genera una solicitud a través del sistema intranet de la universidad.

En general, se deben evaluar las cotizaciones, se enviará la orden de compra y los proveedores
entregarán en el tiempo establecido, que puede ser una semana o para importaciones puede
demorar de 15 a 40 días, en función del producto.

4.3.3. Permisos y homologaciones

Se podrá requerir la solicitud de permisos para ingresar productos tales como antenas o
equipos de comunicación como las tarjetas de radio, las placas, etc. En general para dispositivos
que irradian una cierta energía al ser productos electromagnéticos, se deberá explicar qué es
cada producto y se deberá cumplir con las normas del país.

Las computadoras normalmente no tendrán ningún problema, pero igualmente se enviarán
las especi�caciones técnicas del producto.

Esta aprobación podrá demorar de 15 a 20 días para la homologación. En la aduana permiten
retirar el producto únicamente si está homologado.

4.3.4. Ejecución de las compras

Se deberá partir del listado de compras, indicando el equipo (marca y modelo) y las unidades
necesarias.

Para la la lista de compras se tendrá que tener en cuenta las especi�caciones técnicas, las
exigencias del �nanciador y las especi�caciones nacionales.

Las compras se separarán en función del tipo de equipamiento, equipos de telecomunicación,
equipos de energía, sistema de protección... y se separarán por lotes. Si se superara un cierto
monto, se tendrá que licitar.

4.3.5. Recepción de las compras

El lugar de recepción de las compras dependerá del producto. Si se tratara de obra civil,
se recibirá directamente en la zona de intervención. Los routers, las cajas, etc. se recibirán en
el laboratorio, ya que habrá que con�gurar los equipos de comunicación, realizar las pruebas o
acondicionar las cajas, para después enviarlas.

Desde la orden de compra hasta la recepción podrá demorar de un día a una semana o si se
trata de un producto importado, hasta 40 días.

Durante esta fase se podrá comenzar con el envío de materiales.
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4.3.6. Inventario

Se deberá realizar un inventario de todos equipos recibidos.

Los equipos que haya que manipular se llevarán al laboratorio. Los equipos que no necesitan
manipulación se enviarán directamente a la zona de intervención, donde se guardarán en algún al-
macén. A veces se tendrá que almacenar en una ciudad principal cercana la zona de intervención.

Como documentación de esta fase, se encontrará la lista �nal de equipamiento, el inventario,
las cotizaciones y determinados cuadros comparativos de varios proveedores.
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SIMULACIÓN DE LA RED

Figura 5.1: Grá�co Fase Simulación
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5.1. Validación del funcionamiento de equipo

Esta fase se iniciará comprobando si el equipamiento recibido es el que se solicitó en la etapa
de compras y su correcto funcionamiento.

5.2. Entrega de la con�guración

Se deberá entregar la con�guración de cada elemento del sistema de telecomunicaciones, co-
mo los enrutadores, los ATA, los servidores...

Se deberá con�gurar lo que se re�ere al diseño de enrutamiento y los servicios. Generalmente,
el direccionamiento IP, el enrutamiento, la calidad del servicio, la seguridad, la conexión a In-
ternet y a la PSTN.

En el Apéndice E se de�ne el sistema operativo empleado por GTR, VoyageGTR, y el software
empleado para la red de VoIP, Asterisk.

- Ejemplo del plan de direccionamiento IP:

Esquema de la red con las direcciones IP y su topología.

Direcciones IP de las interfaces de la placa ALIX: ath0, ath1, eth0, eth1.

Direcciones IP de las interfaces de la placa MIKROTIK: wlan1, wlan2, wlan3, ethet1,
ether2.

Direcciones IP de las interfaces del enrutador Linksys en los puntos cliente: br0, eth1,
vlan1, ATA, PC.

Equipos inalámbricos que participan en cada uno de los enlaces de la red troncal: Nombre
del enlace / Repetidor / Enrutador / Interfaz y Modo (AP/ST) / Tarjeta Inalámbrica /
Modo inalámbrico. En cada enlace tiene que aparecer el repetidor AP y el repetidor ST.

Equipos inalámbricos que participan en cada uno de los enlaces de la red de distribución:
Nombre del enlace / Estación / Enrutador / Interfaz y Modo(AP/ST) / Tarjeta Inalám-
brica / Modo inalámbrico. En cada enlace tiene que aparecer el repetidor AP y la estación
cliente ST.

Servidores Asterisk con su respectiva lista de clientes telefónicos: Servidor Asterisk / Ubi-
cación / IP / Instalado en / Función / Enrutador / Número de Clientes / Nombre de
Clientes.

Listado de los números de anexos de todos los terminales telefónicos: Número anexo /
Ubicación / IP / Puerta de enlace / Servidor Asterisk / Modelo.

- Registro de los clientes en su respectivo servidor Asterisk - Telefonía.
Sabiendo el número total de servidores Asterisk en la red troncal, se podrá determinar el
número de anexos a los que estos servidores controlan el trá�co telefónico. Una posibilidad
será que las llamadas entre anexos no representen gasto alguno para los establecimientos
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bene�ciados pues serían totalmente gratuitas y se encontraran disponibles las 24 horas
del día, mientras que las llamadas realizadas fuera de la red sí se facturarían mediante el
sistema prepago de la empresa contratada.

Después de la instalación de la línea telefónica para dar salida a los establecimientos hacia
la red pública de telefonía (PSTN), se debe hacer el registro de los anexos en su respecti-
vo servidor Asterisk. Un ejemplo del comando que se debería emplear para comprobar el
estado de cada servidor Asterisk:

nombren2*CLI> sip show peers
Name/username Host Dyn Nat ACL Port Status

y/y 10.14.x.3 D 5060 OK (z ms)
n sip peers [n online, 0 o�ine]

x: depende de la dirección IP eth1 del Linksys
y: número de anexo del establecimiento al que sirven
z: tiempo requerido
n: número de pares SIP encontrados

5.3. Simulación

Se deberán simular todos los equipos del sistema de telecomunicaciones.

La duración aproximada de la fase de simulación es de un mes, en función del alcance del
proyecto.

Como documentación se deberá entregar la prueba de simulación.

5.4. Ajustes del diseño

Si no se obtienen los resultados esperados se hace un ajuste del diseño para cumplir con un
servicio.

5.5. Adaptación a la ingeniería de detalle

Esta actividad consiste en la adaptación de los alojamientos metálicos, la comprobación de
que todo esté bien �jado y protegido contra la lluvia, etc.

Lo ideal es que se realice en el laboratorio ya que el en campo se trabaja de forma más
extrema.

En este punto la red estará completamente diseñada.
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6
INSTALACIÓN DE LA RED

Figura 6.1: Grá�co Fase Instalación
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6.1. Envío del equipamiento

Consiste en la preparación del equipo para ser enviado, el propio transporte y la plani�cación
en sitio. El envío requerirá de un estudio de mercado para seleccionar el medio y el operador de
transporte.

El envío consiste en que los productos lleguen a cada lugar especí�co. Resultará importante
implementar una logística adecuada para que llegue cada equipo a su lugar, en el momento
oportuno y de�nir la persona que lo recibe.

La instalación de cada etapa (obra civil, infraestructura, equipamiento) no comenzará hasta
que no se disponga de todos los materiales para esa fase. Habrá que minimizar los tiempos en
campo ya que son muy costosos y desgastan mucho a los instaladores. Si permanecen más de
20 días en campo, la probabilidad de que cometan errores en su trabajo será alta y si comenten
errores, encontrar esos errores será muy difícil. Se deberá tratar de hacer el mayor trabajo de
con�guración en o�cina, para que el esfuerzo en campo sea menor.

6.1.1. Selección del medio de transporte

Los criterios de selección del medio de transporte dependerán de la zona. En escenarios de
selva, como el envío resulta costoso, primero se enviarán por tierra y después se enviarán por
lancha, donde sea imposible el desplazamiento por carretera. Podrá demorar de tres a quince
días el transporte. En el caso de la sierra será casi todo por tierra, demorará desde unos tres
días hasta una semana.

Los equipos delicados se deberán enviar por avión hasta donde éstos tengan acceso.

Lo primero que se enviará será el material de obra civil, las torres y otros equipos robustos.

6.1.2. Selección del operador de transporte

Se enviará mediante empresas de transporte especializadas. Éstas deberán ofrecer la seguri-
dad y la garantía de que el producto llegará en buenas condiciones a la zona.

6.2. Instalación

Se deberá realizar el menor trabajo posible en el campo. Para la obra civil se podrá uti-
lizar obras prefabricadas. En la instalación de torres participará el personal más especializado,
será conveniente que haya exceso de capacidad desde el punto de vista técnico para resolver los
problemas contingentes que se den a cada momento. Por último, en la instalación de equipos, se
requerirán varios grupos ejecutando trabajo simultáneo en varios puntos.

El instalador deberá disponer de la máxima información posible y de forma clara.

El tiempo necesario resulta difícil de de�nir. Se plani�cará este periodo por encima del tiempo
medio y por debajo del tiempo máximo teórico.
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6.2.1. Obra civil

Ésta se trata de la construcción de las casetas y de las bases para las torres.

Se podrán realizar los trabajos de forma secuencial, se construirán las bases de estación en
estación y se regresará nuevamente al primer punto para el armado de torres.

En la primera pasada se trabajará el cavado de las bases para las torres, también se traba-
jará la base para el panel solar en el puesto y se colocarán parte de las cajas. Todo el trabajo
mecánico se ejecutará en la primera pasada.

Luego se retornará al primer punto y se empezarán a levantar las torres, una vez levantada
la torre, se instalarán los equipos. La siguiente tarea será el periodo de calibración, en el que se
realizarán pruebas.

En la última pasada se hará la calibración �nal con dos o tres ingenieros, se dejará un periodo
de pruebas donde saltarán pequeños detalles, hasta que todo quede operativo.

Los encargados de la obra civil se de�nirán en función del presupuesto. En función de los
convenios, a veces se podrá solicitar colaboración al municipio y otras veces se contratará per-
sonal.

Esta tarea puede comenzar antes. En cuanto se tenga el diseño, en especial la altura �nal de
las torres, se podrá empezar la construcción de bases.

El tiempo que durará la obra civil variará en función del personal, aproximadamente se
emplearán unos diez días entre acabado, vaciado y montaje con ocho o diez personas. Si las
torres fueran muy altas, como tienen que secar bien las bases, se dejará unos días de secado,
avanzando al siguiente punto para hacer las bases. Si se tratara de una torre muy pequeña, se
podrá vaciar un día y al día siguiente se podrá montar ya que no es mucho peso.

6.2.2. Instalación de la infraestructura

En la primera pasada se instalarán los pozos a tierra. En la segunda se llevará a cabo el
armado y la preinstalación de equipos, como paneles y enrutadores, se tratará de realizar un
enlace aunque no sea muy �no, que se mejorará en la última pasada.

Normalmente un grupo levantará la torre y el otro se encargará de la instalación de equipos
dentro del cliente �nal.

Los tiempos dependerán del tamaño de la torre, las torres de 90 metros pueden montarse en
cinco días, pero depende mucho del clima. Una torre de 60 metros se puede armar en dos días
con la base ya hecha y con un equipo de doce personas.

El personal necesario será un torrero que dirija y el resto peones, que deberán tener expe-
riencia en montaje.
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6.2.3. Instalación de equipamiento

Las cajas que se instalarán en las torres se habrán acondicionado en el laboratorio.

Los equipos viajarán por separado ya que se tratará de equipos delicados. Cuando se reciban
todos los materiales, se ensamblanrán en la parte de abajo. Si fuera posible, se realizarán prue-
bas también abajo. Se probará, por ejemplo, que no haya problemas de conectividad entre los
equipos. Una vez probado todo, se subirán los equipos a la torre. Primero la caja de enruta-
dores, luego la caja de baterías y luego los paneles solares con su soporte. Los paneles podrán
instalarse empotrados en los techos o en las torres. Por último, se instalarán las antenas y los
cables coaxiales y al �nal se harán todas las conexiones de energía, de paneles y de baterías.

Los escenarios de selva y sierra se diferenciarán en que en los repetidores de la selva habrá
más seguridad, ya que las instalaciones estarán cerca del poblado y los equipos estarán en la
parte más alta. En el caso de la sierra, se instalará en zonas muy aisladas y poco accesibles, por
lo que todos los equipos se meterán dentro de la caseta y los paneles estarán empotrados en los
techos.

Se deberá contar con los planos de las bases, la lista de materiales y equipos que se van a
instalar y todos los planos de instalación. También se deberá disponer de diagramas básicos.

Los documentos que se deberán recuperar �rmados serán las actas de instalación de los
equipos, donde se deberá re�ejar todo lo que se está dejando instalado.
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PRUEBAS DE CAMPO

Figura 7.1: Grá�co Fase Pruebas de campo
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7.1. Ejecución del protocolo de pruebas

El protocolo de pruebas se realizará en la fase de simulación. Durante la con�guración de
los equipos se determinarán las pruebas que se ejecutarán, primero en el laboratorio y luego las
de campo. Se creará un documento con la con�guración y las pruebas necesarias. Gracias a los
cruadros y diagramas creados con las simulaciones y el direccionamiento IP, se llevará a cabo el
protocolo de pruebas en campo.

Estas pruebas de campo se re�erirán a las realizadas sobre los equipos de telecomunicaciones,
así como las pruebas de conectividad, energía, niveles de voltaje, etc.

Se deberá monitorizar el nivel de señal, el ancho de banda y el rendimiento, así como todos
los servicios.

En función del tiempo del que se disponga, se realizarán las pruebas paso a paso o todas al
�nal. La parte de computo se probará cuando se disponga de todos los equipos instalados. En el
caso del enlace entre el punto cliente y la torre, se harán las pruebas desde el mismo computador
del cliente. Entre torres se dispondrá de una computadora abajo de la torre monitorizando y
otra persona en la torre buscando el mejor nivel de señal y en otra torre estarán leyendo los
niveles de señal y luego se invertirán los papeles, hasta que se obtenga el nivel de señal óptimo.
Resultaría ideal que trabajaran mínimo un ingeniero y un torrero, por un tema de comodidad y
seguridad.

Antes de que �nalización de la instalación se avanzarán pruebas locales, como hacer ping al
repetidor local, y al �nal se realizará una prueba general de todo el comportamiento de la red.
En la selva resultará complicado porque el desplazamiento es por río y es caro y difícil encontrar
movilidades. Esto se resolverá haciendo dos grupos para a�nar el enlace y cuando se regrese se
intentará corregir algún fallo que se pueda haber detectado. En el caso de la sierra, al ser más
accesible y se podrán realizar más pruebas, resultará menos costoso, incluso será posible trabajar
con más grupos para hacer más rápido la fase de las pruebas.

Una vez �nalizada la instalación se deberá monitorear la red durante aproximadamente un
mes, en este periodo se irán detectando incidencias ya que se observarán los periodos de cortes
intermitentes. Sería recomendable que una vez instalada la red se instalara un servidor que mo-
nitoreara las 24 horas.

El momento en el que la probabilidad de fallo es mayor, resultará ser el inmediatamente pos-
terior a la instalación. Después de un tiempo, el comportamiento de los equipos se estabilizará.
En este periodo de pruebas de campo, a parte de las pruebas, se someterá el equipamiento a estrés
para determinar los posibles motivos de fallo y poder solucionarlos. También será probable que
aparezcan otros problemas en un periodo de tiempo mayor debido al deterioro y a lo agresivo del
ambiente, por ello también se realizarán pruebas de campo cuando el sistema esté en producción.

En las pruebas de campo también deberían participar los usuarios para conseguir que se
involucren, ya que es una forma de capacitarlos y formarlos.

Entre las pruebas que se realizarán se encuentran las siguientes:

1. Veri�car los parámetros TCP/IP de cada interfaz de red.

2. Con�gurar las interfaces inalámbricas.
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3. Con�guración de la tarjeta inalámbrica.

4. Observar las potencias con�gurables en las tarjetas inalámbricas.

5. Veri�cación de las intefaces si están o no activas.

6. Habilitar servicios como ftp, ssh, telnet.

7. Veri�car las seguridad wireless, su tipo y las claves.

8. Hacer un respaldo (backup) de la con�guración.

9. Ping normal entre las interfaces del enlace.

10. Veri�cación de la tabla de rutas y la ruta de salida.

11. Ping a todas las interfaces de red.

12. Conectividad en una red troncal.

7.1.1. Pruebas de nivel de señal de los radioenlaces

Se comprobará el rango (dBm) de los niveles de señal en los enlaces de la red troncal. Estos
valores deberán garantizar un buen funcionamiento en la transmisión de la información.

1. Escanear las redes inalambricas desde un STA.

2. Observar los parametros Wi-Fi como como nivel de recepcion, ruido, y la calidad del enlace
desde un STA.

3. Ver la recepción de la señal desde un AP.

4. Cantidad de clientes conectados al AP.

7.1.2. Pruebas de ancho de banda

Se determinará, según el ancho de banda (Mbits/sec) de las transmisiones, si son positivos
los resultados de las pruebas en los enlaces troncales y si se garantiza buena transmisión de voz
y datos en los enlaces de distribución.

En los Apéndices C y D se pueden encontrar los comandos para la realización de las pruebas
de campo en placas ALIX y MIKROTIK, que son las que se han empleado en GTR.

7.2. Ajustes en instalaciones o con�guraciones

Las pruebas en laboratorio suelen ser ideales y será posible que haya que realizar ajustes en
las instalaciones o en las con�guraciones de algún elemento de la red.

Los ajustes más comunes se referirán a cambios de la antena o el pigtail, ajustes de la po-
laridad de la antena, ajustes de las borneras, ajustes de los pernos de �jación de las antenas,
solucionar �ltraciones de agua en los cables coaxiales y en los empalmes, solucionar problemas
de aislamiento de antenas...

No deberían existir ajustes en la con�guración, si los hubiera deberían ser mínimos en
cualquier servicio. Los ajustes de distancias y de potencias se desarrollarán en la etapa de
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calibración. Al �nal se podrá aumentar la potencia, por ejemplo si el enlace trabajara bien a 16
dB, pero con lluvia se perdiera la señal, se preferirá subir la potencia a 20 dB.

La documentación producida en esta fase serán los resultados de las pruebas de funcionamien-
to de la red. Si se realizaran modi�caciones se deberán registrar y cambiar el documento que
se generó en el laboratorio. También se crearán documentos de monitoreo. Al término se esta
etapa se �rmarán las actas de funcionamiento.

44 CAPÍTULO 7. PRUEBAS DE CAMPO



8
CAPACITACIÓN

Figura 8.1: Grá�co Fase Capacitación
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8.1. Introducción de la fase de capacitación

La fase de formación o capacitación deberá ser un proceso continuo, los usuarios deberán con-
tinuar ese proceso con determinadas metodologías que se les proponga. Dentro de los planes, se
establecerán cursos especí�cos de capacitación, presenciales o virtuales. Las actividades de�nidas
dentro de los planes deberán ser implementadas por los bene�ciarios durante la ejecución del
proyecto y mantenidas después de la entrega.

Se valorarán dos mecanismos para la capacitación para el mantenimiento, una opción con-
sistirá dar la mínima información para que los encargados de mantenimiento sean capaces de
resolver los problemas puntuales y otra opción será dar la máxima información. La decisión del
tipo de capacitación se deberá tomar en función del per�l del personal de mantenimiento y de
la infraestructura y soporte.

Si se elige dar la mánima información, se logrará el aprendizaje de ciertas competencias para
detectar y solucionar ciertas di�cultades, el problema se dará cuando se presenten cuestiones
más especí�cas. También se correrá el riesgo de que los temas obvios no se solucionen de una
forma fácil sino de una manera compleja. Si se ofrece poca información, las personas encargadas
construirán la información que les falta y existirá la posibilidad de que ese proceso constructivo
no tenga una base de ingeniería, que sea ensayo-error.

La mejor opción, según la experiencia de GTR, será dar mucha información, ya que nos
estamos re�riendo a zonas aisladas, con poco acceso a la información. Este mecanismo, desde el
punto de vista pedagógico, podrá parecer incorrecto.

Un gran problema cuando se trabaja en zonas rurales, es pensar que la capacidad es poca
en temas técnicos. En muchos casos existen problemas de lectura-escritura y problemas con el
lenguaje, pero se deberá tener claro que son personas inteligentes. Por lo que se deberán dar las
herramientas para que puedan construir un conocimiento correcto.

Lo primero que se deberá enseñar es la ley de Ohm, para que sean capaces de poner dos
focos en paralelo, por ejemplo.

Otro gran reto consistirá en lograr una mecánica para detección de fallos, lo que suele ser
algo muy difícil. Se deberá tratar de enseñar a ser metódicos, que puedan evaluar todas las
partes de una manera sistemática. Un técnico de mantenimiento debrá adquirir la capacidad de
detectar fallos y su motivo intrínseco, deberá ser capaz de encontrar la raíz del problema.

Para la elección de los encargados de mantenimiento se buscará personal que ya posea capaci-
dad de análisis de los problemas, aunque no necesariamente tenga conocimientos de la tecnología.
En este caso, el GTR se encarga de formar para la adquisición de las capacidades técnicas.

En la medida de lo posible, resultará positivo lograr capacidades locales. En las instalaciones
por ejemplo, se podrá capacitar a empresas locales y reutilizar esa capacidad en el mantenimien-
to, promoviendo el desarrollo local.

Se generará gran cantidad de documentación en esta fase. Existirá un plan de formación
continua y planes de capacitación especí�cos, básicamente mediante cursos presenciales. Se
generarán documentos con los contenidos de estos cursos, manuales de o�mática, manuales de
operación, manuales de mantenimiento, manuales especí�cos para instaladores, etc. Para cada
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curso se generarán encuestas, tests, evaluaciones, �chas de inscripción, guías docentes, etc.

8.2. Capacitación de los instaladores

En los proyectos en los que exista la necesidad de capacitar instaladores, la fomación se de-
berá llevar a cabo antes de las instalaciones. El número de personal a capacitar será la diferencia
entre los recursos humanos necesarios, en función de la magnitud del proyecto, y los recursos
humanos ya destinados a la etapa de instalación.

Será positivo elegir personal local de la propia institución bene�ciaria que estén presentes
durante la instalación, con el �n de que en el momento de la capacitación para el mantenimiento,
posean conocimientos y se formen mejor y más rápido.

El proceso de capacitación de los instaladores será muy especí�co, deberá estar muy acotada
la actividad a desarrollar.

8.3. Capacitación de los usuarios

Lo ideal es que esta capacitación se desarrolle inmediatamente antes e inmediatamente des-
pués de las instalaciones y, en función de los fondos, uno o más refuerzos. En los proyectos
donde no es posible realizar toda esta cadena, se optará por hacer capacitaciones concentradas
inmediatamente después de las instalaciones, para que puedan usar los equipos ya instalados,
pero que estos equipos no funcionen con usuarios no capacitados. Será conveniente hacer un
refuerzo posterior, ya que podrán saltar dudas, al cabo de pocos meses, que se podrán resolver
para mejorar su aprendizaje. Será positivo implementar herramientas virtuales de aprendizaje
(información, contenidos, cursos...) para continuar ofreciendo asesoría a distancia.

La elección del personal que será capacitado dependerá en gran medida de los bene�ciarios.
Se solicitarán listas de personas a formar, indicando los requerimientos mínimos de dedicación
que deben cumplir. Las personas que serán capacitadas se deberán encontrar entre las que vayan
a usar los sistemas instalados.

Se considera que son indispensables los cursos concentrados. Las capacitaciones en sitio no
son tan efectivas ya que, al estar la persona en su lugar de trabajo, tiene muchas distracciones
por sus obligaciones y no es fácil obtener de él tiempo ni atención permanente. Estos cursos con-
centrados se realizarán por grupos, ya que podrán interactuar entre los futuros usuarios, dándose
soporte mutuamente. Los grupos tendrán que ser homogéneos de acuerdo al conocimiento que
ya posean. Cuando el grupo a capacitar sea muy pequeño, a veces se deberá manejar un curso
más �exible, con varios tutores a diferente ritmo.

La formación de los usuarios tendrá como objetivo principal el uso de los recursos y herra-
mientas tecnológicas que se instalan, para que los usuarios sean más e�cientes en las actividades
que normalmente desempeñan. También se podrá buscar �nes de crecimiento personal y profe-
sional con el uso de las nuevas herramientas instaladas.

A los usuarios de los sistemas se les brindará una pequeña formación en temas técnicos para
que sean capaces de reportar fallas correctamente y de realizar un mantenimiento preventivo
mínimo. De acuerdo a la política de mantenimiento, se ofrecerán guías con información de
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actuaciones ante problemas y de actuaciones para realizar un mantenimiento preventivo básico
de los sistemas.

8.4. Capacitación de los encargados del mantenimiento

Las capacitaciones de los encargados de mantenimiento se realizarán también en un periodo
posterior a la instalación, primero porque ya estará disponible el personal técnico que desarrolla-
rá las capacitaciones y segundo porque se podrán hacer pruebas sobre la red instalada. El per�l
de los encargados de mantenimiento será diferente que el de los usuarios. Antes de las instala-
ciones se identi�cará quiénes potencialmente podrán asumir esa responsabilidad. En función de
la complejidad de las tareas que vayan a desempeñar, la capacitación será más o menos profunda.

La elección del personal a capacitar se realizará en coordinación con las entidades bene�cia-
rias, en función del per�l deseado y de la voluntad de colaboración.

La capacitación de los encargados de mantenimiento, igual que la capacitación de usuarios,
se desarrollará por grupos diferenciados, por zonas y por niveles. Se ejecutarán cursos presen-
ciales, procurando que los cursos sean eminentemente prácticos. Lo ideal es que los cursos sean
tutorizados por los técnicos que hayan instalado o diseñado las redes.

En función de cómo se haya concebido la intervención, en algunos casos los bene�ciarios
asumirán todo el mantenimiento, en otros casos se delegará a terceros y en otros casos se
planteará algún tipo de convenio con otra institución que pueda asumirlo. Se formará a los
encargados de mantenimiento para que obtengan el conocimiento su�ciente para supervisar las
actividades de mantenimiento, gestionarlas a nivel administrativo y solucionar problemas sen-
cillos. Las actuaciones más especializadas deberán ser ejecutadas por personal profesional.
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Figura 9.1: Grá�co Fase Acompañamiento
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9.1. Monitoreo de red y mantenimiento temporal

Antes de la entrega, se llevará a cabo un mantenimiento preventivo mediante monitoreo de
la red y un mantenimiento correctivo de las fallas que se puedan encontrar.

Si es posible, se monitoreanrán las redes de forma remota durante el periodo de acom-
pañamiento, este periodo no siempre se ajusta al proyecto. Existirán casos en los que sean
necesarios proyectos sucesivos hasta realizar la transferencia tecnológica y de conocimientos.

Se deberá brindar mantenimiento correctivo hasta que se realice la entrega. Aunque gene-
ralmente no se �nancia dentro de los proyectos, se podrá enmarcar, por ejemplo, dentro de los
trabajos pendientes. En las actuaciones de mantenimiento preventivo participarán las personas
que estén capacitadas en mantenimiento para aumentar su experiencia.

Como documentación generada existirán reportes de atención de fallas.

9.2. Aseguramiento de la sostenibilidad de la red

Se tendrán que valorar dos aspectos para asegurar la sostenibilidad, el aspecto operativo
técnico y el aspecto administrativo.

En el aspecto administativo, algunas organizaciones ya poseen procedimientos internos y se
deberán respetar, pero otras no tienen establecidas unas normas por lo que se tendrán que de�nir
políticas con más detalle. Lo que se deberá de�nir o proponer es la forma exacta de gestionar
los nuevos equipos y servicios. También se de�nirán las responsabilidades de cada tarea. Toda
actividad o función de mantenimiento debe tener responsables, con el �n de asegurar que se
cumpla y se supervise.

Desde el punto de vista técnico, se deberá entregar toda la información en los manuales
técnicos. Además, en los planes operativos de mantenimiento deberán aparecer procedimientos
técnicos para garantizar monitoreo, prevención de fallas, registros, estadísticas, etc.

Se crearán políticas de sostenibilidad de la red que formarán parte de los documentos de esta
fase.

9.3. Búsqueda de nuevos proyectos

Se buscarán nuevos proyectos para asegurar la sostenibilidad en forma integral. Se distin-
guirán varios ámbitos cuando se habla de sostenibilidad. Uno de ellos es el ámbito económico.
Otro es el ámbito tecnológico, relacionado con el grado de transferencia de conocimientos que
se ha logrado o es posible lograr. Otro es el ámbito social-organizativo, referido al nivel de or-
ganización de la institución. También existe un ámbito político, en relación a las políticas de la
institución que marcarán el cumplimiento del mantenimiento.

Los proyectos organizarán el ámbito económico, el tecnológico y el social-organizativo. El
ámbito político es muy complicado y no será el �n principal de los proyectos.
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Figura 10.1: Grá�co Fase Mantenimiento
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10.1. De�nición de políticas y procedimientos de mantenimiento

Para garantizar la sostenibilidad del equipamiento instalado se debe considerar una adecuada
operación, mantenimiento preventivo y mantenimiento correctivo.

En la parte de operación, se habrá capacitado al usuario para mantener los sistemas, estable-
ciéndose políticas fáciles de seguir. Para ello, se procurará que el mantenimiento quede insertado
en la estructura de la organización bene�ciaria, mediante directivas desde la propia institución,
que sienta las instalaciones como parte de su infraestructura y que las obligaciones que acarrea
la red sean parte de sus funciones.

Se deberán entregar las normas básicas de uso en un conjunto de documentos de lo que
concierne a la operación, al mantenimiento preventivo y al correctivo. Se trabajará mediante
propuestas, interactuando con los bene�ciarios, para aprobar políticas que deberán agregarse al
resto de normas que tiene la organización.

Si se implementaran las políticas de mantenimiento antes de las instalaciones, los bene�cia-
rios no podrían comprobar el valor real de lo que se está instalando y el bene�cio de los servicios
de los que van a disponer. Después o durante el proceso de instalación será más fácil tener un
compromiso, ya que se darán cuenta de la importancia de los servicios que están obteniendo.

En los manuales de mantenimiento se entregarán procecimientos de atención de incidencias,
también se incluirán casos típicos de fallas y su solución. Se establecerán algunos formatos de
mantenimiento correctivo para que se registre la información de forma adecuada.

10.2. Mantenimiento necesario mediante coordinación con los be-
ne�ciarios

El objetivo del mantenimiento preventivo será tratar de mantener los equipos en buen esta-
do, previniendo las fallas. La periodicidad de las actividades especí�cas depende de la tecnología
que se haya instalado, del lugar donde se instale y de la organización bene�ciaria. Debe haber
visitas periódicas a cada lugar donde está instalado un sistema para el mantenimiento preventivo.

Una estimación de la periodicidad de las visitas podría ser de al menos dos veces al año. El
mantenimiento preventivo que harán los propios usuarios, como limpiar sus ordenadores o telé-
fonos, se englobará en las normas de operación. Se desarrollará un conjunto de políticas dirigidas
a los usuarios y otro conjunto de normas dirigidas a los técnicos de mantenimiento. También
se deberán entregar mecanismos que indiquen cómo se va a almacenar y gestionar la información.

Esas visitas las realizará personal capacitado propio o tercero, cumpliendo de forma ordenada
una serie determinada de tareas. Estas actividades concretas se cuanti�carán en horas/hombre,
para de�nir el costo asociado y la programación temporal.

El coste que tendrá el mantenimiento dependerá de la realidad de la zona, de la tecnología
instalada y de los servicios implementados. Será conveniente presentar presupuestos estimados,
valorando el peor caso.
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Figura 11.1: Grá�co Fase Entrega
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11.1. Recopilación de información

La información que se deberá recopilar en la entrega depende del tipo de institución a la que
se está bene�ciando con el proyecto. Existen instituciones con las que se deberá ser más riguroso,
por lo que se desarrollarán inventarios detallados del equipamiendo instalado, de su ubicación,
del costo, incluyendo comprobantes de compra, etc. para que acepten cada equipo como propio.
También se ofrecerá información sobre la red, la tecnología y los servicios implementados. Se
deberá garantizar la sostenibilidad para que se pueda aceptar la donación.

11.2. Transferencia de bienes y responsabilidades

La transferencia de bienes es un proceso en el que se presenta la solicitud de donación,
con toda la información requerida, a las instituciones bene�ciarias para que la estudien y la
acepten. Es posible que soliciten modi�caciones y requieran de diversas consultas. Al �nal de
este proceso, se emitirán resoluciones de aceptación de la donación para que pase a formar
parte de los inventarios de la institución. La transferencia de bienes puede no coincidir con
la transferencia tecnológica total y con la implementación de las políticas de mantenimiento,
pueden estar desfasadas.

11.3. Gestión del cambio en la institución bene�ciaria

La gestión del cambio puede realizarse en varios frentes. Un frente referido a la gestión del
cambio personal mediante la capacitación, la modi�cación de actitudes, el añadir conocimientos,
actividades, funciones y responsabilidades. También se debe facilitar el cambio en la forma de
hacer las cosas, ofrecer el conocimiento del uso de las herramientas para mejorar los procesos,
las funciones y las actividades que desarrollan. A nivel de institución también existirá gestión
del cambio, mediante las correcciones necesarias para asegurar la sostenibilidad de las redes.
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Conclusiones

De�nir de forma general las fases de las que se conforma un proyecto es posible. Si se quiere
particularizar cada una de estas etapas para un proyecto determinado se deberán tener en cuenta
múltiples factores:

- El alcance del proyecto, en función de la extensión la red, el número de nodos y los servicios
ofrecidos.

- La realidad de la zona, dependerá del clima, la estación en la que se desarrolle el proyecto,
la orografía, etc.

- La normativa vigente en el país, por ejemplo, se podrán diferenciar las bandas libres del
espectro de frecuencias entre países.

- El momento social y político del país.

- Las restricciones económicas, que en estos proyectos en países en desarrollo puede ser el
mayor limitante.
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Glosario de acrónimos

- AC: Alternating Current

- AMD: Advanced Micro Devices

- AP: Access Point

- ApD: Asociación para el Desarrollo

- API: Application Program Interface

- ATA: Analog Telephone Adapter

- CF: Compact Flash

- CLI: Command Line Interface

- CPU: Central Processing Unit

- DC: Direct Current

- DHCP: Dynamic Host Con�guration Protocol

- DNS: Domain Name Server

- E: East

- FPU: Floating Point Unit

- FTP: File Transfer Protocol

- FXO: Foreign eXchange O�ce

- FXS: Foreign eXchange Subscriber

- GPS: Global Positioning System

- GTR: Grupo de Telecomunicaciones Rurales

- HW: HardWare

- IP: Internet Protocol

- ISF: Ingeniería Sin Fronteras

- IVR: Interactive Voice Response

- LAN: Local Area Network

- MAC: Media Access Control

- MTU: Maximum Transfer Unit

- N: North

- NASA: National Aeronautics and Space Administration
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- NAT: Network Adress Translation

- ONG-ApD: Organización No Gubernamental - Asociación para el Desarrollo

- OSPF: Open Shortest Path First

- PBX: Private Branch eXchange

- PCB: Printed Circuit Board

- PCMCIA: Personal Computer Memory Card International Association

- PC: Personal Computer

- PCI: Peripheral Component Interconnect

- PIRE: Potencia Isótropa Radiada Equivalente

- PoE: Power over Ethernet

- PSTN: Public Switched Telephone Network

- ptp: point-to-point

- ptmp: point-to-multipoint

- PUCP: Ponti�cia Universidad Católica del Perú

- QoS: Quality of Service

- RAM: Random Access Memory

- RDSI: Red Digital de Servicios Integrados

- RTC: Red Telefónica Conmutada

- S: South

- SBC: Single Board Computer

- SD: Secure Digital

- SIP: Session Initiation Protocol

- SRTM: Shuttle Terrain Radar Maping Mision

- SSH: Secure Shell

- STA: STAtion

- S.O.: Sistema Operativo

- SW: SoftWare

- TCP: Transmission Control Protocol

- TELNET: TELecommunication NETwork

- TIC: Tecnologías de la Información y las Comunicaciones

- TTL: Time To Live

- UDP: User Datagram Protocol

- UPS: Uninterruptible Power Supply
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- USB: Universal Serial Bus

- VoIP: Voice over Internet Protocol

- W: West

- WEP: Wired Equivalent Privacy

- WPA-PSK: Wireless Protected Access-PreShared key
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A
Manual de Radio Mobile

Radio Mobile permite la simulación de enlaces de radio y representar el área de cobertura.
Es de distribución libre. Utiliza el modelo Longle-Rice para cálculos de propagación.

Los mapas de elevación del terreno se descargan gratuitamente de Internet para crear vistas
estereoscópicas, en 3-D, animaciones, fusionado de imágenes, etc.

En nuestro caso, obtenemos los datos de elevación de un proyecto de la NASA Shuttle Terrain
Radar Mapping Misión (SRTM).

El presente documento está dividido en los diferentes pasos importantes para el dineño de
radio enlaces. Cada sección se ha subdividido en una parte teórica y en una parte práctica,
incluyendo un ejemplo.

Se han seguido los criterios empleados por GTR-PUCP para tecnología Wi-Fi, descritos la
parte práctica.

A.1. Instalación

En el sitio web http://www.cplus.org/rmw/english1.htm se accede a la opción Download...
y se siguen los siguientes pasos:

1. Descargar e instalar Visual Basic Runtime (Service pack 6) File_vbrun60sp6.exe de Mi-
crosoft. Es posible que se requiera reiniciar el PC.

2. Crear un directorio de programa para colocar los contenidos de los siguientes �cheros.

3. Descargar, descomprimir e instalar de rmwcore.zip y rmwupdate.zip.

4. Descargar y descomprimir rmw1015spa.zip para el idioma español.

5. Crear una estructura de directorios de datos.

6. Para habilitar la descarga de mapas de Internet se debe editar el �chero Map_Link.txt
con Notepad y borrar los apóstrofes de las primeras líneas.
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7. Para obtener un mapamundi con de�nición SRTM, extraer File_wmap.zip en el directorio
del programa.

8. Asegurarse de que no existan otras instancias de Rmwdllx32.dll en su sistema. Si quiere
emplazar el programa en más de una ubicación, debe poner Rmwdllx32.dll (y otras dlls)
en C:\Windows\system32.

A.2. Inicio

Unidades (Units): emplazamientos con posición geográ�ca de la red entre los que se estable-
cen enlaces.

Enlaces (Networks): Grupo de unidades y enlaces entre ellas.

Sistema (System): Conjunto de características de los equipos a emplear.

Práctica:

File > New networks.

1. Aparece la ventana New Net initialization. Debemos introducir el número aproximado
de enlaces, unidades y sistemas que vamos a necesitar. Podemos utilizar la cantidad por
defecto (25 enlaces, 50 unidades y 25 sistemas) pulsando Default.

2. Nos da una estimación de la memoria requerida.

3. Con el botón Use map se cargarán las coordenadas del anterior mapa con el que se ha
trabajado.

4. Seleccionar OK.
Ver �gura A.1.

Figura A.1: File > New networks.

File > Open network.

1. Aparece la ventana Open Networks donde seleccionaremos en �chero *.net con el que
queremos trabajar.

2. Aceptamos.
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A.3. Mapas

Para acceder a la ventana de con�guración de mapas es necesario seleccionar la opción Map
Properties del menú File.

La primera sección (Centre) determina el centro del mapa que vamos a cargar.

Se indican las coordenadas empleando la expresión de grados sexagesimales y empleando el
sistema QRA Locator, donde el primer par de letras son la longitud cada 20 grados y la latitud
coda 10 grados, respectivamente, el par de números dividen las cuadrículas anteriores en 100
cuadrículas (10x10), el último par de letras dividen las cuadrículas en 276 cuadrículas (24x24)
más pequeñas.

Para introducir las coordenadas del centro del mapa deseado se debe seleccionar uno de los
siguientes métodos:

- Introducir la latitud y la longitud mediante la expresión de grados decimales.

- Usar la posición del cursor mediante Use cursor position.

- Ubicar la zona con el mapamundi con el botón World Map.

- Si se conoce o si está incluida en la lista la ciudad bajo estudio, se puede utilizar Select a
City Name.

- Introducir manualmente las coordenadas mediante la expresión en grados sexagesimales,
incluyendo los botones para latitud norte o sur (N /S ) y este u oeste (E/W ), decimales y
empleando el sistema QRA Locator.

- La última opción es la de seleccionar como centro del mapa una unidad de las cargadas
que aparecen en la lista desplegable.

La siguiente sección se re�ere a algunas utilidades para mapas:

- Ajustar las elevaciones de las unidades al nuevo mapa mediante Adjust units elevations.

- Para superponer diferentes imágenes de mapas se debe seleccionar la opciónMerge pictures.

- Para forzar a que la imagen se represente en escala de grises se emplea Force gray scale.

Se selecciona el tamaño del mapa gracias a los dos módulos siguientes:

- El primero (Size (pixel)) se re�ere la resolución del ancho (Width) y alto (Height) del mapa
en número de píxeles.

- Se emplea Size (km) para introducir el alto (Height) en kilómetros, el ancho (Width) se
ajusta de forma automática en función de la proporción del tamaño en píxeles.

La última sección de la columna central es la de Elevation data source, se re�ere a las opciones
para elegir las fuentes de donde se descargan los mapas.

- Para seleccionar el modelo digital del terreno se emplea el primer menú desplegable. Dicho
menú tiene las opciones de SRTM, DTED, GTOPO30, GLOBE y BIL dependiendo del
espaciado entre muestras.
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- Driver or path se re�ere a dónde se encuentran los mapas a utilizar.

- Para buscar de donde cargar estos mapas, empezando por la capa superior (Top layer)
hasta la capa inferior (Bottom layer), se selecciona Browse.

- Como últimas opciones de este campo están las opciones de:

o Ignorar si hay archivos de datos que faltan (Ignore Missing �les), si no se selecciona
Radio Mobile avisa qué archivos faltan.

o Inicializar con una determinada altura en metros (Initialize matrix with elevation
(m)).

En la columna de la derecha aparecen las opciones de extraer los mapas seleccionados (Ex-
tract) y cancelar (Cancel). También aparecen indicadas automáticamente las coordenadas de las
cuatro esquinas del mapa cargado.

Otras opciones del menú File relacionadas con mapas son las de:

- Save map as... que guarda el mapa en el directorio elegido. Recibe la extensión �.map�.

- Para abrir mapas existen las opciones Open map, Previous map y Next map.

En el menú Edit existen herramientas para ajustar la imagen:

- Fit to a window ajusta el tamaño del mapa a las dimensiones de la ventana. Aparece una
ventana (Keep merged picture in pinture? ) se puede seleccionar si queremos guardar el
ajuste de la imagen o no y de qué forma:

o Guardar en la imagen actual: Seleccionar Keep in actual picture y OK.

o Guardar en otra imagen: Seleccionar Keep in a new picture y OK.

o Guardar de forma volátil: Seleccionar Keep volatile y OK.

o No guardar: Seleccionar Do not keep y OK.

- Seleccionando la zona que se quiere, gracias a Fit map to picture/selection el tamaño de
la imagen se ajusta dicha zona.

- Fit map to units ajusta la imagen a las unidades habilitadas.

Para la superposición de mapas existe la opción Merge pictures... del menú Edit.

En la columna izquierda se selecciona la fuente (Source), que puede ser por ejemplo:

- Another picture superpone otra imagen abierta en Radio Mobile a la imagen activa, es-
peci�cando el nombre en el menú desplegable Source Picture.

- Internet MapPoint da la posibilidad de seleccionar una zona del mapamundi.

- Internet Virtual Earth que permite descargar mapas de carreteras (Roads), mapas híbridos
(Hybrids) y fotos aéreas (Aerial photos). Y seleccionar el zoom.

- Seleccionando Internet MapQuest te permite cargar mapas topográ�cos.

- Gracias a Internet GoogleMap se pueden descargar imágenes de satélite.
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En la columna derecha aparecen los botones de aceptar (Draw) o cancelar (Cancel) y la
sección de Operation donde se selecciona el modo de operación mediante el cual se superponen
las imágenes y las opciones de contraste (Contrast) y brillo (Brightness):

- Para representar sin superponer el mapa descargado se debe seleccionar Copy.

- Empleando cualquiera de las otras tres opciones (Add, Multiply o Bitwise) sí se procesan
los datos de la nueva imagen con la imagen actual. La óptima es el modo en el cual quede
más nítida la imagen.

Práctica:

Options > Intenet.

1. Activar la opción para la descarga de los datos de Internet si no se encuentran en el
directorio local seleccionando Download from Internet if a �le is not found on local path
and set a local copy.

2. Seleccionar el directorio ftp (Internet ftp directory) según el área de interés, en nuestro
caso USGS South America - 3 arcseconds.

3. Seleccionar OK.
Ver �gura A.2.

Figura A.2: Options > Intenet.

Options > Elevation data.

1. Activar la opción Use elevation data in memory generated by Map Properties.

2. Seleccionar OK.
Ver �gura A.3.

File > Map properties.

1. Introducir las coordenadas del centro de la región de trabajo.

2. Determinar el la resolución y el tamaño del mapa.
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Figura A.3: Options > Elevation data.

3. Seleccionar la fuente de elevación STMR de la NASA que provee datos de altitud de 3
segundos de arco (100m) y buscar el directorio donde se almacenan los datos SRTM.

4. No seleccionar la opción Ignore Missing �les, con el �n de que el programa avise de los
datos incompletos.

5. Seleccionar Extract.
Ver �gura A.4.

Figura A.4: Options > Map properties.

A.4. Imágenes

Si seleccionamos Picture properties del menú File, podemos modi�car las características de la
imagen. Para crear una nueva imagen se elegiría File > New picture.

La primera columna se re�ere a las formas de coloreado:

- Gray scaled slope: Escala de grises.
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- Colored slope (absolute/relative): Coloreado, la opción relative colorea la imagen en refer-
encia a las alturas con respecto al suelo.

- X-ray y X-ray (inverted): Rayos X.

- Rainbow : Con la posibilidad de elegir los colores por altura.

En la columna siguiente aparecen las opciones de:

- Bottom elevation (m): Menor elevación de la imagen.

- Top elevation (m): Mayor elevación de la imagen.

- Contrast (%): Contraste.

- Brightness (%): Brillo.

- Light azimuth (◦): Ángulo acimutal de la luz.

Existen otras opciones como la de mostrar ciudades o dibujar los contornos cada un número
de metros determinado en la zona inferior de la sección Draw mode.

La columna de la derecha de la ventana tiene las opciones:

- Draw : Aceptar las opciones y dibujar la imagen.

- Cancel : No guardar las características que hemos introducido.

- 3D picture: Crear una imagen en tres dimensiones.

- Stereo: Crear una imagen más simple.

- Object drive/Path: Seleccionar un path.

En la zona inferior de la ventana aparece un texto en verde donde se puede observar:

- La información de mapa cargado (Elevation data source).

- La altura mínima (Minimum), la máxima (Maximum) y la altura media (Average) en
metros.

- Si los datos del mapa coinciden o no con la imagen cargada (Fits elevation data in memory
/ Does not �t elevation data in memory).

- La anchura y altura de la imagen en píxeles (Width/Height).

- La ruta de la imagen si ya existía (Path).

La opción Draw grid del menú Edit, para dibujar una cuadrícula:

- En la sección Style se puede elegir el estilo de la leyenda a mostrar.

- El espaciado se selecciona en Spacing.

- Mediante las otras opciones se puede elegir el color y si se muestran las etiquetas.

- Por último, hay que pulsar Draw si queremos aceptar y dibujar la rejilla o Cancel si no
queremos guardar las opciones ni dibujar.
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Para dibujar circunferencias concéntricas separadas una determinada distancia, seleccionamos
Draw rings del menú Edit :

- La primera sección es Centre, donde se puede seleccionar si queremos que el centro de las
circunferencias sea una unidad a elegir o donde tenemos posicionado el cursor.

- Gracias a los apartados Unit of measure y Step elegimos la distancia entre circunferencias
y su unidad.

- Mediante las otras opciones se puede elegir el color y si se muestran las etiquetas.

- Por último, hay que pulsar Draw si queremos aceptar y dibujar las circunferencias o Cancel
si no queremos guardar las opciones ni dibujar.

A.5. Unidades

Con la opción de Unit properties del menú File, se accede a la ventana de con�guración de las
unidades.

En la columna izquierda aparecen las unidades de la red. Habiendo seleccionado una unidad
se pasa a introducir sus características:

En el primer apartado de la columna central se determina:

- El nombre de la unidad (Name), de manera opcional se puede dar Add / Get units to /
from cities.dat una descripción detallada (en el botón con el símbolo +).

- En el apartado Elevation (m) se emplaza automáticamente la altura de la unidad una vez
introducidas las coordenadas.

En la sección de Position aparecen las coordenadas en forma hexadecimal y mediante el
sistema QRA. Estas coordenadas se pueden:

- Copiar (Copy) y pegar (Paste) a otra unidad.

- Bloquear mediante Locked para no perder los datos.

- Modi�car mediante:

o Enter LAN LON o QRA. Aparece una ventana donde se introducen las coordenadas
bajo la misma presentación que en la carga de mapas (coordenadas hexadecimales,
decimales y con el sistema QRA).

o Place unit at cursor position, seleccionando un punto en el mapa en el que deseamos
emplazar la unidad. Una utilidad del programa es la de posicionar el cursor en el
punto máximo de una zona seleccionada o de todo el mapa, gracias a View > Find
peak elevation.

- Otras opciones de este apartado son:

o Emplazar el cursor en las coordenadas de la unidad (Place cursor at unit position).

o Añadir / obtener unidades (nombre y coordenadas) al / desde el la base de datos
del programa cities.dat (Add / Get units to / from cities.dat), donde se encuentran
las coordenadas de ciudades principales. El inconveniente es que se trabaja con las
unidades de forma individual.
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La sección de Style acoge diversas opciones para las unidades:

- Para poder trabajar con una determinada unidad debe estar habilitada, esto se consigue
seleccionando Enabled.

- Las siguientes opciones se re�eren al estilo del incono (Icon 16x16 pixels) y de la etiqueta
del icono que puede ser transparente (habilitando Transparent), cambiar el color (mediante
BackColor y ForeColor), cambiar la posición hacia la izquierda, centrado o hacia la derecha
(Left, Centre o Right).

La última opción de esta columna es la de sólo mostrar las unidades que son miembros de
enlaces visibles, seleccionando Show only units that are members of a visible netwok.

La columna de la izquierda de la ventana contiene botones para aceptar (OK ), deshacer las
nuevas características introducidas de la unidad (Undo unit), mover la unidad hacia arriba o
hacia abajo (Move up o Move down), guardar las unidades en un archivo de texto (Export),
obtener las coordenadas de un archivo de texto para incluirlas a nuestra red (Import), para ello
hay que hacer File > Load en la ventana que aparece y seleccionar el archivo de texto correcto,
borrar todas las unidades mediante Clear all, clasi�car por orden alfabético las unidades, gracias
al botón Sort y, por último, aplicar a todas las unidades el estilo de la unidad seleccionada (Ap-
ply Style). En alguno de los casos se debe que aceptar en la ventana de con�rmación que aparece.

En la esquina inferior derecha aparece el estilo de icono y etiqueta que va a aparecer para
dicha unidad.

Si no tenemos el detalle de donde se posicionará una estación y va a depender del mapa
de cobertura, la podemos emplazar en cualquier lugar del mapa y moverla en el momento que
queramos.

Práctica:

File > Unit properties.

1. Seleccionar la unidad con la que vamos a trabajar.

2. Escribir un nombre con el que podamos identi�car fácilmente la unidad en Name.

3. Introducir las coordenadas:

a) Seleccionamos Enter LAN LOR or QRA. Aparece la ventanaWGS coordinates, intro-
ducimos las coordenadas de forma hexadecimal, decimal o mediante el sistema QRA
y pulsamos OK.

b) Situando el cursor donde queramos que esté aproximadamente la unidad y seleccio-
nando Place unit at cursor position.

c) Pegándolas desde otra unidad empleando Paste.

d) Obtenerlas desde la base de datos del programa con Get units from cities.dat.

e) Desde Google Earth, haciendo en el programa Añadir > Marca de posición y copiando
las coordenadas en Radio Mobile.

4. Ya deben aparecer de color verde y azul las coordenadas de la unidad.

5. En la sección de estilo habilitamos la unidad, seleccionando Enabled y centramos la etiqueta
(Centre).
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6. Si queremos incluir unidades de otras redes, pulsamos Import. En nueva ventana (Import
units) hacemos File > Load y cargamos el �chero que contenga las unidades deseadas,
estas se pueden observar en la columna derecha. Por último se seleccionan las que queremos
incluir en nuestro proyecto y se pulsa el botón <- y OK. En la columna de la izquierda
hay que seleccionar desde que unidad queremos que se importe (Start overwrite at) para
evitar que se sobrescriban.

7. Para incluir el nombre y coordenadas de nuestras unidades de trabajo hay que pulsar
Export y escribir el nombre del �chero.

8. Para guardar los cambios y cerrar la ventana seleccionamos OK.

9. Seleccionar Extract.
Ver �gura A.5.

Figura A.5: File > Unit properties.

A.6. Redes

Seleccionando Networks properties del menú File aparece la ventana Networks properties
donde se puede seleccionar en la �la superior:

- Los parámetros por defecto (Default parameters).

- Copiar las características del enlace en uso o copiarlas de otro enlace (Copy / Paste Net).

- Aceptar o Cancelar las propiedades y cerrar la ventana (OK o Cancel).

Existen cinco iconos para seleccionar el tipo de parámetros:

- Para ajustar los parámetros generales del modelo de propagación: Parameters.

- La topología del enlace se de�ne en Topology.

- En Membership seleccionamos las unidades que forman parte del enlace, el papel de éstas
en relación con la topología y su sistema.

- En la pestaña Systems se de�nen los sistemas o equipos que vamos a emplear.

- Por último, el estilo de presentación de los enlaces se selecciona en Style.
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A.6.1. Sistemas

Para la de�nición los sistemas, en la ventana que aparece hay que seleccionar Systems para
introducir las características:

- El menú Select from Radiosys.dat permite cargar parámetros de otros sistemas en nuestro
nuevo sistema.

- El nombre se puede introducir en la casilla System name.

- La potencia de transmisión emitida por el equipo se puede introducir en vatios o dBm,
se calcula automáticamente en la otra unidad. Se competa en Transmit power (watt) o
(dBm).

- En Receiver threshold (µV) o (dBm) se asigna la sensibilidad del equipo receptor.

- Las pérdidas de línea que incluyen las del cable, cavidades (si se utilizan), conectores, etc.
se introducen en dB en Line loss (dB).

- En el menú desplegable Antenna type se selecciona el tipo de antena de los que se incluyen
en el �chero radiosys.dat, por ejemplo omnidireccional, elíptica o yagi. En el botón View
aparece una ventana (Antenna pattern) se puede ver dibujado el diagrama de radiación de
la antena de cada tipo e ir variando los parámetros manualmente o el ángulo de la antena
en Front beam azimuth (◦), la ganancia de la antena en Front beam gain (dBi) y la escala
en dB (Scale (dB)). Para dibujarla se selecciona Draw. Para copiar en el portapapeles se
pulsa Copy to clipboard. Seleccionar las distintas opciones de visibilidad de la rejilla y de
las etiquetas (Draw grid y Draw labels) y las opciones de color del diagrama, de la rejilla
y del fondo (Plot color, Grid color y Back color).

- La ganancia de la antena respecto a la antena isotrópica o a la del dipolo de media longitud
de onda de trabajo se incluye en Antenna gain (dBi) o (dBd), la otra casilla se rellena
automáticamente.

- La altura sobre el suelo en metros se introduce en Antenna height (m).

- Las pérdidas del cable desde la base de la torre hasta el conector en dB/m, si la altura de
la antena en el posterior estudio del enlace di�ere de la introducida en el sistema, se deben
rellenar en la casilla Aditional cable loss (dB/m).

- Los datos de la antena se pueden guardar o borrar de la base de datos radiosys.dat (Add
to / Remove from radiosys.dat), para poder utilizar los datos en otros sistemas.

A.6.2. Parámetros de enlaces

Para el ajuste de los parámetros de los enlaces se selecciona Parameters de la ventana Net-
works properties. Los parámetros que se pueden seleccionar en este apartado son:

- Nombre del enlace (Net name).

- Frecuencia mínima y máxima en MHz (Minimum/Maximum frequency (MHz)). Ésta puede
variar entre 20 MHz y 20 GHz. El programa tomará la frecuencia media como entrada al
modelo de propagación.

- Refractividad de la super�cie terrestre (Surface refractivity (N-units)), que determina la
curvatura que sufrirán las ondas de radio. Para unas condiciones atmosféricas promedio se
selecciona 301 Unidades de n, que corresponde a una curvatura de la tierra de 4/3.
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- Conductividad del suelo medida en Siemens por metro (Ground conductivity (S/m)). De-
pende del tipo de terreno y de la frecuencia de trabajo. El valor por defecto es 0.005.

- Permitividad relativa del suelo o constante dieléctrica del medio (ε) (Relative ground per-
mittivity). Depende del tipo de terreno y de la frecuencia de trabajo. El valor por defecto
es 15. Ver Tabla A.1.

Características del terreno Conductividad Permeabilidad
(S/m) relativa

Terreno de calidad media 0.005 15
Terreno pobre 0.001 4
Terreno bueno 0.01 25
Agua dulce 0.02 25
Agua marina 5 25

Cuadro A.1: Conductividad y permeabilidad según el tipo de terreno.

- En la categoría Polarization se puede seleccionar polarización de la antena vertical u hori-
zontal (Vertical / Horizontal). Se asume que ambas antenas tiene la misma polarización.

- En siguiente sección llamada Mode of variability se puede seleccionar el modo de varia-
bilidad, que determina la �abilidad de los valores utilizados en el modo. Éstos pueden
ser:

o Spot : ajustando el porcentaje respecto a las situaciones. El programa hace un único
intento para enviar un mensaje en la simulación. Transmisiones unicast entre esta-
ciones �jas.

o Accidental : ajustando el porcentaje respecto al tiempo y las situaciones. Se utiliza
para evaluar interferencias.

o Mobile: ajustando el porcentaje respecto al tiempo y las situaciones. Empleado para
comunicaciones móviles.

o Broadcast : ajustando el porcentaje respecto al tiempo, las ubicaciones y las situa-
ciones. Transmisiones broadcast entre estaciones �jas.

- El porcentaje de pérdidas adicionales (Additional loss) dependiendo de si nos encontramos
en suelo urbano (City) o rural (Forest).

- Por último encontramos la sección Climate, donde se puede de�nir el clima aproximado de
la zona bajo estudio: Equatorial, Continental sub-tropical, Maritime sub-tropical, Desert,
Continental temperature, Maritime temperature over land y Maritime temperature over
sea.

A.6.3. Topología de red

Seleccionando Topology se de�ne la topología de cada enlace. Si está habilitado Visible, se
mostrará el enlace en la imagen. Dicha topología puede ser:

- Voice net (Command/Subordinate/Rebroadcast): Se emplea para comunicar las estaciones
de mando con las subordinadas, pero no las subordinadas entre sí. Para mejorar la comu-
nicación se crean unidades de retransmisión.

- Data net, star topology (Master/Slave): Se utiliza para enlazar las unidades maestro con
las unidades esclavo, pero no las unidades esclavo entre sí. Existe la opción de marcar por
defecto las demás unidades como esclavo cuando se marca una como maestro habilitando
If a unit is set to master, set all others as slave.
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- Data net, cluster (Node/Terminal): Se emplea para redes de datos con nodos que pueden
retransmitir datagramas, determinando el número máximo de retransmisiones de 0 a 20
(Maximum number of rebroadcasts allowed).

A.6.4. Unidades miembro del enlace

En este apartado se de�nen los miembros y características de cada enlace. Se accede selec-
cionando Membership. Seleccionando el nombre un enlace, aparece una lista de las unidades. De
las que se seleccionan las que pertenezcan al enlace y se seleccionan sus características:

- Se selecciona del menú desplegable de Role of... en función de la topología indicada.

- En Antenna height (m) se puede elegir si dejamos la altura determinada en el sistema
(System) o modi�carla (Other) introduciendo otro valor.

- Si la antena seleccionada no es omnidireccional, en Antenna Azimuth se debe seleccionar
la directividad de la antena indicando hacia que unidad apunta. También se puede �jar un
ángulo, habilitando Fixed (◦) e introduciendo una cantidad. Existe la posibilidad de ver el
diagrama de radiación de la antena gracias a View pattern.

A.6.5. Estilo del enlace

Para de�nir el estilo de representación del enlace se selecciona el icono Style:

- La primera sección es la de Propagation mode donde se puede habilitar la aplicación del
método de dos rayos (directo y re�ejado en la super�cie terrestre) en el cálculo de radioen-
laces de visión directa (Use �Two Rays� for Line-Of-Sight). Elegir Normal o Interference
si contemplamos el cálculo de interferencias.

- Las tres opciones siguientes se destinan a seleccionar el color (verde, amarillo y rojo) de
la línea de enlace en función de si la señal relativa recibida en un punto del mapa supera
o no un valor. Para topologías de red tipo cluster y el número de saltos es mayor a cero,
el color amarillo desaparece y el color verde y el rojo se destinan para valores de la señal
recibida mayores o menores a cero.

- La última opción es Draw lines with dark background que dibuja las líneas con fondo
oscuro.

Práctica:

File > Networks properties.

1. Activar la pestaña Systems.

a) Seleccionar el sistema que queremos caracterizar en la columna izquierda.

b) Introducir nombre del sistema que vamos a de�nir. Se debe emplear un nombre con
el que podamos identi�car fácilmente las características. Por ejemplo: Tipo de tarjeta
inalámbrica (R25H, SR2...), tipo de antena (dir, sec, omni...), ganancia de la antena
(18 dBi) y tipo de cable coaxial (lmr600...), lo que quedaría R25H dir 28.5dBi lmr600.

c) Se rellenan las características de los equipos del sistema que estamos de�niendo: po-
tencia transmitida, sensibilidad del equipo receptor, pérdidas de línea, tipo, ganancia
relativa y altura de la antena y pérdidas adicionales del cable por metro. La mayoría
de estos datos los debe proporcionar el fabricante en las hojas de características de los
equipos, otras se calculan. Por ejemplo, la ganacia relativa se especi�ca por recomen-
daciones y la experiencia propia; la altura de la antena se de�ne como resultado de
la simulación.
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d) Es conveniente guardar los datos en radiosys.dat mediante Add to radiosys.dat, ya
que muchas características serán iguales en otros sistemas.
Ver �gura A.6.

Figura A.6: Systems.

2. Seleccionar Parameters.

a) Seleccionar el enlace deseado de la lista de enlaces.

b) Elegir un nombre para el enlace. Éste puede contener los dos extremos del enlace, por
ejemplo Punto A - Punto B.

c) Si no conocemos los valores de la refractividad, la conductividad y la permitividad,
se utilizan los valores por defecto (301 / 0,005 / 15).

d) La frecuencia a seleccionar debe estar en torno a 2.4 GHz o 5.8 GHz ya que son
las frecuencias inalámbricas no licenciadas. Se pueden hacer pruebas en las dos fre-
cuencias y elegir la que mejor resultados ofrezca. También depende de la frecuencia
utilizada en la zona para evitar interferencias. La selección de la frecuencia mínima
y la máxima, depende del canal elegido.

e) De�nir la polarización de la antena (vertical / horizontal). Por defecto se de�ne
polarización vertical. Cuando en un mismo punto se existen muchas verticales se
opta que uno de ellos sea horizontal.

f ) El modo de variabilidad que se solía emplear para este tipo de enlaces era el de Broad-
cast con% de tiempo, ubicaciones y situaciones igual a 90, 80 y 80, respectivamente.
Ahora se está usando el modo Accidental, quedando bloqueado el% de ubicaciones
ya que es un punto �jo y los porcentajes de tiempo y situaciones igual a 90 y 70,
respectivamente.

g) Seleccionar City o Forest dependiendo de si nos encontramos en zona urbana o rural,
respectivamente. El porcentaje de las pérdidas adicionales en bosque se calcula con
el simulador Land Cover.

h) El clima depende del escenario. En selva se ha empleado Equatorial y en sierra Con-
tinental temperature.
Ver �gura A.7.

3. Seleccionar Topology.

a) Seleccionar el enlace que queremos de�nir de la columna de la izquierda.

b) Habilitad la opción Visible.
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Figura A.7: Parameters.

c) Marcar la topología deseada. Se suele utilizar Data net, star topology (Master/Slave).

d) Activar la casilla If a unit is set to master, set all others as slave.
Ver �gura A.8.

Figura A.8: Topology.

4. Seleccionar Membership.

a) Seleccionar el enlace del que queremos caracterizas sus miembros.

b) Activar las unidades que pertenecen a este enlace y caracterizar cada una de ellas
con el papel que juegan en el enlace (Master / Slave) y el sistema que de�ne las
características de sus equipos.

c) Inicialmente, seleccionar la altura de la antena de�nida en el sistema (activando Sys-
tem en Antenna height (m)).

d) Para antenas que no sean omnidireccionales, deshabilitar en Antenna azimuth la
opción Fixed (◦) y seleccionar la otra unidad del enlace en el menú desplegable.
Ver �gura A.9.

5. Activar Style.
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Figura A.9: Membership.

a) Seleccionar la opción de Use �Two Rays� for Line-Of-Sight en modo Normal si no
consideramos el cálculo de interferencias.

b) Marcas las tres siguientes casillas, indicando en dB los límites. Por ejemplo en amarillo
el nivel mínimo de señal recibida y en verde si se supera de forma más amplia.

c) Activar la opción de Draw lines with dark background.
Ver �gura A.10.

Figura A.10: Style.

6. Pulsar OK para guardar los cambios y cerrar la ventana.

View > Show networks.

1. > All para mostrar unidades y enlaces.

2. > Units muestra únicamente los emplazamientos de la red.

3. > Needlines muestra las líneas de los enlaces.
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A.7. Reportes de enlaces

En el menú Tools en Network report, se pueden observar las características de cada enlace,
se seleccionan los siguientes parámetros:

- El enlace que queremos estudiar.

- Si permitimos retransmisiones (With rebroadcast) o sólo permitimos trayectorias directas
(Direct path only (dB)).

- Imprimir (Print) o guardar (File) el informe.

La información que te ofrece la ventana Performance report que aparece es:

- Nombre del enlace.

- Topología empleada.

- Frecuencia de trabajo.

- Para cada unidad de la red: Nombre, número, margen relativo de recepción, papel que
desempeñan con respecto a la topología, sistema empleado y altura y ángulo acimutal de
la antena.

- Si hemos seleccionado Direct path only, aparecerá Quality = 50 + signal margin in dB, por
lo que hay que sumarle 50 al margen de recepción. Si hemos seleccionado With rebroadcast
aparecerá Quality = 50 - number of resend, habrá que restarle a 50 el número de retrans-
misiones.

Si seleccionamos File, nos aparece un informe con los siguientes datos:

- En el apartado General information aparecen las rutas del *.net y del *.map, las coorde-
nadas centrales del mapa y la altura y anchura de su representación.

- En la sección Active units information, podemos observar los siguientes datos de cada
unidad: Nombre (Name), coordenadas (Location) y altitud (Elevation).

- En Systems aparecen las características de los sistemas: Nombre (Name), potencia trasmi-
tida en vatios (Pwr Tx ), pérdidas en dB (Loss), pérdidas adicionales por metro en dB/m
(Loss (+)), sensibilidad del receptor en dBm (Rx thr.), ganancia relativa de la antena en
dBi (Ant. G.) y tipo de antena (Ant. Type).

- En la sección Active nets information, se de�nen las siguientes características de cada
enlace:

o Nombre del enlace.

o Topología empleada.

o Frecuencia de trabajo.

o Polarización (horizontal o vertical).

o Modo de variabilidad

o La refractividad, conductividad y permitividad.

o Clima seleccionado.
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o Para cada unidad del enlace: Nombre (Net members), número (01 ), margen relativo
de recepción (02 ), papel que desempeñan con respecto a la topología (Role), sistema
empleado (System) y altura y ángulo acimutal de la antena (Antenna).

o También aparecerá Quality = 50 - number of resend, por lo que habrá que restarle a
50 el número de retransmisiones.

A.8. Radio Link

Se accede a esta herramienta mediante Tools > Radio link. En la ventana Radio Link que
aparece se muestran los parámetros del enlace entre las dos unidades que seleccionemos. En
menú de dicha ventana se puede seleccionar:

- Edit : Permite copiar la imagen seleccionando Copy o guardarla mediante Export to...

- View : para observar diferentes perspectivas y presentaciones del enlace.

- Swap: Intercambia el transmisor y el receptor.

Los datos que aparecen arriba de la imagen son:

- Azimuth: Ángulo acimutal de la antena en grados (◦).

- Elev. angle: Ángulo de elevación en grados (◦).

- Clearance: Despeje at en km.

- Worst Fresnel : Peor ángulo de Fresnel en veces F1.

- Distance: Distancia del enlace en km.

- PathLoss: Pérdidas en el espacio libre en dB.

- E �eld : Nivel de campo en dBµV/m.

- Rx level : Nivel de señal recibida en dBm.

- Rx level : Nivel de señal recibida en µV.

- Rx reative: Margen de la potencia de la señal recibida respecto a la sensibilidad del receptor
en dB.

En la imagen aparece el per�l orográ�co del enlace.

- Las siguientes secciones contienen los parámetros del transmisor (Transmitter) y del re-
ceptor (Receiver) que anteriormente introdujimos. Entre ellos están el nombre, el papel
que desempeñan, el nombre del sistema, la potencia de transmisión, las pérdidas de línea,
la ganancia de la antena y la potencia radiada. Podemos variar las alturas de las antenas.
El código S se re�ere a la sensibilidad, depende del margen de fadding (M), siendo M =
Pr - Prmin (Pr: Potencia recibida, Prmin: sensibilidad en el receptor). Ver Tabla A.2.

En la sección Net aparece el nombre de los enlaces correspondientes a las unidades bajo
estudio, debemos seleccionar el que nos interese si existen varios.
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Código S Fadding (M)
S0 M ≤ -1.5 dB
S1 -1.5 dB < M ≤ 1.5 dB
S2 1.5 dB < M ≤ 4.5 dB
S3 4.5 dB < M ≤ 7.5 dB
S4 7.5 dB < M ≤ 10.5 dB
S5 10.5 dB < M ≤ 13.5 dB
S6 13.5 dB < M ≤ 16.5 dB
S7 16.5 dB < M ≤ 19.5 dB
S8 19.5 dB < M ≤ 22.5 dB
S9 22.5 dB < M ≤ 27 dB

S9+10 27 dB < M ≤ 39 dB
S9+20 39 dB < M ≤ 49 dB
S9+30 49 dB < M ≤ 59 dB

Cuadro A.2: Código S en función del márgen de fadding (M)

Por último, aparece el mínimo y el máximo de la frecuencia en el apartado Frequency, que
podemos modi�car.

Práctica:

Tools > Radio link.

1. Seleccionar las unidades que queremos estudiar.

2. Seleccionar el enlace correspondiente.

3. Modi�car las alturas de las antenas hasta que:

a) Worst Fresnel sea mayor o igual a 0,6F1, aunque mejor 1F1.

b) Rx relative sea mayor o igual a 20, aunque a veces hay que conformarse con menos.

c) PIRE sea menor o igual a 4 W por limitación de las leyes peruanas. En campo es más
�exible, se podría aumentar pidiendo un permiso. En otros paises puede ser cambiar
este límite.

4. Presionar Apply para guardar los cambios.

5. Es recomendable seleccionar Swap del menú superior para analizar el enlace en el otro
sentido ya que no suele ser simétrico.
Ver �gura A.11.

A.9. Representación de la cobertura

Mediante el menú Tools, se puede dibujar el área de cobertura seleccionando Radio coverage.
Los tipos de grá�cas que se pueden dibujar son:

Single polar : dibuja el área de cobertura de una unidad central �ja para una unidad móvil
realizando un barrido radial.

- Hay que seleccionar tanto estas unidades como el enlace en estudio.
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Figura A.11: Tools > Radio link.

- En el apartado Link Direction se especi�ca si queremos que el centro sea la estación
transmisora o la receptora.

- Se determina el mínimo y el máximo de la distancia desde la unidad �ja donde se calculará
la cobertura en Radial Range (km).

- En la sección Plot se determina cómo queremos que se dibuje la cobertura, sólo el contorno
o relleno de un color o en escala de colores.

- El rango del ángulo acimutal se selecciona en Azimuth Range.

- En Threshold se puede ajustar la sensibilidad según el código S, en dBm, µV y dBµV/m.
Se puede poner el mínimo y el máximo o ajustarlo automáticamente, lo que da lugar al
mínimo igual a la sensibilidad del receptor móvil y el máximo 40 dB por encima.

- Se puede emplear la antena relativa al enlace o modi�carla en Antenna Pattern.

- Los botones de la esquina superior derecha te permiten dibujar la cobertura o cancelar.

Combined cartesian: para calcular el área de cobertura en coordenadas cartesianas se utilizan
una o varias unidades �jas y una unidad móvil.

- Se seleccionan las unidades �jas (de las que se puede cambiar la antena y dibujar el patrón
de radiación), la unidad móvil y el enlace que las relaciona.

- Se pueden habilitar las siguientes opciones: usar las características de la antena ya de�nidas,
guardar los datos del mapa de bits en un �chero, presentar las unidades no seleccionadas,
guardar los dibujos de cobertura y de�nir una distancia máxima en kilómetros para dibujar
la cobertura.

- En las dos siguientes secciones, Link Direction y Mode, se determina si la unidad móvil es
el transmisor o el receptor y si se dibuja para todo el dibujo o para una sección.

- En Single range to draw : se determina el mínimo y el máximo de la distancia a la que se
dibujará la cobertura según el código S, en dBm, µV y dBµV/m. El tamaño en píxeles y
el color de la zona dibujada.
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- La columna de la derecha da la opción de dibujar, cancelar, cargar o guardar las carac-
terísticas o descargar datos en un �chero *.txt.

Interference: dibuja regiones con un nivel de interferencia aceptable y regiones que superan
el margen de interferencia.

- En la primera sección, Coverage based on required Signal to Interference ratio (S/I) or
acceptable time delay, se de�ne si se va a analizar la cobertura en función del código S, en
dBm, µV y dBµV/m, el mínimo de nivel de señal y de relación S/I. Se elige el color si se
supera o no la relación S/I mínima y el tamaño en píxeles del dibujo. Si se habilita Time
delay se debe de�nir el desfase máximo que se considerará y el color con el que se dibujará
la zona donde no se supera la relación S/I, pero hay un desfase aceptable.

- En las dos secciones siguientes se selecciona el transmisor deseado y el interferente, se
puede cambiar los patrones de las antenas o dejarlas tal como las de�nimos. Si habíamos
habilitado Time delay, estas dos secciones se referirán a los dos transmisores.

- La última sección Mobile, se re�ere a la unidad móvil. Hay que seleccionar la red que
englobe a todas las unidades bajo estudio.

- Cuando tengamos todas las opciones elegidas podemos seleccionar Draw para dibujar o
Cancel para cancelar.

Fresnel : en la ventana Fresnel Zone Coverage que aparece se debe seleccionar la unidad
central, la unidad móvil y la red que las relaciona. Como características de representación hay
que de�nir:

- En el apartado First Fresnel zone clearance, el intervalo de despeje de la primera zona de
Fresnel que queremos que se coloree y su color.

- El mínimo y el máximo de la distancia en kilómetros de cobertura desde la estación �ja.

- El ángulo acimutal que para todas direcciones sería de 0◦a 360◦.

- Por último se puede elegir Draw o Cancel.

Find best sites: encuentra los mejores emplazamientos de la unidad transmisora para dar
cobertura a los receptores de una determinada red:

- En la �la superior hay que activar Within a network, si se quiere determinar los mejores
puntos para la unidad central dentro de una red oWith waypoints, seleccionando una ruta.

- Hay que elegir la unidad transmisora y la red. Si hemos activado With waypoints también
hay que elegir una unidad móvil.

- Se de�ne el mínimo porcentaje de cobertura que vamos a dibujar y el color de los valores
que lo superan pulsando Color.

- Se elige el tamaño en píxeles del dibujo y el color con el que se va representar.

- Si se ha activado la opción With waypoints aparecen una sección más para dibujar la ruta
o descargarla desde algún �chero.

- Por último se debe dibujar (Draw) o cancelar (Cancel).
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Route: aparece la ventana Route radio coverage. Esta opción se emplea cuando disponemos
de la ruta en un �chero.

La cobertura de visión directa se puede dibujar desde Visual coverage del menú Tools. En la
ventana que aparece se puede seleccionar:

- La unidad desde la que queremos observar y la altura del sensor en metros en la sección
Observer.

- El estilo de la zona de cobertura visual. Si queremos que sea relleno, únicamente representar
el borde o ambas y su color en Plot.

- Los rangos de los ángulos acimutal y de elevación, eligiendo los mínimos y máximos. Esto
se de�ne en Azimuth / Elevation angle range.

- En Target se puede elegir que el objetivo esté sujeto al suelo (se puede variar la altura) o
con una determinada altura respecto al nivel del mar.

- La última sección, Radial range, se destina a ajustar la distancia para la que se va a calcular
la cobertura visual.

- Para presentar esta cobertura se pulsa Draw y para cancelar, Cancel.

Práctica:

Tools > Radio coverage.

1. > Single polar.

a) Se selecciona la unidad �ja (normalmente un repetidor), la unidad móvil y el enlace
que las relaciona. La unidad móvil hay que de�nirla previamente en un lugar cercano
al ideal.

b) Se de�ne si la unidad móvil es la transmisora o la receptora.

c) El máximo de Radial Range (km) depende de la distancia aproximada a la cual
queramos situar la unidad móvil.

d) Si nos interesa dibujar la cobertura en todas direcciones elegiremos el rango del ángulo
acimutal de 0◦a 360◦.

e) La sensibilidad se puede ajustar automáticamente.

f ) Pulsamos Draw.

2. > Combined cartesian.

a) Se seleccionan una o varias unidades �jas, la unidad móvil y el enlace que las relaciona.
La unidad móvil hay que de�nirla previamente en un lugar cercano al ideal.

b) Se de�ne si la unidad móvil es la transmisora o la receptora.

c) Se elige el rango de señal que se dibujará.

d) Se selecciona Draw.

3. > Interference.

a) Seleccionar el mínimo nivel de relación S/I que se va a aceptar.

b) De�nir las unidades transmisora, receptora y la interferente. Deben pertenecer a la
misma red.
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c) Draw.

4. > Fresnel.

a) De�nir la unidad �ja, la móvil y el enlace entre ambas.

b) Elegir que veces la primera zona de Fresnel queremos que se dibuje.

c) Seleccionar el máximo de la distancia y los ángulos acimutales entre los que queremos
representar, que para todas direcciones debe ser entre 0◦y 360◦.

d) Draw.

5. > Find best sites.

a) Elegir Within a network si no tenemos claro la posición de la unidad. Sí debe existir
un enlace que relacione la unidad central, que debemos seleccionar, y la móvil.

b) De�nimos el mínimo de cobertura que vamos a representar.

c) Pulsamos Draw.

Tools > Visual coverage.

1. Seleccionar la unidad central desde la que queremos conocer la cobertura visual.

2. De�nir el estilo de la zona de cobertura, el ángulo de elevación y el ángulo azimutal, que
debe ser de 0◦a 360◦si queremos que calcular la cobertura en todas direcciones.

3. Elegir la opción Nap-of-the-earth, si queremos de�nir la altura del objetivo con respecto al
suelo.

4. Draw.

A.10. Guardar el proyecto

Extensión de �cheros que se guardan para una red:

- La información de la red (unidades, enlaces, parámetros de propagación, topologías...) se
guarda en el *.net.

- En el �chero *.map se encuentra la información de los per�les del terreno, la elevación.

- Las imágenes asociadas a los mapas se guardan en el �chero *.bmp. No tienen información
del per�l del que son representación grá�ca.

Práctica:

File > Save networks as...

En la ventana Save networks que aparece se selecciona el directorio deseado, se introduce el
nombre del proyecto y el tipo Netwok File (NET) y se acepta.

File > Save map as...
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En la ventana Save map que aparece se selecciona el directorio deseado, se introduce el nom-
bre del proyecto y el tipo Map File (MAP) y se acepta.

File > Save picture as...

En la ventana Save picture que aparece se selecciona el directorio deseado, se introduce el
nombre del proyecto y el tipo Picture File (BMP) y se acepta.

A.11. Google Earth

Una vez guardado el �chero *.net, con todos los datos de la red se debe pasar a un tipo de
�chero compatible con Google Earth, éste es *.klm. Se consigue con la aplicación Net2Klm de
VE2DBE.

Una vez en Google Earth, una utilidad es la de comprobar si existe línea de vista, hay que
seleccionar Abrir... del menú Archivo y seleccionar el �chero *.klm que habíamos creado.

El �chero *.klm aparece en Lugares temporales. Debemos ir desplegando pestañas hasta que
aparezca Networks. Para el enlace que queramos observar desplegamos la pestaña y aparece
Link between �unidad1� and �unidad2�. Hacemos clic con el botón derecho y seleccionamos
Propiedades. Aparece la ventana Google Earth - Editar Ruta. En la pestaña Altitud se puede
seleccionar la altura en metros escribiéndola o con un cursor desplazable, si esta altura se re�ere
al suelo, al lecho marino, si el enlace está sujeto al suelo o al lecho marino o si la altura es
absoluta. La última opción es la de Extender la ruta al suelo.

Otra utilidad es la de encontrar un emplazamiento dependiendo de la posibilidad de acceso.
Por ejemplo si está cerca de una vía, si el punto está sobre una pared muy vertical, etc. Ya que
habrá que acceder transportando material. Las coordenadas de este punto se consiguen medi-
ante Añadir > Marca de posición. Pinchamos el marcador en el lugar deseado y en la ventana
Google Earth - Nuevo Marca de posición que aparece, se puede ver la Latitud y la Longitud que
copiaremos en Unit properties de Radio Mobile.

Práctica:

Net2Klm.

1. Seleccionar Open a Network del menú File. Elegir el �chero *.net que contenga los datos
de nuestra red.

2. En el menú File seleccionar Save as klm �le.

3. File > Exit.

Google Earth.

1. Comprobar línea de vista:

a) Archivo > Abrir... y seleccionar nuestro *.klm relacionado con el *.net.
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b) Lugares temporales > Networks y clic derecho en Link between �unidad1� and �unidad2�
y seleccionamos Propiedades.

c) Seleccionar la pestaña Altitud de la ventana Google Earth - Editar Ruta.

d) Activar Extender ruta al suelo.

e) Aceptar.

2. Encontrar un buen emplazamiento:

a) Añadir > Marca de posición. Pinchar para poner el marcador en la zona deseada.

b) Copiar Latitud y Longitud a Unit properties de Radio Mobile.

c) Aceptar.
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B
Selección de equipamiento

B.1. Placas SCB

[3]
Ver Tabla B.1.

- RouterBOARD 532A. Características: http://www.routerboard.com/rb500.html

o Se basa en el procesador Freescale MPC8321. No tiene FPU (unidad de punto �otante).

o Ventaja de manejar hasta 4 y 6 interfaces inalámbricas miniPCI (por medio de tarjetas
adicionales) .

o Inconveniente de que a más interfaces menos potencia administrada a cada uno.

o Inconveniente de venir con un sistema operativo propietario instalado llamado RouterOS,
no se podrá adicionar o cambiar aplicaciones particulares.

o Existe la posibilidad de instalar otro sistema operativo no propietario mediante una
ranura par CF sin perder el sistema propietario.

- RouterBOARD 333. Características: http://www.routerboard.com/pdf/rb333b.pdf

o Una de las placas más utilizadas por los desarrollares de redes inalámbricas.

o Se basa en el procesador Freescale MPC8321. No tiene FPU.

o Gran ventaja de manejar tres interfaces inalámbricas miniPCI de alta potencia.

o Viene con el sistema operativo RouterOS instalado.

- Alix2C0. Características: http://www.pcengines.ch/alix2c0.htm

o Se basa en el procesador AMD Geode LX700, es un x86 y posee FPU.

o No viene con ningún sistema operativo, posee ranura para CF para instalar uno.

o Posee dos ranuras miniPCI que con modi�caciones soportará interfaces inalámbricas
de alta potencia.

o Al ser un sistema x86 se tiene la gran facilidad de trabajar con las distintas aplica-
ciones de redes conocidas de alto nivel.

- Pronghorn SBC-250. Características: http://www.adiengineering.com/
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o Se basa en un procesador Intel IXP425, 533 Mhz. No posee FPU.

o Posee dos ranuras miniPCI que soportan interfaces inalámbricas de alta potencia.

o No trae un sistema operativo.

o Se le puede instalar el que ofrece el mismo fabricante u otro porque posee una ranura
para CF.

o Suministra más corriente a las interfaces miniPCI comparada con las otras.

- Pronghorn Metro SBC Quad-RadioWireless. Características: http://www.adiengineering.com/

o Consume mucha potencia en comparación a las anteriores.

o Maneja 4 interfaces inalámbricas miniPCi de alta potencia

o Posee herramientas para manejar tarjetas WiMax.

B.2. Tarjetas de red inalámbrica

[3] Se ha trabajado con tarjetas de dos chipsets diferentes (Intersil Prism 2.5 y Atheros), con
modelos que transmiten desde 80mW hasta 600mW. Se recomienda usar como controladores de
las interfaces inalámbricas el driver Hostap para el caso de tarjetas con chipset Intersil Prism
2.5 y MadWi� para tarjetas con chipset Atheros.

Mientras que el driver Madwi� permite modi�car el valor de ACKtimeout, CTSTimeout y
SlotTime, comentados anteriormente y por lo tanto un mejor control de las prestaciones del
sistema, el Hostap no permite modi�car los valores anteriores, sin embargo, las tarjetas con este
driver tienen un valor mayor ACKtimeout, de manera que pueden ser usadas con prestaciones
aceptables en enlaces largos de hasta 30km. No obstante, mientras que estas últimas sólo pueden
ser con�guradas en modo b, distintos modelos con chipset Atheros soportan los estándares 802.11
a,b o g. Ver Tabla B.2.

En conclusión las características deseables son:

- Tarjetas de alta potencia en los estándares 802.11a/b/g.

- Que tengan Chipset Atheros.

- Consumo de corriente apropiada para la placa a utilizar.

- Debe ser de factor de forma miniPCI.

B.3. Pigtails

[3] Estos se tratan, típicamente, de conectores UFL y MMCX. En el otro extremo los pigtails
tienen conectores N hembra o macho. Dado que los conectores UFL y MMCX son sumamente
pequeños, los pigtails están fabricados con cables coaxiales muy delgados de mucha atenuación
motivo por el cual deben ser lo más cortos posible (típicamente de 30 cm).
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B.4. Antenas

[3] Dada la diversidad de situaciones en las que las que se necesitan las antenas, tales como:
PtP, PtMP, con distancia entre los puntos variable, entre centenas de metros y decenas de ki-
lómetros, y con distintas características ambientales de los lugares donde se han instalado, se
utilizan multitud de modelos de antenas en función de estos requerimientos.

En GTR-PUCP siempre se ha con�ado para la adquisición de estos equipos en la marca
Hyperlink, ya que es una marca ampliamente disponible y su relación calidad precio es una de
las mejores del mercado. Dentro de esta marca y dado que las antenas siempre se instalan a
la intemperie, se eligen los modelos especí�cos para exteriores. A partir de aquí la elección de
la antena depende de la ganancia necesaria de la misma para poder realizar el enlace y de la
frecuencia en la que se va a realizar. Estos datos se obtienen durante la etapa de diseño de
la red. Es importante resaltar que los precios de las antenas aumentan con su ganacia, por lo
que un ajuste �no, en lo que a ganancia se re�ere, puede suponer grandes reducciones en el costo.

En la banda de 2.4 GHz algunos de los modelos utilizados son:

- Antena de grilla HG2424G de 24 dBi.

- Antena de panel HG2418P de 14dBi.

- Antenas sectoriales HG2414SP-120 y la HG 2414SP-090 de 14 dBi de ganancia cada una
y de 120 y 90◦de haz, respectivamente.

En la de 5.8 GHz se han utilizado:

- Antena de plato HG5829D de 29 dBi dada su gran ganancia y la posibilidad de instalarle
un radome, que la dota de mayor aerodinamicidad, fundamental en lugares muy ventosos.

- Antena de grilla HG5827G de 27 dBi y la de panel HG5819P de 19 dBi.

NOTA: Las antenas de grilla tanto de 2.4 GHz como de 5.8 GHz tienen unas abrazaderas
un tanto débiles, por lo que en zonas de mucho viento se recomienda emplear un método de
sujeción adicional.
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Cuadro B.1: Comparación de SBCs para aplicación de redes inalámbricas.
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Interfaces Estándar Potencia máx Potencia máx Conector antena Sensibilidad Corriente
en g (dbm) en a (dbm)

SR2 g 26 @ 1-24Mbps - 1 U.FL y 1 MMCX 6 Mbps -94 dBm 1.1
12 Mbps -91 dBm

R52H ag 26 @ 6Mbps 26 @ 6Mbps 2 U.FL 6 Mbps -90dBm ag 0.8
SR5 a - 26 @ 6-24Mbps 1 U.FL y 1 MMCX 6 Mbps -94 dBm 1.3

12 Mbps -91 dBm
XR2 g 28 @ 1-24Mbps - 1 U.FL y 1 MMCX 6 Mbps -94 dBm 1.3

12 Mbps -91 dBm
XR5 a - 28 @ 6-24Mbps 1 U.FL y 1 MMCX 6 Mbps -94 dBm 1.8

12 Mbps -91 dBm
EMP ag 27 @ 6-24Mbps 22 @ 6-24Mbps 2 U.FL 6 Mbps -90 dBm a 1

-8602+S 6 Mbps -92 dBm g
WLM54A a - 26 @ 6-24Mbps 1 U.FL y 1 MMCX 6 Mbps -90 dBm a 1.5
-26dbm
WLM54G g 30 @ 6-24Mbps - 1 U.FL y 1 MCX 6 Mbps -90 dBm g 1.5
-6B-30

Cuadro B.2: Comparación de tarjetas inalámbricas para Wi-Fi de larga distancia.
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C
Pruebas de Campo para placas MIKROTIK

C.1. Ejecución del protocolo de pruebas. Placas MIKROTIK

[3] Protocolo de pruebas de las placas MIKROTIK usando una PC con Linux:

1. Acceder como superusuario:
#sudo su

2. Acceso al routeboard:

- Acceso por ssh:
root@lima:∼#ifconfig eth0 10.10.30.5 netmask 255.255.255.0

root@lima:∼#route add default gw 10.10.30.1

root@lima:∼# ssh admin@10.10.30.1

[admin@hregional-mw1] > quit

- Acceso por serial:
root@lima:∼# chmod 777 /dev/ttyUSB0

root@lima:∼# cu -l /dev/ttyUSB0 -s 115200

user: admin

3. Hacer ping (al �nal sale la estadistica):

[admin@MikroTik] > ping 10.10.30.1 count=20

20 packets transmitted, 20 packets received, 0 % packet loss round-trip min/avg/max

= 1/1.0/1 ms

4. Ver las IP de las interfaces:

[admin@MikroTik] > ip address print

5. Veri�cación de las intefaces si están o no activas:

[admin@MikroTik] > interface print

6. Ver las MAC de cada interfaces de red, las ethernet y las inalambricas:
[admin@MikroTik] > interface ethernet print

[admin@MikroTik] > interface wireless print
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7. Con�gurar las interfaces inalámbricas:
[admin@MikroTik] > interface wireless set wlan1

Al seleccionar mode=ap/sta cambiamos de AP a STA.

8. Para habilitar servicios como ftp, ssh, telnet, se activa con la opcion enable:
[admin@MikroTik] > /ip service disable ftp

9. Veri�car las seguridad wireless, su tipo y las claves:
[admin@MikroTik] > /interface wireless security-profiles print

10. Hacer un respaldo (backup) de la con�guración:
[admin@nodob] > system backup save name=backup-hregional-21n2

Para ver el archivo backup-hregional-21n2.backup:
[admin@nodob] > file print

Restaurando una con�guración previamente subida al equipo:
[admin@nodob] > system backup load name=backup-nodoc.backup

Restore and reboot? [y/N]:

Desde una PC externa a la routerboard se conecta por ftp para guardar el backup en la
PC o subir un backup al routerboard.

root@laptop:∼# ftp 11.11.11.1

Connected to 11.11.11.1.

Name (11.11.11.1:gtr-rvr): admin

Password:

- Para guardar el backup:
ftp> binary

ftp> get backup-nodoc.backup

ftp> quit

- Para subir un backup:
ftp> binary

ftp> put backup-nodoc.backup

ftp> quit

Si son varios archivos se puede usar mget o mput respectivamente.

C.1.1. Pruebas de nivel de señal de los radioenlaces. Placas MIKROTIK

1. Para escanear las redes inalambricas:

[admin@MikroTik] > interface wireless scan wlan1

Únicamente es posible actuando como estación cliente, nunca como AP.

2. Observar los parametros Wi-Fi como como nivel de recepcion, ruido, y la calidad del enlace:
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[admin@nodoa] > interface wireless monitor wlan1

El monitoreo se puede realizar únicamente como estación cliente, nunca como AP.

3. Ver la recepción de la señal desde un AP:

[admin@nodoa] > interface wireless registration-table print

El comando se re�ere a:
Interface wireless: Opera usando el grupo de estándares IEEE 802.11.
Registration-table: Información sobre los clientes actualmente conectados.
print: Ver redes inalámbricas.

Los resultados que se obtienen son:
# interface (read-only): Número de la interfaz a la cual está registrado el cliente.
radio-name: Nombre descriptivo de la tarjeta.
mac-address (read-only): Dirección MAC de la tarjeta inalámbrica transmisora.
AP (read-only): Si el dispositivo conectado es un AP o no.
signal-strength (read-only): Potencia media de la de la señal recibida en el cliente enviada
por el AP.
tx-rate (read-only): Tasa de transmisión de datos.
uptime (read-only): Tiempo en el que el cliente está asociado con el AP.

C.1.2. Pruebas de ancho de banda. Placas MIKROTIK

1. Prueba de rendimiento, empleando la MIKROTIK (dos tipos con protocol=udp y proto-
col=tcp, la IP es la del equipo remoto):

[admin@MikroTik] > tool bandwidth-test 10.10.30.1 user=admin

password=************ protocol=udp duration=60

bandwidth-test: Puede ser usado para monitorear el rendimiento sólo para un router re-
moto Mikro Tik y de ese modo ayudar a descubrir cuellos de botella de la red.

El test TCP usa el protocolo TCP estándar con acuse de recibo y sigue el algoritmo TCP
sobre cuantos paquetes a enviar de acuerdo con la latencia, paquetes perdidos y otras
características del algoritmo TCP. Las estadísticas del rendimiento son calculadas usando
el tamaño total del paquete TCP. Como los acuses de recibo son un trabajo interno para
TCP, su tamaño y uso de la conexión no está incluida en las estadísticas del rendimiento.
Por lo tanto estas estadísticas no son tan �ables como las de UDP cuando estimamos el
rendimiento.

El test UDP envía 110% o más paquetes de los que actualmente son reportados como
recibidos en el otro lado del enlace. Para ver el máximo rendimiento de un enlace, el
tamaño del paquete se debe �jar al máximo MTU permitido por el enlace, normalmente
1500 bytes. UDP no requiere acuse de recibo, esta implementación signi�ca que se puede
ver la aproximación más cercana.

Los resultados del test son:
duration: Duración del test (s).
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rx-current: Ancho de banda actual que se recibe (Mbps).
rx-10-second-average: Media del ancho de banda recibido en los últimos 10 segundos
(Mbps).
rx-total-average: Media total del ancho de banda (Mbps).
lost-packets: Paquetes perdidos.
random-data: Datos aleatorios.
direction: Dirección del test (receive/transmit/both) rx-size: Tamaño de la recepción.
status: Estado del test.
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D
Pruebas de Campo para placas ALIX

D.1. Ejecución del protocolo de pruebas. Placas ALIX

[3]

1. Se utiliza el comando iwcon�g, que nos dará la información de cómo está con�gurada la
tarjeta inalámbrica:

nombren2:∼# iwconfig ath0

nombren1:∼# iwconfig ath1

Si en los nodos Managed se observa la MAC del AP, con esto se puede asegurar que existe
enlace entre el STA y el AP. Además con el resultado de ésta información se debe veri-
�car el nombre la red Wi-Fi, el canal, la potencia con�gurada, la velocidad máxima, y la
seguridad apoyada de otros archivos.

Con dicho comando se obtienen los siguentes datos:
Essid: Nombre de la red.
Nickname: Nombre de la estación.
Mode: Modo de operación del dispositivo, depende de la topología de red. Managed (nodo
conectado a una red compuesta por varios AP), Master (el nodo actúa como AP).
Frequency: Frecuencia en GHz.
Access Point: Dirección del AP.
Bit Rate: Tasa de bit (Mb/s).
Tx-Power: Potencia de transmisión (dBm).
Sensibility: Umbral de sensibilidad. El menor nivel de señal que el HW puede considerar
que recibe paquetes útiles.
Retry: Número de retransmisiones.
RTS thr: Umbral RTS. RTS añade un handshake antes de cada transmisión de paque-
tes para asegurarse que el canal está desocupado. Esto provoca sobrecarga pero mejora el
rendimiento en el caso de nodos ocultos o un gran número de nodos activos. Este parámetro
se re�ere al menor tamaño de paquete para el que el nodo envía RTS.
Fragment thr: Umbral de fragmentación. La fragmentación permite dividir un paquete IP
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en una ráfaga de menores fragmentos. En la mayor parte de los casos esto provoca so-
brecarga, pero en un entorno con mucho ruido reduce el error y permite que los paquetes
pasar a través de las ráfagas interferentes. Este parámetro se re�ere al máximo tamaño de
fragmento.
Encryption key: Clave de encriptación y cifrado y modo de seguridad. Dígitos hexadeci-
males.
Security Mode: Modo de seguridad (open/restricted).
Power Management: Administración de potencia.
Link Quality: Calidad de la conexión (Nivel de capacidad de acceso o interferencia, la tasa
de error de bit o de trama, cómo de buena es la señal recibida,...).
Signal level: Potencia de la señal recibida (cómo de fuerte es la señal recibida).
Noise level: Nivel de ruido de fondo (cuando no se transmiten paquetes).
Rx invalid nwid: Número de paquetes recibidos con un NWID o ESSID diferentes. Usado
para detectar problemas de con�guración o la existencia de una red contigua (en la misma
frecuencia).
Rx invalid crypt: Número de paquetes que el hardware no puede desencriptar. Puede ser
usado para detectar ajustes de encriptación inválidos.
Rx invalid frag: Número de paquetes para los cuales el HW no es capaz de reensamblar
correctamente los fragmentos de la capa de enlace (lo más seguro es que uno se perdió).
Tx excessive retries: Número de paquetes que el hardware falló en la entrega. La mayoría
de los protocolos MAC reintentarán el envío del paquete un número de veces antes de
abandonar.
Invalid misc: Otros paquetes perdidos en relación con funcionamiento inalámbrico especí-
�co.
Missed beacon: Número de tramas periódicas perdidas de la celda al AP. Las tramas son
enviadas en intervalos regular para mantener la coordinación de la celda, un fallo en la
recepción suele indicar que la tarjeta está sin señal.

2. Con el siguiente comando se observará las potencias con�gurables en las tarjetas inalám-
bricas.

nombren2:∼# iwlist ath0 txpower

3. Se debe veri�car los parámetros TCP/IP de cada interfaz de red. La IP y la máscara de
red se observa con el comando ifcon�g:

nodo-a: # ifconfig ath0

nodo-a: # ifconfig ath1

4. Ping normal entre las interfaces del enlace.
Se prueba la conectividad con el comando ping. Además de observar si la otra interfaz
responde al ping; se debe observar la regularidad de los ping y la pérdida de paquetes.
Para esta prueba se debe hacer un ping de unos 30 paquetes y por cada AP - STA del
enlace.

El resultado de los ping esta relacionados con la distancia del enlace y con nivel y calidad
de la señal.

voyage: # ping 11.11.11.1 -c 40
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Si se obtiene resultados muy alejados de lo aceptable; se debe cambiar la distancia; cam-
biando en pasos de 100m hasta encontrar el más óptimo.

Un ping con mayor bytes transmitidos muestra una aproximación de la carga que puede
soportar el enlace; esto se observa en la regularidad del tiempo de transmisión de paquetes
y la pérdida de éstos. La pérdida de paquetes debe ser muy baja o casi nula comparada
con la cantidad que se está enviando en total.

voyage: # ping 11.11.11.1 -c 50 -s 1500

En este ejemplo se transmiten 1500 bytes.

5. Veri�cación de la tabla de rutas y la ruta de salida.
Se debe revisar que las redes a las que se desea acceder estén en la tabla de rutas de los
equipos que conforman el enlace; además de la ruta por defecto si se ha con�gurado. En
la tabla se observa las redes accesibles y no los equipos accesibles; para esto se usa, el
comando route, con él se pueden ver las redes accesibles (Flag con UG) inclusive si se está
usando OSPF.

nodo-b: # route -n

Los resultados que se obtienen son destination, gateway, genmask, �ags, metric, ref, use e
iface (interfaz).

Si se trabaja con enrutamiento dinámico las redes accesibles aparecerán en la tabla de
rutas; si alguno no aparece se debe comprobar; quizás el problema es que ciertos enlaces
estén caídos; para esto se puede usar traceroute.

nodo-b: # traceroute 10.1.4.2

Si se trabaja con enrutamiento estático necesariamente se debe comprobar el acceso a la
red con el comando traceroute para veri�car que la red es accesible. Si el equipo tiene
salida a Internet se debe comprobar:

nodo-b: # ping www.google.com -c 5

6. Ping a todas las interfaces de red.
Una vez revisado las rutas, se debe hacer ping (con una cantidad de 20 paquetes) desde
cada equipo que conforma el enlace hacia el resto de las interfaces de la red y observar si a
todos se llega correctamente o no. Anotar además posibles retardos o pérdida de paquetes
hacia una interfaz en particular para su revisión posterior cuando se esté en ese nodo.

7. Conectividad en una red troncal.
Para comprobar esta conectividad se hace ping desde uno de los extremos de la troncal
hacia el resto de las interfaces de la red y observar si a todos se llega correctamente o no
y se mide el rendimiento de la troncal. Se recomienda realizar la prueba del rendimiento
con el iperf con un tiempo total de unos 50s a más.
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D.1.1. Pruebas de nivel de señal de los radioenlaces. Placas ALIX

1. Para escanear los AP desde un STA:

nodo-b: # iwlist ath0 scan

Entre los resultados que se obtienen están:
ESSID: Nombre de la red.
Mode: Modo (Master/Managed).
Frequency y channel: Frecuencia y canal en el que está trabajando.
Signal level: Nivel de señal (dBm). En largas distancias se puede asumir que se debe lograr
un nivel de entre -65dBm y -75dBm
Quality: Calidad. En largas distancias se debe lograr una calidad de unos 20dB.

2. Cantidad de clientes conectados al AP.
Según el diseño se debe comprobar que todos los clientes estén conectados al AP.

voyage: # cat /proc/net/Madwifi/ath0/associated_sta

D.1.2. Pruebas de ancho de banda. Placas ALIX

1. Medida de ancho de banda y rendimiento de una conexión entre dos hosts, empleando una
ALIX.

Esta prueba está relacionada directamente con la distancia con�gurada. Tenga en cuenta la
relación que existe entre el nivel de ruido y la velocidad con�gurada. Se recomienda realizar
la prueba por unos 50s a más y por cada AP - STA del enlace y anotar el rendimiento por
cada intervalo de tiempo de la prueba y el rendimiento promedio al �nalizar la prueba.

Se utiliza el comando iperf, se trata de una herramienta cliente-servidor, por lo que hay
que ejecutar iperf en dos máquinas, una hará de cliente y otra de servidor.

nombren2:∼# iperf -s

nombren1:∼# iperf -c eth0-n2 -t 60 -i 5

iperf -s: Ejecuta iperf como servidor. Se encuentra a la escucha en el puerto2.
iperf -c eth0-n2: Ejecuta iperf como cliente. Se conecta con el servidor (eth0-n2) y se envían
una serie de paquetes para calcular el ancho de banda en la conexión. Se pueden utilizar
parámetros como por ejemplo -t 60 -i 5, para ajustar la duración de la transmisión en 60
segundos, en intervalos de 5 segundos.

Otros parámetros que se pueden emplear como servidor son:
-D como servicio.
-R remover servicio.
-u recibir datagramas UDP, en vez de TCP por defecto.
-P x número de conexiones simultáneas.
-m muestra MTU (depende del sistema operativo).
-w especi�ca el tamaño de ventana (TCP). Muy útil para ir calculando nuestro tamaño de
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ventana más óptimo según las mediciones de ancho de banda.
-f[bkmBKB] mostrar resultados en bits/s, kilobits/s, megabytes/s, Bytes/s, KiloBytes/s,
MegaBytes/s (s=segundos).

Otros parámetros que se pueden utilizar como cliente:
-i segundos especi�ca un intervalo, medido en segundos, en el cual se volverá a realizar la
medición.
-t segundos tiempo duración transmisión. Hace más �able la medida.
-T ttl especi�ca valor TTL.
-p especi�ca puerto en el que escucha el servidor.
-m muestra MTU (depende del sistema operativo).
-u envío de UDP en vez de TCP por defecto. Podemos medir también pérdida de paquetes.
-w (lo mismo que para servidor).
-f[bkmBKB] (igual que lo comentado como servidor).
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E
Software

E.1. Sistema Operativo Linux Voyage

Sitio web: http://www.voyage.hk/. [3]

- Basado en la distribución Debian Sarge r3.1/Etch r4.0/Lenny r5.0, tomando solo las apli-
caciones necesarias. Está optimizada para plataformas x86 de propósito especí�co tales
como las placas de PC Engines ALIX/WRAP o las de Soekris 45xx/48xx.

- La instalación típica requiere un espacio en disco de 128MB, aunque una mayor capacidad
de almacenamiento permite que se puedan instalar otros paquetes adicionales.

- La capacidad del sistema se puede incrementar de acuerdo a las necesidades por medio del
manejo de la aplicación apt.

- Kernel Linux 2.6.

- Total soporte para placas PC Engines ALIX/WRAP.

- Soporte Wi-Fi.

- Soporte para diversos drivers de redes inalámbricas como madwi�, hostap, prism54, etc.

- Soporte WPA vía hostapd y wpa_supplicant.

- Soporte WDS vía drivers hostap y madwi�.

- Adecuado para ejecutarlo con características como �rewall, access point inalámbrico, gate-
way de VoIP, etc.

- No contiene todas las aplicaciones para implementar redes de datos; contiene sólo lo básico;
como los controladores para el manejo de las interfaces Ethernet y para el manejo de las
interfaces inalámbricas en base a chipset Atheros.

E.1.1. Voyage GTR

El GTR-PUCP ha adaptado Voyage 0.5.2 para la implementación de enlaces inalámbricos
Wi-Fi de larga distancia. A esta Voyage, más sus aplicaciones adaptadas se le llama Voyage GTR
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que puede descargarse desde este enlace: http://gtr.telecom.pucp.edu.pe/webfm_send/987.

Un router de larga distancia debe contener ciertas aplicaciones para poder implementar redes
Wi-Fi de larga distancia; a Voyage le faltaría implementar:

- Con�guración rápida y cómoda de las interfaces de red.

- Enrutamiento estático, NAT y DHCP.

- Implementar seguridad WPA-PSK.

- Enrutamiento dinámico.

- Telefonía IP.

- Con�guración vía web.

Estas características se ha implementado en Voyage GTR, pero además se ha tenido cuidado
en que todas estas aplicaciones trabajen conjuntamente y que Voyage GTR tenga las herramien-
tas necesarias para su trabajo en entornos rurales. Estas herramientas son:

- Administración de la memoria y del espacio de disco.

- Conservación y borrado de registros de sistema (logs).

- Creación de archivos de respaldo.

- Apagado, reinicio y conservación de fecha.

E.1.2. Instalación y con�guración de Voyage GTR

- Instalación de Voyage GTR.
Para instalar Voyage GTR en una Compact Flash (CF) se introduce la memoria CF en el
lector/grabadora de memorias USB y se conecta a una PC con Linux y se ejecuta el script
de instalación. Para la instalación se recomienda trabajar como usuario root en la PC; se
debe obtener la versión de Voyage GTR junto al script que permite su grabado; ambos se
podrían guardar en la carpeta /root/. Ahora se ejecuta el script que permite el grabado
de Voyage GTR.

root@gtrdesktop: # bash grabar-voyage-gtr

Si no se muestra ningún tipo de error o advertencia se puede dar por �nalizada la grabación
y se puede extraer la CF y desconectar la lectora/grabadora del puerto USB.

- Acceso inicial por puerto serial o por Ethernet.
Una vez instalado Voyage en la CF, ésta se coloca en la placa ALIX y se procede al acceso;
para esto se usará una PC con Linux y un cable serial nulo; será necesario un adaptador
serial-USB si la PC carece de puerto serial. Sin encender la placa ALIX, se procede a
conectar el cable serial a la PC y a la placa ALIX; en un terminal, como administrador,
se ejecuta los siguientes comandos:

Con puerto serial:
# chmod 777 /dev/ttyS0

# cu -l /dev/ttyS0 -s 38400
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Con puerto serial y adaptador serial-USB:
# chmod 777 /dev/ttyUSB0

# cu -l /dev/ttyUSB0 -s 38400

Al energizar la placa ALIX, en el terminal se podrá observar como se carga Voyage Linux
hasta que se pida el ingreso del usuario y la contraseña; por defecto el usuario es root y
la contraseña es voyage. El uso del puerto serial es muy importante porque nos permite
ingresar a los equipos sin usar sus interfaces de red y en caso de fallas para observar los
problemas en el equipo. El puerto Ethernet eth0 de la placa esta con�gurado por defecto
con la IP 11.11.11.1/24; por lo cual en un inicio se puede ingresar por este puerto con ssh.
Para ingresar se usará un cable cruzado y una vez que la placa este encendida y cargado
el sistema operativo (alrededor de un minuto) se puede hacer:

# ssh root@11.11.11.1

Después de esto se pedirá el ingreso de la clave, en éste caso inicial será voyage.

- Edición de archivos.
La partición donde se instala Voyage GTR inicialmente carga en modo lectura.

voyage: # mount

Para editar los archivos y carpetas se debe pasar el sistema al modo escritura.

voyage: # remountrw

Cuando acabe se debe regresar el sistema al modo escritura.

voyage: # remountro

- Guardar archivos o carpetas de /rw.
Todo lo modi�cado o creado en /rw se perderá después de un reinicio; pero existe la posi-
bilidad de guardar estas modi�caciones; en el archivo /etc/voyage.conf, especí�camente
en la variable VOYAGE_SYSTEM_ SYNCDIRS se indica que carpeta o carpetas (por
ende su contenido) se desea guardar; en la variable VOYAGE_ SYSTEM_ SYNCFILES
se indica que archivo o archivos se desea guardar. Debe descomentar estas variables si se
van a usar.

Una vez que reinicia el equipo todo el contenido de las carpetas o archivos seleccionados
para guardar se guardarán, incluyendo su contenido, en /ro; cuando el sistema cargue des-
pués del reinicio, en /rw estará lo guardado.

voyage: # cat /etc/voyage.conf

#

# This file generated automatically by copyfiles.sh

# on Tue Jul 15 15:40:18 PET 2008

#

VOYAGE_ PROFILE=ALIX

VOYAGE_ SYSTEM_ CONSOLE=serial

# VOYAGE_ SYSTEM_ SYNCDIRS=/var/log�

# VOYAGE_ SYSTEM_ SYNCFILES=/var/log/syslog /var/log/kern.log�

VOYAGE_ SYSTEM_ SERIAL=38400

VOYAGE_ SYSTEM_ PCMCIA=no

VOYAGE_ SYSTEM_ MODULES=�lm90; w83627hf; scx200_ acb base=0x810,0x820; geodewdt;

led-class; leds-alix; ledtrig-heartbeat; ledtrig-timer�
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SYSTEM_ BOOTSTRAP=grub

Si ya no se desea seguir guardando, se comentan de nuevo las variables.

- Con�guración previa a cualquier aplicación en Voyage GTR.
Dar nombre al equipo, editar /etc/hostname; el nombre del equipo no debe contener puntos
ni espacios en blanco o caracteres extraños.

voyage: # cat /etc/hostname

Dar una clave al sistema.

voyage: # passwd

Si el equipo no va a ser un servidor de tiempo, se puede indicar un servidor o servidores
NTP editando la variable NTPSERVERS.

voyage: # cat /etc/default/ntpdate

...

# NTPSERVERS=�0.debian.pool.ntp.org 1.debian.pool.ntp.org 2.debian.pool.ntp.org

3.debian.pool.ntp.org�

NTPSERVERS=�200.16.6.80�

...

Con�gurar el reinicio del equipo; editar el archivo /etc/cron.d/reboot-board y descomentar
la opción de reinicio aleatorio de entre las 4 y 4:30 horas cada sábado o reinicio a las 4
horas todos los días. También se puede con�gurar uno particular.

voyage: # cat /etc/cron.d/reboot-board

- Obtención de respaldo de la con�guración de las aplicaciones en Voyage GTR.
Para sacar un respaldo de la con�guración hecha en Voyage GTR se debe indicar que archi-
vo o carpeta se debe respaldar; esto se indica en el archivo de con�guración /etc/backup.list;
originalmente éste archivo contiene una lista de los archivos y/o carpetas que deberían ser
respaldados; si en esta lista no se encuentra una carpeta o archivo en particular se adiciona
línea por línea. Después se ejecuta el script mgbackup con la opción backup:

red-sur: # mgbackup backup

Si no se muestra error en la creación del respaldo, se creará en /opt un archivo comprimido
con el nombre del equipo. La opción Archivos de con�guración mostrada al ejecutar el script
que permite el grabado de Voyage GTR en la CF, se utilizará para indicar el archivo de
respaldo que se copiará en esta grabación de Voyage GTR; es decir Voyage GTR que se
obtendrá aquí será idéntica en con�guración de Voyage GTR de donde se sacó el respaldo.

- Veri�cación del espacio ocupado y disponible.
Dependiendo del tipo de router se debe observar el espacio disponible en el disco total y
en las particiones críticas. Normalmente es necesario que se tenga al menos la mitad de
espacio disponible en cada partición, si se tiene ocupando más de la mitad, se debe eliminar
archivos innecesarios y vigilar. Anotar el espacio ocupado y disponible de las particiones
críticas del equipo.

En el router GTR se tiene dos particiones críticas que son la /ro y /rw.

voyage: # df -l
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Filesystem 1K-blocks Used Available Use % Mounted on

rootfs 998808 272816 675256 29 % /

udev 10240 20 10220 1 % /dev

/dev/disk/by-label/ROOT_ FS

998808 272816 675256 29 % /

/dev/disk/by-label/ROOT_ FS

998808 272816 675256 29 % /dev/.static/dev

tmpfs 63384 0 63384 0 % /lib/init/rw

tmpfs 63384 0 63384 0 % /dev/shm

tmpfs 32768 664 32104 3 % /rw

- Veri�cación del espacio de RAM libre y de CPU desocupado en un instante.
Esto dará una idea de cuanta RAM o CPU se está usando en el equipo para prevenir un
uso excesivo de los recursos del sistema. Si se tiene un uso alto se debe seguir vigilando
para asegurarse que quizás sólo sea un instante donde muchas aplicaciones estén con mu-
cho trabajo. El uso excesivo se da generalmente en pocos instantes y con poca duración,
en este instante se puede llegar a más de 60% de RAM y casi 100% de CPU; pero en el
resto del tiempo generalmente se debe tener un consumo de alrededor de 20% de RAM; y
el CPU debe estar casi en 90% si uso. Anotar el espacio de RAM libre en un instante de
trabajo normal y el de CPU desocupado en un instante de trabajo normal.

gtr-v106: # free

total used free shared buffers cached

Mem: 126768 47564 79204 0 2604 25148

-/+ buffers/cache: 19812 106956

Swap: 0 0 0

gtr-v106: # top

top - 15:01:42 up 10:43, 1 user, load average: 0.01, 0.02, 0.00

Tasks: 34 total, 1 running, 33 sleeping, 0 stopped, 0 zombie

Cpu(s): 1.3 % us, 1.0 % sy, 0.0 % ni, 95.4 % id, 0.0 % wa, 0.3 % hi, 2.0 % si, 0.0 % st

Mem: 126768k total, 68964k used, 57804k free, 2800k buffers

Swap: 0k total, 0k used, 0k free, 45956k cached

...

- Veri�ciación de la fecha del sistema y del último reinicio.
Tomar la fecha del sistema para saber si está sincronizando o no con el servidor de tiempo.
Se recomienda que esté sincronizado; si no lo está por motivos de red se podría �jar la
fecha manualmente. Además se debe evaluar el correcto reinicio programado del router, se
puede evaluar observando el último reinicio del equipo. Anotar la fecha del sistema y la
fecha del último reinicio del sistema.

gtr-v106: # date

Fri May 8 15:05:18 PET 2009

gtr-v106: # date -set �05/11/09 14:51�

voyage: # uptime

14:29:10 up 10:10, 1 user, load average: 0.00, 0.00, 0.00
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E.1.3. Con�guración de Redes con Voyage GTR

- Con�guración de las interfaces de red.
Para empezar a con�gurar las interfaces de red se debe asegurar que el sistema reconozca
los dispositivos; para esto se puede hacer:

voyage: # lspci

Además se debe asegurar que el sistema disponga de los controladores para estos dis-
positivos, aunque esto ya se ha hecho al implementar Voyage Gtr; se puede observar en
/var/log/syslog una vez que el sistema este cargado.

voyage: # cat /var/log/syslog |grep wifi

voyage: # cat /var/log/syslog |grep eth

Los archivos de con�guración están editados con una plantilla que se puede modi�car o adi-
cionar. En el archivo /etc/network/interfaces se especi�ca la con�guración de las interfaces
de red. En este archivo no se pone la ruta por defecto, eso se hará en /etc/network/natstatic-
routes.

o Con�guración de Ethernet y de Bridge Ethernet.
Para con�gurar las interfaces Ethernet se descomenta las líneas correspondientes y se
cambiará la IP/Máscara de red si es necesario.

auto eth0

iface eth0 inet static

address 10.10.10.1

netmask 255.255.255.240

#auto eth1

#iface eth1 inet static

#address 11.11.11.1

#netmask 255.255.255.0

Si se desea crear bridge, sólo se podrá hacer entre las Ethernet; se debe descomentar
el bloque del bridge y poner la IP/Máscara de red; además la con�guración de las
interfaces involucradas deben ser comentadas.

auto br0

iface br0 inet static

address 11.11.10.1

netmask 255.255.255.0

bridge_ports eth0 eth1

bridge_stp off

bridge_maxwait 5

o Con�guración de las interfaces Wi-Fi.
Se debe elegir si es AP ó STA, con�gurar los parámetros Wi-Fi, establecer seguridad
y con�gurar de la IP/MASK.

Si es AP se descomenta las líneas:
#�ap
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ath_parent wifi0

ath_vaptype ap

Si es STA se descomenta las líneas:
#�cliente

ath_parent wifi0

ath_vaptype sta

#ath_vapopts nosbeacon

Sólo en el caso de que en una placa se mezclen AP y STA la línea #ath_vapopts

nosbeacon del STA deberá ser descomentada.

Algunos parámetros Wi-Fi son obligatorios, se cambiará de valor según sea necesario.

#�otros parametros wifi

ath_distance 19800 (metros) cada interfaz de un mismo enlace de-

be estar configurado con la misma distancia;

si se tiene varios STA se coloca la distancia

más larga entre el AP y el STA (NOB).

ath_diversity 0 puede ser 1 habilitado o 0 deshabilitado (NOB)

ath_txantenna 1 puede ser 1 o 2; se refiere al conector de la

tarjeta inalámbrica donde será conectado la

antena para transmitir; si ath_diversity es 1

no interesa su valor

ath_rxantenna 1 puede ser 1 o 2; si ath_diversity es 1 no intere-

sa su valor

ath_txpower 23 está dado dBm, si se pone debe ser un valor

valido, puede ser de 0 a 30, se debe conocer

antes según la tarjeta inalámbrica (NOB)

ath_wirelessmode 11g puede ser 11a o 11g (OB)

ath_ssid EHAS1 nombre de la red (OB)

ath_channel 11 puede ser 1 al 11 en 2.4GHz o 36 al 160 en

5.8GHz (OB si es AP)

ath_rate 9M puede ser 6M, 9M, 12M ... 54M (NOB)

(NOB: no obligatorio, OB: obligatorio)

Para la seguridad; se puede elegir si se usa WEP o WPA-PSK; si se usa WEP aquí
se pone la clave que debe ser en hexadecimal; si se usa WPA2-PSK se descomenta el
bloque respectivo si es STA o AP; y se debe editar el archivo mencionado donde se
cambiara el nombre de la red y la clave WPA2-PSK.

Si se usa WEP; se habilita y además se con�gura la clave; se elige 10 números hexa-
decimales (WEP de 64b) o 26 (WEP de 128b).

#�seguridad wep

ath_security wep

ath_wep_key1 12345ABCDE

Si se usa WPA2-PSK en una AP se habilita:

#�seguridad wpa-psk ap

ath_security wpa2

ath_wpa_cfgfile /etc/hostapd/hostapd-ath0.conf

APÉNDICE E. SOFTWARE 111



Guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú

Si se usa WPA2-PSK en una STA se habilita:

#�seguridad wpa-psk sta

wpa_driver madwifi

wpa_conf /etc/wpa_supplicant/wpasupplicant-ath0.conf

Por último se con�gura la IP y la Máscara de red de la interfaz.

#�ip y netmask

address 10.10.1.2

netmask 255.255.255.240

Si se ha elegido seguridad WPA2-PSK además de habilitar las opciones se debe editar
los archivos adicionales; donde sólo se cambiará el nombre de la red y la clave WPA2-
PSK (en caracteres y debe ser desde 8 a 63 caracteres). Existe un archivo plantilla
para cada interfaz dependiendo si es STA o AP.

Si se está con�gurando un cliente que es ath0 entonces se edita /etc/wpa_supplicant/
wpasupplicant-ath0.conf y se cambia el ESSID y la clave WPA2-PSK.

...

ssid=�LOCAL0�

scan_ssid=1

...

priority=10

psk=�gtrcaswifi�

#psk=70df87c28aee0e42b49f55450df0f822200933ff3968406176fbcd41eb9a8a72

Si se esta con�gurando un AP que es ath2 entonces se edita /etc/hostapd/hostapd-
ath2.conf y se cambia el ESSID y la clave WPA2-PSK.

...

ssid=LOCAL2

...

wpa_passphrase=gtrcaswifi

Para activar los cambios realizados se ejecuta /etc/init.d/networking restart además
se actualiza la con�guración hecha /etc/network/statics-routes-nat.

- Con�guración del enrutamiento estático, gateway y NAT.
Para poner en la ruta por defecto, NAT o rutas estáticas se usa el archivo /etc/network/nat-
static-routes, donde se encuentran variables que serán habilitadas según el uso. Si el equipo
debe tener una ruta por defecto se habilita la variable DEFAULT_GW, y se pone la di-
rección IP de la ruta por defecto (gateway).

DEFAULT_GW=�10.13.1.2�

Si se desea adicionar rutas estático se habilitando la variable ROUTEX (donde X es
1,2,3...100) y en cada una se pone la red, la máscara de red y la salida por donde se
accederá a esta red; además se pone la métrica.

ROUTE1=�10.14.1.0/28 10.13.1.2 1�
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Si se adiciona otra ruta se van adicionando variables numeradas. Esta limitado hasta 100
variables.

Para NAT sólo se optará por habilitar o no habilitar; si se habilita se descomenta la vari-
able DEFAULT_NAT y se elige la interfaz que hará de NAT en el equipo.

DEFAULT_NAT= �eth1�

Al ejecutar /etc/init.d/networking restart se actualiza la con�guración hecha en
/etc/network/interfaces y en /etc/network/statics-routes-nat.

Si se va a usar OSPF, se recomienda con�gurar las rutas estáticas en zebra.conf y no
hacerlo en este archivo.

- Con�guración del enrutamiento dinámico con OSPF.
Para ver los archivos usados en el enrutamiento con OSPF se utiliza:

curco-2n2:/etc/quagga# ls

En /etc/quagga/daemons se pone en yes si se desea usar OSPF.

En zebra.conf; antes de todo se pone un nombre que podría ser el mismo que en ospfd.conf.

Hostname ospf-voyage

Se habilita las interfaces involucradas en el enrutamiento; se descomenta el bloque respec-
tivo. Además se puede cambiar el ancho de banda, por defecto esta en 10MB.

interface ath0

bandwidth 10000000

ipv6 nd suppress-ra

Si este equipo pertenece a una red OSPF y está conectado a un equipo vecino que no
pertenece a una red OSPF y además existe redes detrás de este equipo vecino; entonces si
se quiere que la red OSPF acceda a éstas redes; entonces en éste archivo de debe especi�car
la ruta para llegar a esa red indicando por donde se llegaría y además de la distancia. En
resumen se está adicionando rutas estáticas en una red OSPF.

ip route 10.14.1.0/28 10.13.1.2 1

Si hay más redes se debe adicionar más líneas de estas.

Aquí también se puede poner la ruta por defecto del equipo; pero será mejor hacerlo en
/etc/network/nat-static-routes.

Para la con�guración en si del OSPF se edita el archivo /etc/quagga/ospfd.conf. Se pone
un nombre.

hostname ospf-voyage
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Se debe habilitar las interfaces involucradas descomentando los bloques respectivos; además
se debe poner un costo (valor entero), para que no se use el ancho de banda con�gurado
en zebra.conf.

interface ath2

ip ospf cost 10

Ahora se debe especi�car el identi�cador del equipo en la red OSPF, es importante este
valor y debe ser distinto en la red OSPF (al menos en una misma área).

ospf router-id 0.0.1.2

Ahora se debe poner las redes locales involucradas en la red OSPF; indicando Red/Máscara
y el área al cual pertenece.

network 10.10.1.0/28 area 0.0.0.0

network 10.10.2.0/28 area 0.0.0.0

network 10.11.1.0/28 area 0.0.0.1

network 10.21.1.0/28 area 0.0.0.2

Si este equipo es el límite entre áreas OSPF se debe indicar las redes que están el área que
no sea el cero.

area 0.0.0.1 range 10.11.0.0/16

area 0.0.0.1 range 10.12.0.0/16

area 0.0.0.2 range 10.21.0.0/16

area 0.0.0.2 range 10.22.0.0/16

Si al equipo se le ha adicionado rutas estáticas (zebra.conf); entonces se debe especi�car
como se debe publicar estas rutas a la red OSPF; para esto se descomenta la siguiente
línea especi�cando la métrica y el tipo; si no se desea publicar estas rutas estáticas se deja
comentada la línea.

redistribute static metric 10 metric-type 1

Si se ha con�gurado una puerta de salida equipo (/etc/network/nat-static-routes); en-
tonces se debe especi�car como se debe publicar en la red OSPF. Para esto se descomenta
una de las siguientes líneas:

default-information originate metric 10 metric-type 1

! default-information originate always metric 10 metric-type 1

La diferencia está en always; con éste los routers tendrán una ruta por defecto este con�-
gurado o no en el router que lo publica; sin always los routers tendrán una ruta por defecto
mientras este con�gurado en el router que lo publica.

Al ejecutar /etc/init.d/quagga stop y /etc/init.d/quagga start se actualiza los cambios del
enrutamiento. Si una vez que OSPF ya está trabajando se hace /ect/init.d/networking
restart lo del OSPF se perderá, para activar de nuevo se debe ejecutar /etc/init.d/quagga
restart.
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- Con�guración del DHCP.
Para habilitar el servicio en el arranque; se debe poner yes en la variable RUNDNSMASQ
en el archivo /etc/default/dnsmasq. El archivo de con�guración es /etc/dnsmasq.conf; en
este archivo se especi�ca:

1. La interfaz por donde se brindará este servicio.
interface=br0

2. El rango de IP (inicio-�nal) y la Máscara de red; además del tiempo de asignación de
la IP.
dhcp-range=192.168.114.7,192.168.114.14,255.255.255.240,24h

3. La ruta por defecto de los equipos clientes.
dhcp-option=3,192.168.114.1

Para completar se debe especi�car los DNS que usará este servicio; para esto se descomenta
los DNS en /etc/resolv.conf los que se necesite.
Para activar el servicio se ejecuta /etc/init.d/dnsmasq restart.

- Con�guración de interfaces Wi-Fi y de parámetros TCP/IP mediante comandos.

Crear la interfaz ath0 como AP:
nodo-a: # wlanconfig ath0 create wlandev wifi0 wlanmode ap

Crear la interfaz ath0 como STA:
nodo-a: # wlanconfig ath0 create wlandev wifi0 wlanmode sta

Activar la interfaz ath0:
nodo-a: # ifconfig ath0 up

Con�gurar al modo 802.11g a ath0 (3->g; 1->a, 2->b):
nodo-a: # iwpriv ath0 mode 3

Desactivar la diversidad y activar la RX y TX por el conector principal; para la ath0 (wi�0):

nodo-a: # echo 0 >/proc/sys/dev/wifi0/diversity

nodo-a: # echo 1 >/proc/sys/dev/wifi0/txantenna

nodo-a: # echo 1 >/proc/sys/dev/wifi0/rxantenna

Con�gurar el ESSID, canal, velocidad de TX, clave WEP de 64bits y limitar la potencia
de TX:
nodo-a: # iwconfig ath0 essid PUCP channel 11 rate 12M key aabbccddee txpower 10

Con�gurar la distancia (en metros) del enlace:
nodo-a: # athctrl -i wifi0 -d 1000

Con�gurar la IP/MASK de la interfaz ath0:
nodo-a: # ifconfig ath0 12.12.12.1 netmask 255.255.255.0

Con�gurar la IP/MASK de la interfaz eth0:
nodo-a: # ifconfig eth0 10.10.1.1 netmask 255.255.255.0
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Con�gurar la IP/MASK de la interfaz eth1:
nodo-a: # ifconfig eth1 192.168.1.2 netmask 255.255.255.0

Con�gurar una puerta de salida:
nodo-a: # route add default gw 192.168.1.1

Con�gurar una ruta:
nodo-a: # route add -net 10.10.2.0/24 gw 12.12.12.2 metric 10

Con�gurar NAT sobre eth1:
nodo-b: # iptables -t nat -A POSTROUTING -o eth1 -j

MASQUERADE

Si se desea con�gurar DNS se debe indicar en /etc/resolv.conf.

Si una interfaz está como STA y se desea pasar a modo AP (o al revés), antes se debe
deshabilitar la interfaz lógica creada, así:
nodo-a: # wlanconfig ath0 destroy

y después se creará la interfaz lógica:
nodo-a: # wlanconfig ath0 create wlandev wifi0 wlanmode ...

Para eliminar rutas no deseadas se puede hacer:
nodo: # route del -net 192.168.20.0/24 gw 10.10.1.2

Para anular toda entrada de la tabla NAT se hace:
nodo: # iptables -t nat -F

Se debe recordar que se está trabajando con comandos; después de un reinicio se perderá
la con�guración.

E.2. Software PBX Asterisk

[3] Asterisk es una aplicación de software libre (bajo licencia GPL) que proporciona fun-
cionalidades de una central telefónica (PBX). Se puede conectar un número determinado de
teléfonos para hacer llamadas entre sí e incluso conectar a proveedores de VoIP y de telefonía
convencional tanto analógica como digital. Originalmente desarrollado para el sistema operativo
GNU/Linux, Asterisk actualmente también se distribuye en versiones para los sistemas opera-
tivos BSD, MacOSX, Solaris y Microsoft Windows, aunque la plataforma nativa (GNU/Linux)
es la mejor soportada de todas.

Asterisk incluye muchas características como buzón de voz, conferencias, IVR, distribución
automática de llamadas, y otras muchas más tal como PBX comerciales. Los usuarios pueden
crear nuevas funcionalidades por medio de lenguaje script de Asterisk o añadiendo módulos es-
critos en cualquier lenguaje de programación soportado por Linux.

Las versiones estables de Asterisk están compuestas por los módulos siguientes:

- Asterisk: Archivos base del proyecto.
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- Zaptel: Soporte para hardware Digium. Drivers de tarjetas.

- Addons: Complementos y añadidos del paquete Asterisk.

- Libpri: Soporte para conexiones digitales.

- Sounds: Aporta sonidos y frases en diferentes idiomas.

Cada uno de estos módulos cuenta con una versión estable y una versión de desarrollo. Has-
ta ahora; las versiones desarrolladas son la 1.6 y la 1.4. Las versiones 1.2 y 1.0 se consideran
paralizadas y ya no se continuarán manteniendo. Actualmente la rama 1.4 es la aconsejada para
sistemas en producción.

La arquitectura de Asterisk está basada en 4 API:

- API de Canales Asterisk: controla el tipo de conexión por el cual el cliente está llegando
(bien sea una conexión SIP, H323, BRI, etc).

- API de Aplicaciones Asterisk: permite a varios módulos de tareas, cumplir varias funciones
(conferencias, buzones de voz, etc).

- API de Traducción de Codecs: carga módulos, codecs, para apoyar varios tipos de audio,
codi�cando y decodi�cando formatos tales como G711, G729, GSM11, etc.

- API de formato de �cheros Asterisk: controla la lectura y escritura de varios formatos de
archivos para el almacenaje de datos en el sistema de archivos.

Usando estas API Asterisk alcanza una completa abstracción entre sus funciones básicas y
las diferentes tecnologías y aplicaciones relacionadas.

Asterisk permite implementar los mismos servicios que una central clásica.

Asterisk tiene soporte para casi todos los codecs de audio como: G.711, G.723.1, G.726,
G.729, GSM, ilbc14, linear, lpc-1015, speex. Quizá lo más interesante de Asterisk es que soporta
muchos protocolos VoIP como pueden ser SIP, H.323, IAX y MGCP.

Asterisk permite integrar una red de telefonía IP con redes telefónicas tradicionales por medio
de interfaces analógicos y digitales. Para la conexión con líneas analógicas se hace a través de
dispositivos FXO y FXS. Para la conexión con líneas digitales RDSI se logra por medio de in-
terfaces del tipo BRI (2 canales de voz de + 1 de señalización) y PRI (30 canales de voz + 1 de
señalización).

Las interfaces de telefonía analógica se encuentran en múltiples dispositivos de redes (routers,
centrales de telefonía IP, etc.) que operan como acceso hacia los servicios de voz convencionales
como la telefonía pública.

E.2.1. Con�guración de una red de Telefonía IP con Asterisk

- Con�guración inicial.
Si se va ha usar Asterisk en un equipo donde exista OSPF se debe poner el nombre del
equipo también en /etc/hosts.

voyage: # cat /etc/hosts

127.0.0.1 localhost
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127.0.1.1 voyage

Para activar el servicio en el arranque del sistema se debe poner en yes la variable RUNAS-
TERISK en el archivo /etc/default/asterisk.

voyage: # vim /etc/default/asterisk

...

RUNASTERISK=yes

Es recomendable cargar el módulo ztdummy; descomentar en:

voyage: # cat /etc/modules

...

ledtrig-heartbeat

ledtrig-timer

#zaptel

#ztdummy

Esto permitirá que se cargue después de un reinicio; pero si se desea que se cargue en este
momento se puede hacer:

voyage: # modprobe ztdummy

El Asterisk en la Voyage, (/etc/asterisk/modules.conf), está adaptado para realizar tareas
mínimas, al ser un equipo de bajo rendimiento para este tipo de aplicación. Se ha desa-
rrollado una con�guración básica para realizar la comunicación entre clientes SIP de un
mismo Asterisk y con clientes SIP administrados por otros Asterisk y además permitir la
comunicación con la red de telefonía pública; esta con�guración involucra a los archivos
sip.conf, extensions.conf, y iax.conf, todos éstos ubicados en /etc/asterisk/. Se puede tomar
esta con�guración como plantilla para una con�guración particular.

- Con�guración de los clientes SIP.
El archivo /etc/asterisk/sip.conf tiene una con�guración inicial para clientes SIP; donde
se puede especi�car los identi�cadores del cliente y los codecs a usar.

[general]

;

bindport=5060

disallow=all

allow=ulaw

allow=g726aal2

allow=gsm

allow=ilbc

allow=g726

;

[210]

type=friend

host=dynamic

language=es

context=center

secret=passwd
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username=210

callerid=210

dtmfmode=rfc2833

qualify=yes

;

Para con�gurar clientes SIP con puerto FXO, se puede usar la identi�cación 10; cambiado
sólo lo necesario.

[10]

type=friend

port=5061

host=dynamic

language=es

context=center

secret=passwd

username=10

callerid=10

dtmfmode=rfc2833

qualify=yes

;

- Programación de las llamadas telefónicas.
En /etc/asterisk/extensions.conf es donde se con�gura la comunicación telefónica. En la
parte [globals] se especi�ca las variables usadas, aquí se muestra variables que representan
la IP de los otros Asterisk de la red.

[globals]

;

IP-SERVER200=

IP-SERVER300=20.20.20.13

IP-SERVER400=

IP-SERVER-PSTN=

PHONE-DEFAULT=

La variable PHONE-DEFAULT= contiene el teléfono que responderá por defecto después
de escuchar el IVR en una llamada proveniente del exterior. En la parte (center) se es-
peci�ca con que equipos se tendrá comunicación; está divido en: comunicación con equipos
locales, con equipos de otros Asterisk y con la telefonía pública. Aquí se muestra una es-
pecie de prueba de llamado al servidor, se especi�ca un número que identi�que al servidor
Asterisk.

;prueba de llamada al servidor

exten =>200,1,Macro(call-svlocal,200)

;

Aquí se especi�ca los números telefónicos locales.

;llamar area local

exten =>210,1,Macro(dial-svlocal,SIP,${EXTEN})

exten =>211,1,Macro(dial-svlocal,SIP,${EXTEN})

;exten =>_21[0-9],1,Macro(dial-svlocal,SIP,${EXTEN})
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Para comunicarse con otros servidores se especi�ca la numeración telefónica de estos, se
puede usar rangos como en este caso; además debe poner la IP del Asterisk que administra
este rango de números telefónicos; como se observa esto se hace en base a variables por
ejemplo IP-SERVER300 donde su valor estará en la sección de variables.

Para la comunicación con la telefonía pública se especi�ca los números permitidos; tenga
en cuenta que se debe diferenciar de los números telefónicos usados en la red; a veces se
usa un pre�jo; en este caso se antepone un cero, si se desea llamar al 147 sería 0147, si se
desea una comunicación sin restricción se puede usar _0.

En el cuadro de abajo se muestran los comandos para comunicarse con la telefonía públi-
ca para el Asterisk donde se va a registrar al cliente SIP que va ha conectar la telefonía
IP con la telefonía pública. En la primera parte se muestra los números permitidos para
llamar a la telefonía pública y la segunda parte se muestra al identi�cador 11 que se usará
para identi�car todas las llamadas entrantes de la telefonía pública; como se observa, están
redirigidas al IVR.

;llamar a clientes de otros servidores

exten =>_3[0-5]X,1,Macro(dial-svred, $IP-SERVER300, ${EXTEN})

exten =>_4XX,1,Macro(dial-svred, $IP-SERVER400, ${EXTEN})

En el cuadro de abajo se muestran los comandos para un Asterisk que no registre al equipo
que une a la telefonía IP con la telefonía pública; en este caso el Asterisk deberá comuni-
carse con el Asterisk que registre a este equipos que une ambas redes.

;exten =>0147,1,Macro(dial-svred,$IP-SERVER-PSTN,${EXTEN})

exten =>_0.,1,Macro(dial-svred,$IP-SERVER-PSTN,${EXTEN})

- Identi�cación de direcciones IP de los servidores Asterisk.
Si un Asterisk tiene que establecer comunicación con otro Asterisk que está en un equipo
que posee varias IP, se debe elegir la IP de la interfaz que está más próxima entre la
comunicación de ambos Asterisk.

- Grabación de archivos de sonido.
Para hacer archivos se sonido del tipo gsm, se puede usar la función implementada en
/etc/asterisk/extensions.conf; para esto se llama al 170; después de escuchar el beep se
procederá a grabar por el teléfono hasta que se presione el símbolo #; después se es-
cuchará lo grabado y terminará la llamada.

;grabacion de archivos de sonido gsm

exten =>170,1,Macro(sounds-record,gsm)

;

Los archivos serán grabados en /root/ con el nombre de mensaje-pbx-X.gsm donde X
cambiará (0, 1, 2 ...) según se vaya grabando; cambien de nombre y según su uso deberá
ser guardado en /var/lib/asterisk/sounds/es/.

- Con�guración de IVR básico.
El IVR se utiliza para contestar y direccionar las llamadas entrantes provenientes de la tele-
fonía pública; esto está en /etc/asterisk/extensions.conf. Se debe especi�car los archivos
de sonido para el saludo correspondiente; xivr_bienvenido_pucp contiene un saludo pre-
sentando a la institución; xivr_opciones_pucp contiene la opción de esperar para que sea
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respondido por algún cliente SIP; xnumero_incorrecto contiene el mensaje de �numero in-
correcto� Los archivos de sonido en español deben estar en /var/lib/asterisk/sounds/es/.
Además se debe especi�car en la variable PHONE-DEFAULT el número telefónico que de-
berá contestar si no se elige un teléfono válido. En la parte �nal se especi�ca los números
telefónicos al que puede acceder el llamante de la red de telefonía pública.

;ivr basico

;

(ivr)

;

exten =>s,1,Set(CHANNEL(LANGUAGE)=es)

exten =>s,2,Background(xivr_bienvenido_pucp)

exten =>s,3,Background(xivr_opciones_pucp)

exten =>s,4,Set(TIMEOUT(digit)=3)

exten =>s,5,Set(TIMEOUT(response)=9)

exten =>t,1,Goto(center,${PHONE-DEFAULT},1)

exten =>i,1,Set(LANGUAGE()=es)

exten =>i,2,Playback(xnumero_incorrecto)

exten =>i,3,Goto(s,3)

;

exten =>_2XX,1,Goto(center,${EXTEN},1)

exten =>_3XX,1,Goto(center,${EXTEN},1)

exten =>_4XX,1,Goto(center,${EXTEN},1)

;

- Comunicación con otros servidores Asterisk.
El archivo /etc/asterisk/iax.conf se utiliza para la comunicación con otros Asterisk no es
necesario que se edite; posee una con�guración general; si se hace cambios en este se debe
tener en cuenta que estos cambios deben estar re�ejados en /etc/asterisk/extensions.conf.

[general]

;

bindport=4569

language=es

disallow=all

allow=ulaw

allow=g726aal2

allow=gsm

allow=ilbc

allow=g726

;

[iaxuser]

type=user

username=iaxuser

callerid=iaxuser

secret=passwd

context=center

;

E.2.2. Registro de los clientes SIP

Una vez con�gurado los archivos se comprobará el registro de los clientes y el funcionamiento
del Asterisk. Se utilizará el script /etc/init.d/asterisk para iniciar y detener el Asterisk.
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nodo-b: # /etc/init.d/asterisk start Para correr el Asterisk

nodo-b: # /etc/init.d/asterisk stop Para detener el Asterisk

nodo-b: # /etc/init.d/asterisk restart Para reiniciar el Asterisk

En este caso se inicia la ejecución del Asterisk; para observar el estado del registro de los
clientes y del propio Asterisk se debe acceder a entorno CLI del Asterisk.

nodo-b: # asterisk -vvvvr

...

nodo-b*CLI>sip show peers

Name/username Host Dyn Nat ACL Port Status

10/10 (Unspecified) D 0 UNKNOWN

211/211 (Unspecified) D 0 UNKNOWN

210/210 (Unspecified) D 0 UNKNOWN

Dentro del CLI con el comando sip show peers se puede observar si los clientes se han regis-
trado; en el mensaje de arriba mostrado en la última columna se observa que los tres clientes
están con el mensaje UNKNOWN por tanto no están registrados si aparece OK entonces si
estarán registrados.

Si ya se ha con�gurado los clientes SIP se debe comprobar su registro en el Asterisk. Para
salir del CLI sólo se hace exit.

Si se modi�ca los archivos de con�guración para cargar ésta nueva con�guración en el As-
terisk se hace:

nodo-b*CLI>reload

Pero mejor quizás sea detener el Asterisk y de nuevo cargarlo así:

nodo-b*CLI>stop now

...

nodo-b: # /etc/init.d/asterisk start

Debe asegurarse que el Asterisk esté activo; para esto se puede usar ps -le | grep asterisk si
arroja resultado entonces el Asterisk está corriendo; sino no lo está. Si por cualquier motivo no
se puede ejecutar el Asterisk entonces se debe ejecutar con la opción:

nodo-b: # asterisk -vvvvc

En la Voyage-GTR el Asterisk corre como root. Con esto se observará la carga de cada mó-
dulo del Asterisk, si uno de ellos falla nos lo mostrará; si la falla es grave no continuará con la
carga del Asterisk y se detendrá en el primer error grave; si todo está correcto se llegará al CLI
del Asterisk, con esto se tendrá asegurado que la falla no es debido a la carga de algún módulo;
si aún hay fallas se debe seguir observando los mensaje que aparecerán en el CLI. Si todo está
bien; se sale del CLI, pero como en este caso se ha ingresado al CLI con la opción -c, entonces
no se podrá usar el comando exit, para esto se debe detener el Asterisk y cargar de nuevo así:
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*CLI>stop now

nodo-b: # /etc/init.d/asterisk start

No olvide que debe comprobar de nuevo que el Asterisk esté cargado o activo.

E.2.3. Veri�cación del estado de telefonía IP con Asterisk

- Estado del registro de clientes y tono en los teléfonos.
En el cuadro de abajo se observa el registro de los equipos clientes telefónicos 10 y 210;
porque aparece OK en Status. El tiempo de registro de los equipos telefónicos deberá ser
menor a 50ms; si se tiene un tiempo mayor se debe evaluar instalar un servidor en la misma
red del equipo cliente. Anotar qué equipos están registrados y el tiempo de registro de los
clientes telefónicos.

nodo-b*CLI>sip show peers

Name/username Host Dyn Nat ACL Port Status

10/10 10.1.52.4 D 5061 OK (12 ms)

211/211 (Unspecified) D 0 UNKNOWN

210/210 10.1.52.3 D 5060 OK (13 ms)

3 sip peers (2 online , 1 offline)

Los equipos telefónicos deben dar tono una vez descolgado el auricular.

- Llamada de prueba al servidor de telefonía IP.
Se debe realizar una llamada de prueba al servidor Asterisk, además se debe observar el
resultado de ésta llamada en el CLI del Asterisk la correcta ejecución de los comandos.

- Llamada de prueba a un cliente local.
Se debe realizar una llamada de prueba a un cliente administrado por el mismo servidor
Asterisk al que se está evaluando, además se debe observar el resultado de ésta llamada
en el CLI. Anotar si se realiza sin problemas una llamada de prueba con un cliente local,
el codec utilizado en la conversación y la calidad en la conversación.

- Llamada de prueba al resto de servidores de telefonía IP.
Se debe realizar una llamada de prueba a los otros servidores Asterisk y observar en el CLI
de ambos Asterisk la correcta ejecución de los comandos. Anotar si se realiza sin problemas
una llamada de prueba al resto de los servidores de telefonía de la red.

- Llamada de prueba a un cliente administrado por otro servidor.
Se debe realizar una llamada de prueba a un cliente remoto que sea administrado por
otro Asterisk; anotar si esto se realiza sin problemas, comentar sobre la calidad de la
conversación; además se debe observar en el CLI de ambos Asterisk si la comunicación
se realiza con el codec con�gurado, si los comandos se ejecutan correctamente. Se debe
realizar llamado a todos, si es necesario. Anotar si se realiza sin problemas una llamada de
prueba con un cliente administrado por otro servidor, el codec utilizado en la conversación
y la calidad de la conversación.
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Presupuesto

1) Ejecución Material

- Compra de ordenador personal (Software incluido) 2.000 ¤

- Desplazamientos Madrid-Lima y desplazamientos internos en Perú 3.500 ¤

- Material de o�cina 150 ¤

- Total de ejecución material 5.650 ¤

2) Gastos generales

- sobre Ejecución Material 352 ¤

3) Bene�cio Industrial

- sobre Ejecución Material 132 ¤

4) Honorarios Proyecto

- 1800 horas a 15 ¤/ hora 27000 ¤

5) Material fungible

- Gastos de impresión 280 ¤

- Encuadernación 20 ¤
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6) Subtotal del presupuesto

- Subtotal Presupuesto 33.434 ¤

7) I.V.A. aplicable

- 18% Subtotal Presupuesto 6.018,12 ¤

8) Total presupuesto

- Total Presupuesto 3.9452,12 ¤

Madrid, Diciembre 2010

El Ingeniero Jefe de Proyecto

Fdo.: María Martín Espín

Ingeniero Superior de Telecomunicación
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Pliego de condiciones

Pliego de condiciones

Este documento contiene las condiciones legales que guiarán la realización, en este proyecto,
de una guía para el diseño e implementación de redes inalámbricas en entornos rurales de Perú.
En lo que sigue, se supondrá que el proyecto ha sido encargado por una empresa cliente a una
empresa consultora con la �nalidad de realizar dicho sistema. Dicha empresa ha debido desar-
rollar una línea de investigación con objeto de elaborar el proyecto. Esta línea de investigación,
junto con el posterior desarrollo de los programas está amparada por las condiciones particulares
del siguiente pliego.

Supuesto que la utilización industrial de los métodos recogidos en el presente proyecto ha
sido decidida por parte de la empresa cliente o de otras, la obra a realizar se regulará por las
siguientes:

Condiciones generales.

1. La modalidad de contratación será el concurso. La adjudicación se hará, por tanto, a la
proposición más favorable sin atender exclusivamente al valor económico, dependiendo de
las mayores garantías ofrecidas. La empresa que somete el proyecto a concurso se reserva
el derecho a declararlo desierto.

2. El montaje y mecanización completa de los equipos que intervengan será realizado total-
mente por la empresa licitadora.

3. En la oferta, se hará constar el precio total por el que se compromete a realizar la obra
y el tanto por ciento de baja que supone este precio en relación con un importe límite si
este se hubiera �jado.

4. La obra se realizará bajo la dirección técnica de un Ingeniero Superior de Telecomunicación,
auxiliado por el número de Ingenieros Técnicos y Programadores que se estime preciso para
el desarrollo de la misma.

5. Aparte del Ingeniero Director, el contratista tendrá derecho a contratar al resto del per-
sonal, pudiendo ceder esta prerrogativa a favor del Ingeniero Director, quien no estará
obligado a aceptarla.
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6. El contratista tiene derecho a sacar copias a su costa de los planos, pliego de condiciones y
presupuestos. El Ingeniero autor del proyecto autorizará con su �rma las copias solicitadas
por el contratista después de confrontarlas.

7. Se abonará al contratista la obra que realmente ejecute con sujeción al proyecto que sirvió
de base para la contratación, a las modi�caciones autorizadas por la superioridad o a las
órdenes que con arreglo a sus facultades le hayan comunicado por escrito al Ingeniero
Director de obras siempre que dicha obra se haya ajustado a los preceptos de los pliegos
de condiciones, con arreglo a los cuales, se harán las modi�caciones y la valoración de las
diversas unidades sin que el importe total pueda exceder de los presupuestos aprobados. Por
consiguiente, el número de unidades que se consignan en el proyecto o en el presupuesto,
no podrá servirle de fundamento para entablar reclamaciones de ninguna clase, salvo en
los casos de rescisión.

8. Tanto en las certi�caciones de obras como en la liquidación �nal, se abonarán los trabajos
realizados por el contratista a los precios de ejecución material que �guran en el presupuesto
para cada unidad de la obra.

9. Si excepcionalmente se hubiera ejecutado algún trabajo que no se ajustase a las condiciones
de la contrata pero que sin embargo es admisible a juicio del Ingeniero Director de obras, se
dará conocimiento a la Dirección, proponiendo a la vez la rebaja de precios que el Ingeniero
estime justa y si la Dirección resolviera aceptar la obra, quedará el contratista obligado a
conformarse con la rebaja acordada.

10. Cuando se juzgue necesario emplear materiales o ejecutar obras que no �guren en el pre-
supuesto de la contrata, se evaluará su importe a los precios asignados a otras obras o
materiales análogos si los hubiere y cuando no, se discutirán entre el Ingeniero Director y
el contratista, sometiéndolos a la aprobación de la Dirección. Los nuevos precios convenidos
por uno u otro procedimiento, se sujetarán siempre al establecido en el punto anterior.

11. Cuando el contratista, con autorización del Ingeniero Director de obras, emplee materiales
de calidad más elevada o de mayores dimensiones de lo estipulado en el proyecto, o sustituya
una clase de fabricación por otra que tenga asignado mayor precio o ejecute con mayores
dimensiones cualquier otra parte de las obras, o en general, introduzca en ellas cualquier
modi�cación que sea bene�ciosa a juicio del Ingeniero Director de obras, no tendrá derecho
sin embargo, sino a lo que le correspondería si hubiera realizado la obra con estricta sujeción
a lo proyectado y contratado.

12. Las cantidades calculadas para obras accesorias, aunque �guren por partida alzada en el
presupuesto �nal (general), no serán abonadas sino a los precios de la contrata, según las
condiciones de la misma y los proyectos particulares que para ellas se formen, o en su
defecto, por lo que resulte de su medición �nal.

13. El contratista queda obligado a abonar al Ingeniero autor del proyecto y director de obras
así como a los Ingenieros Técnicos, el importe de sus respectivos honorarios facultativos
por formación del proyecto, dirección técnica y administración en su caso, con arreglo a
las tarifas y honorarios vigentes.

14. Concluida la ejecución de la obra, será reconocida por el Ingeniero Director que a tal efecto
designe la empresa.

15. La garantía de�nitiva será del 4% del presupuesto y la provisional del 2%.

16. La forma de pago será por certi�caciones mensuales de la obra ejecutada, de acuerdo con
los precios del presupuesto, deducida la baja si la hubiera.

17. La fecha de comienzo de las obras será a partir de los 15 días naturales del replanteo o�cial
de las mismas y la de�nitiva, al año de haber ejecutado la provisional, procediéndose si no
existe reclamación alguna, a la reclamación de la �anza.
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18. Si el contratista al efectuar el replanteo, observase algún error en el proyecto, deberá
comunicarlo en el plazo de quince días al Ingeniero Director de obras, pues transcurrido
ese plazo será responsable de la exactitud del proyecto.

19. El contratista está obligado a designar una persona responsable que se entenderá con el
Ingeniero Director de obras, o con el delegado que éste designe, para todo relacionado
con ella. Al ser el Ingeniero Director de obras el que interpreta el proyecto, el contratista
deberá consultarle cualquier duda que surja en su realización.

20. Durante la realización de la obra, se girarán visitas de inspección por personal facultativo
de la empresa cliente, para hacer las comprobaciones que se crean oportunas. Es obligación
del contratista, la conservación de la obra ya ejecutada hasta la recepción de la misma,
por lo que el deterioro parcial o total de ella, aunque sea por agentes atmosféricos u otras
causas, deberá ser reparado o reconstruido por su cuenta.

21. El contratista, deberá realizar la obra en el plazo mencionado a partir de la fecha del
contrato, incurriendo en multa, por retraso de la ejecución siempre que éste no sea debido
a causas de fuerza mayor. A la terminación de la obra, se hará una recepción provisional
previo reconocimiento y examen por la dirección técnica, el depositario de efectos, el inter-
ventor y el jefe de servicio o un representante, estampando su conformidad el contratista.

22. Hecha la recepción provisional, se certi�cará al contratista el resto de la obra, reservándose
la administración el importe de los gastos de conservación de la misma hasta su recepción
de�nitiva y la �anza durante el tiempo señalado como plazo de garantía. La recepción
de�nitiva se hará en las mismas condiciones que la provisional, extendiéndose el acta
correspondiente. El Director Técnico propondrá a la Junta Económica la devolución de la
�anza al contratista de acuerdo con las condiciones económicas legales establecidas.

23. Las tarifas para la determinación de honorarios, reguladas por orden de la Presidencia
del Gobierno el 19 de Octubre de 1961, se aplicarán sobre el denominado en la actualidad
"Presupuesto de Ejecución de Contrata 2anteriormente llamado "Presupuesto de Ejecución
Material"que hoy designa otro concepto.

Condiciones particulares.

La empresa consultora, que ha desarrollado el presente proyecto, lo entregará a la empresa
cliente bajo las condiciones generales ya formuladas, debiendo añadirse las siguientes condiciones
particulares:

1. La propiedad intelectual de los procesos descritos y analizados en el presente trabajo,
pertenece por entero a la empresa consultora representada por el Ingeniero Director del
Proyecto.

2. La empresa consultora se reserva el derecho a la utilización total o parcial de los resultados
de la investigación realizada para desarrollar el siguiente proyecto, bien para su publicación
o bien para su uso en trabajos o proyectos posteriores, para la misma empresa cliente o
para otra.

3. Cualquier tipo de reproducción aparte de las reseñadas en las condiciones generales, bien
sea para uso particular de la empresa cliente, o para cualquier otra aplicación, contará
con autorización expresa y por escrito del Ingeniero Director del Proyecto, que actuará en
representación de la empresa consultora.

4. En la autorización se ha de hacer constar la aplicación a que se destinan sus reproducciones
así como su cantidad.

5. En todas las reproducciones se indicará su procedencia, explicitando el nombre del proyec-
to, nombre del Ingeniero Director y de la empresa consultora.
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6. Si el proyecto pasa la etapa de desarrollo, cualquier modi�cación que se realice sobre él,
deberá ser noti�cada al Ingeniero Director del Proyecto y a criterio de éste, la empresa
consultora decidirá aceptar o no la modi�cación propuesta.

7. Si la modi�cación se acepta, la empresa consultora se hará responsable al mismo nivel que
el proyecto inicial del que resulta el añadirla.

8. Si la modi�cación no es aceptada, por el contrario, la empresa consultora declinará toda
responsabilidad que se derive de la aplicación o in�uencia de la misma.

9. Si la empresa cliente decide desarrollar industrialmente uno o varios productos en los que
resulte parcial o totalmente aplicable el estudio de este proyecto, deberá comunicarlo a la
empresa consultora.

10. La empresa consultora no se responsabiliza de los efectos laterales que se puedan pro-
ducir en el momento en que se utilice la herramienta objeto del presente proyecto para la
realización de otras aplicaciones.

11. La empresa consultora tendrá prioridad respecto a otras en la elaboración de los proyectos
auxiliares que fuese necesario desarrollar para dicha aplicación industrial, siempre que
no haga explícita renuncia a este hecho. En este caso, deberá autorizar expresamente los
proyectos presentados por otros.

12. El Ingeniero Director del presente proyecto, será el responsable de la dirección de la apli-
cación industrial siempre que la empresa consultora lo estime oportuno. En caso contrario,
la persona designada deberá contar con la autorización del mismo, quien delegará en él las
responsabilidades que ostente.
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